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Foreword
Welcome to The Beginner’s Guide to DaVinci Resolve 18.
DaVinci Resolve 18 is the only post-production solution that combines editing, color 
correction, visual effects, motion graphics, and audio post-production all in one software 
tool! Its elegant, modern interface is fast to learn for new users yet powerful enough for 
the most experienced professionals. DaVinci Resolve lets you work more efficiently 
because you don’t have to learn multiple apps or switch software for different tasks. It’s 
like having your own post-production studio in a single app!

DaVinci Resolve 18 adds Blackmagic Cloud support for remote collaboration, DaVinci proxy 
workflow, new Resolve FX, intuitive object masking, improved subtitling for editors, 
Fairlight fixed bus to FlexBus conversion, and so much more!

Best of all, Blackmagic Design offers a version of DaVinci Resolve 18 that is completely free! 
We’ve made sure that this version of DaVinci Resolve includes more features than any paid 
editing system. That’s because at Blackmagic Design we believe everybody should have 
the tools to create professional, Hollywood-caliber content without having to spend 
thousands of dollars.

I invite you to download your copy of DaVinci Resolve 18 today and look forward to seeing 
the amazing work you produce!

Grant Petty  
Blackmagic Design
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Getting Started
Welcome to The Beginner’s Guide to DaVinci Resolve 18, the official Blackmagic Design 
Training and Certification book that teaches editors, artists, and students how to edit, 
composite, color correct, and mix audio in DaVinci Resolve. All you need is a Mac or 
Windows computer, the free download version of DaVinci Resolve 18, and a passion to 
learn and tell your story!

This official step-by-step training guide covers the basics of editing, visual effects, motion 
graphics, color correction, and audio so you can start creating your own Hollywood-caliber 
film and video today!

What You’ll Learn
 — How to mark selections, edit clips in the timeline, and perform context-

sensitive trimming

 — How to retime clips, add transitions, and pan and scan photos

 — How to work with new title templates, create your own titles, and add animation

 — How to perform primary and secondary corrections using DaVinci Resolve’s legendary 
color tools

 — How to match shots, use color management, create looks, and grade multiple clips

 — How to use Power Windows, track objects in a shot, use curves, and add Resolve FX

 — How to set up projects, import media, and use metadata to speed up your work
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 — How to edit and mix audio using the Fairlight audio tools

 — How to navigate the Fusion page and use a node-based interface for visual 
effects compositing

 — How to deliver projects in a variety of formats and share them directly to 
YouTube and Vimeo

 — And dozens of tips and tricks throughout the book that will transform how you work!

The Blackmagic Design Training and 
Certification Program 
Blackmagic Design publishes several training books that take your skills farther in 
DaVinci Resolve 18. They include:

 — The Beginner’s Guide to DaVinci Resolve 18

 — The Colorist Guide to DaVinci Resolve 18

 — The Editor’s Guide to DaVinci Resolve 18

 — The Fairlight Audio Guide to DaVinci Resolve 18

 — The Visual Effects Guide to DaVinci Resolve 18

Whether you want an introductory guide to DaVinci Resolve or want to learn more 
advanced editing techniques, color grading, sound mixing, or visual effects, our certified 
training program includes a learning path for you.

Getting Certified
After completing this book, you are encouraged to take a 1-hour, 50-question online 
proficiency exam to receive a Certificate of Completion from Blackmagic Design. The link 
to the online exam can be found on the Blackmagic Design training webpage. The 
webpage also provides additional information on our official Training and Certification 
Program. Please visit www.blackmagicdesign.com/products/davinciresolve/training

http://www.blackmagicdesign.com/products/davinciresolve/training
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System Requirements
This book supports DaVinci Resolve 18 for macOS and Windows. If you have an older 
version of DaVinci Resolve, you must upgrade to the current version to follow along with 
the lessons.

NOTE The exercises in this book refer to file and resource locations that will differ 
if you are using the version of software from the Apple Mac App Store. For the 
purposes of this training book, we recommend that macOS users download and 
use the DaVinci Resolve software from the Blackmagic Design website rather than 
from the Mac App store.

Download DaVinci Resolve
To download the free version of DaVinci Resolve 18 or later from the 
Blackmagic Design website:

1 Open a web browser on your Windows or macOS computer.

2 In the address field of your web browser, type:  
www.blackmagicdesign.com/products/davinciresolve.

3 On the DaVinci Resolve landing page, click the Download button.

4 On the download page, click the button corresponding to your computer’s 
operating system.

5 Follow the installation instructions to complete the DaVinci Resolve installation.

When you have completed the software installation, follow the instructions in the following 
section to download the content for this book.

Copying the Lesson Files
The DaVinci Resolve lesson files must be downloaded to your macOS or Windows computer 
to perform the exercises in this book. After you save the files to your hard drive, extract the 
file and copy the folder to your Movies folder (macOS) or Videos folder (Windows).

http://www.blackmagicdesign.com/products/davinciresolve
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To Download and Install the DaVinci Resolve Lessons Files:
When you are ready to download the lesson files, follow these steps:

1 Open a web browser on your Windows or macOS computer.

2 In the address field of your web browser, type:  
www.blackmagicdesign.com/products/davinciresolve/training

3 Scroll the page until you locate the The Beginner’s Guide to DaVinci Resolve 18.

4 Click the Part 1 link to download the media. The file is roughly 3.06 GB in size.

5 After downloading the zip file to your macOS or Windows computer, open your 
Downloads folder and double-click R18_Beginner_Guide_Lessons.zip to unzip it if it 
doesn’t unzip automatically. You’ll end up with a folder named “R18 Beginner Lessons” 
that contains all the content for this book.

6 From your Downloads folder, drag the R18 Beginner Guide Lessons folder to your 
Movies folder (macOS) or Videos folder (Windows). These folders can be found within 
your User folder on either platform.

You are now ready to begin Lesson 1.

http://www.blackmagicdesign.com/products/davinciresolve/training


xvi Introducing Blackmagic Cloud

Introducing Blackmagic Cloud
DaVinci Resolve is the world’s only complete post-production solution that lets everyone 
work together on the same project at the same time. Traditionally, post-production follows 
a linear workflow with each artist handing off to the next, introducing errors and 
mountains of change logs to keep track of through each stage. With DaVinci Resolve’s 
collaboration features, each artist can work on the same project, in their own dedicated 
page with the tools they need. 

Now Blackmagic Cloud lets editors, colorists, VFX artists, animators, and sound engineers 
work together simultaneously from anywhere in the world. Plus, they can review each 
other's changes without spending countless hours reconforming the timeline.

Simply create a Blackmagic Cloud ID, log in to the online DaVinci Resolve Project Server, 
and follow the simple instructions to set up a new project library—all for one low 
monthly price! 

Once created, you can access this library directly from the Cloud tab in the Project 
Manager to create as many projects as you need—all stored securely online. Then invite up 
to 10 other people to collaborate on a project with you. With a simple click, they can relink 
to local copies of the media files and start working on the project immediately, with all their 
changes automatically saved to the cloud.

Enabling Multiple User Collaboration for your project means that everyone can work on 
the same project at the same time—edit assistants, editors, colorists, dialogue editors, and 
visual effects artists can now all collaborate wherever they are in the world in a way never 
before possible.

Media Sync with Blackmagic Cloud Store
Now you don’t need to buy expensive proprietary storage that needs an entire IT team to 
manage! Blackmagic Cloud Store has been designed for multiple users and can handle the 
huge media files used by Hollywood feature films. You can also have multiple Blackmagic 
Cloud Stores syncing the media files with your Dropbox account so that everyone has 
access to the media files for the project.

To find out more about these exciting workflows, visit  
www.blackmagicdesign.com/products/davinciresolve/collaboration

http://www.blackmagicdesign.com/products/davinciresolve/collaboration
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2 Lesson 1 Editing in the Edit Page

Over the next two lessons, you will edit a short trailer for the documentary film Living in the 
Age of Airplanes, directed by Brian J. Terwilliger, so you can appreciate some of the thought 
processes and happy accidents that often occur in editing suites around the world.

Bin List – allows you 
to easily select a bin 
to view its contents

Toolbar – features timeline editing 
modes, editing functions, and 

timeline zoom settings

Timeline – allows you to 
place and adjust clips 

used in the current edit

Source Viewer – displays 
the unedited footage

Media Pool – displays clips in 
the currently selected bin

Timeline Viewer – displays 
edited clips in the timeline

Importing a Project and 
Relinking Media
You will begin this lesson by importing a project that has already been set up for you and 
contains the clips needed to edit the trailer.

NOTE You will learn more about project settings in Lesson 6.



3Importing a Project and Relinking Media

1 Open DaVinci Resolve to display the Project Manager. 

2 In the lower-left corner of the Project Manager, click the Import button.

3 Navigate to R18 Beginner Guide Lessons / Lesson 01 folder and select the file 
Age of Airplanes.drp.
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NOTE The file extension .drp indicates this is a DaVinci Resolve Project file. 
Using project files like this is a good way to exchange projects with other 
users, particularly if you’re using a local project library. You’ll learn more 
about project libraries and creating your own .drp files in Lesson 9.

4 Click Open.

The project is added to the Project Manager for the current project library.

NOTE DaVinci Resolve does not “open” project files directly from your 
system. Instead, .drp files are copied directly into the current project library. 
Thereafter, any changes to the project are applied only to the copy in the 
project library.

5 Double-click the Age of Airplanes project to open it and, if necessary, click the Edit 
page button.

6 Select Workspace > Reset UI Layout to reset the edit page workspace to the default 
configuration.
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7 In the bin list, select the VIDEO CLIPS bin to display its contents.

Currently, all the clips in this project are displaying as offline. This means that the link 
that was originally established by the project to the media files, when they were 
initially imported, has been broken. So, before you can begin editing the clips in this 
project, you’ll need to relink the clips in this project to their media files on your 
computer’s hard drive.

NOTE Media files may often go offline because they’ve been moved or 
renamed on the original storage. To prevent this from happening, once you 
have imported the clips, you should leave them in their original locations on 
your computer. If you need to move them, you can use the Media 
Management tool, which you will learn more about in Lesson 9.

8 In the top left of the interface, above the media pool, click the Relink Media button.
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9 The Relink Media window appears, telling you how many clips are missing their 
media files.

10 Click the Locate button, and in the file window that appears, navigate to the R18 
Beginner Guide Lessons folder and click Open.

Resolve will quickly search this folder and attempt to find the matching media files.
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NOTE If Resolve cannot find the appropriate files, you can initiate a more 
comprehensive search from the Relink Media window using the Disk Search 
button. Be aware, though, that this search may take much longer if you have 
very large hard drives with lots of media files to search through!

Once the clips are found in the R18 Beginner Guide Lessons folder, Resolve will quickly 
relink the clips in the project with their appropriate media files, and the clips will no 
longer be displayed as offline in the media pool.

Now that the clips have been relinked to their original media files, you can begin exploring 
this project.

Working with the Media Pool
The media pool is the place where clips and other project elements such as timelines are 
stored and organized. In the edit page, though, there is much more emphasis on accessing 
specific clips in different bins. 

Using Bins and Smart Bins
The bin list is displayed to the left of the media pool. You can access the clips inside each 
bin by clicking on a bin at any time.
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1 Select the VIDEO CLIPS bin to see the clips available in this bin.

You can also organize bins inside other bins.

2 Click the disclosure arrow next to the AUDIO CLIPS bin to reveal the sub bins called 
Music, Sound Effects, and VO (voiceover).

You can also display the contents of multiple bins together in the media pool.



9Working with the Media Pool

3 Select the AUDIO CLIPS bin, and then Command-click (macOS) or Ctrl-click (Windows) 
the VIDEO CLIPS bin to display all the individual clips in these bins.

Despite easily accessing the different bins, the edit page has a much more flexible 
approach to finding the clip you’re after, using the metadata that’s applied to a clip.

4 In the Smart Bins section of the bin list, click the disclosure arrow next to the 
Keywords folder.

Smart bins are special bins that will automatically collect different clips based on sets 
of rules. The Keywords Smart Bin category is an example of a set of automatic smart 
bins that appear when you start adding keywords to clips in your project.
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5 Select the Timelapse smart bin. Two clips appear in the media pool because each of 
these has timelapse applied as a keyword.

6 Click the disclosure triangle for the Custom Smart Bins folder.

This smart bin, called “Good Takes”, was manually created to help further organize the 
clips in this project.

7 Select the Good Takes smart bin to reveal clips that have been marked as a Good Take.
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NOTE You’ll learn more about viewing, adding, and modifying clip metadata, 
including adding keywords and marking clips as good takes so you can create and 
organize your own smart bins, in Lesson 6.

Reviewing Clips in the Edit Page
Being able to effectively review the clips in your project in the source viewer is an 
important part of the editing process.

1 Select the B-Roll smart bin to display the clips tagged with the keyword “B-Roll.”

2 Move your mouse pointer across the first clip in the media pool, 
01 A380 TAKEOFF.mov.

The clip is automatically previewed in the source viewer.

TIP You can disable audio scrubbing by choosing Timeline > Audio Scrubbing 
or by pressing Shift-S.

3 Continue moving your mouse pointer across the different clips in this smart bin to 
quickly preview them.

For more control, you may need to open the clip in the source viewer since live preview 
only temporarily displays the clip for as long as your mouse pointer is over the clip in 
the media pool.
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4 In the media pool, locate the clip 07 KENYA.mov to live preview the clip, and then drag 
the clip from the media pool into the source viewer.

Now, when you are no longer live previewing a clip, the Kenya clip is displayed in the 
source viewer.

TIP You can turn off live preview by clicking the Options menu in the top-
right corner of the source viewer (displayed as three dots), and deselecting 
Live Preview.

5 Live preview the clip 03 MALDIVES.mov in the media pool, and then double-click it to 
open it in the source viewer.

The Maldives clip replaces the Kenya clip as the active clip in the source viewer.

To switch back to the Kenya clip, you could reopen it from the media pool or use the 
recent clips menu.
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6 Click the recent clips menu at the top of the source viewer and choose 07 Kenya.mov 
from the clips recently opened.

The Kenya clip is reopened.

TIP The source viewer’s recent clips menu lists the last ten clips that were 
previously opened in the source viewer, with the most recently opened clips 
at the top of the list.
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NOTE The name of the clip in red indicates that the source viewer is the currently 
active part of the interface, so any keyboard shortcuts or menu items will be 
applied only to this part of the Resolve interface.

Exploring Viewing Options
There are different ways you can view clips in the media pool, with options for sorting the 
clips depending on your choice. Currently the clips are displayed as thumbnails.

1 At the top of the media pool, drag the slider to the right to make the 
thumbnails bigger.

When the thumbnails are larger, it’s easier to read the clip names.
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NOTE If you’re working on a laptop, you may need to increase the overall size 
of the media pool by dragging the divider between the media pool and the 
source viewer.

2 Click the Sort menu to display the sort order of the clips.

By default, the clips in the media pool are displayed in an ascending order, based on 
their clip name.
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3 Click Duration to change the sort order based on duration, with shorter clips at the top 
and longer clips at the bottom.

4 Click the List View button.
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The thumbnails are replaced by a series of columns displaying various pieces of 
information about each clip.

5 Scroll through the list and notice how the clips are still sorted by duration.

6 Click the Duration column header to reverse the sort order, so longer clips are now at 
the top of the list and short clips are at the bottom.
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7 Scroll back to the Name column and click its header to reorder the clips based on their 
name in ascending order. 

8 Click the thumbnail view button to return to thumbnail view.
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The thumbnail view is a good way to live preview the clips quickly, while list view shows 
much more information about each clip but doesn’t allow you to quickly preview each 
clip. To see what each clip is, you’d need to open each one in the source viewer. 

Metadata View
A third viewing option in the edit page’s media pool is Metadata view, which is 
half-way between thumbnails view and list view.

In Metadata view, you have a thumbnail that still allows you to live preview the 
clips but also displays some useful metadata fields, such as the names of the clips, 
the scene and shot number, and whether the clip is marked as Good.
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Building the Timeline in the 
Edit Page
Now that you’ve explored the edit page in terms of reviewing the footage for this project, 
it’s time to start editing it together into a short trailer. To do that, you will need a timeline.

Because many projects often contain multiple timelines, it’s useful to create a bin 
specifically to store all the timelines together, making it easy to locate them.

1 In the bin list, right-click the Master bin and choose New Bin or press Shift-
Command-N (macOS) or Shift-Ctrl-N (Windows).

A new bin, called “Bin 6,” is created in the Master bin  because it is the sixth bin to have 
been created in this project.
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2 With the name of this bin highlighted, type TIMELINES and press Return (Enter) to 
rename this bin.

3 Select the new empty TIMELINES bin and choose File > New Timeline or press 
Command-N (macOS) or Ctrl-N (Windows).

4 Change the name of this timeline to Age of Airplanes Trailer and click Create.

The new timeline is added to the selected bin and opens in the timeline window.

TIP If you created the timeline in the wrong bin, you can always move it into 
the correct bin at any time by dragging it from the media pool onto the 
correct bin in the bin list.
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Editing the Sound Bites
As with the previous lesson, you’ll begin by editing the interview clips together.

1 Select the Interview smart bin and open clip Interview 01.mov in the source viewer.

2 Click the Go To First Frame button or press the Up Arrow key to return the small 
playhead to the start of the clip.

3 Click the Play button or press the Spacebar to play the clip and listen to Brian’s interview.
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While the edit page supports drag-and-drop editing, it’s much more restrictive to what 
types of edits you can perform this way, limiting you to the default overwrite edit. 
Instead, you can use specific editing functions.

4 Drag the clip from the source viewer over to the timeline viewer, but don’t let go of 
your mouse button right away.

An overlay appears, detailing the different types of edits available to you. The default is 
Overwrite, which is highlighted automatically.

5 With the Overwrite option highlighted, release the mouse button.

Your first clip is edited into the timeline, and the timeline viewer becomes active 
automatically.
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6 Click the Full Extent Zoom button so the clip fills the timeline window.

7 In the timeline viewer, press the Go To Previous Edit button or press the Up Arrow key 
to return to the start of the timeline clip. Press the Spacebar to start playback from this 
point, and press the Spacebar again to stop playback after Brian says “…shoot the 
real world.”

This is where you’ll make your next edit.

TIP You can always refine the location of your playhead by using the jog 
wheel or pressing the Left Arrow or Right Arrow keys. 
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Controlling Timeline Zoom
The edit page has three options for controlling the zoom level of clips in the 
timeline: Full Extent Zoom, Detail Zoom, and Custom Zoom.

Full Extent Zoom will always display the whole duration of your timeline in the 
timeline window, automatically adjusting the zoom to keep everything in sight. 
This is most useful for seeing a bird’s-eye view of your edit and allows you to 
navigate anywhere within the timeline, like the upper timeline in the cut page.

Detail Zoom scales the timeline to a closer, zoomed view, centered on the 
playhead. This option is most useful when you want to step into the timeline to 
select a clip or edit point to make fine adjustments, like the lower timeline in 
the cut page.

Custom Zoom provides the most flexibility as it allows you to set your own zoom 
scale in the timeline. You can use the slider to zoom in and out of the playhead 
location or hold Option (macOS) or Alt (Windows) and use the scroll function on 
your mouse (or trackpad) to adjust the zoom of the timeline dynamically, centered 
on the playhead. 

Timeline track heights can be adjusted using the timeline view options menu or by 
holding Shift and using the mouse scroll wheel in either the audio or video areas 
of the timeline.

Useful keyboard shortcuts for zooming the timeline include:

 — Command-= (equals) in macOS or Ctrl-= (equals) in Windows to zoom in to the 
timeline playhead

 — Command--(minus) in macOS or Ctrl--(minus) in Windows to zoom out of the 
timeline playhead

 — Shift-Z toggles between fitting the timeline to the timeline window and 
returning you to the previous zoom level



26 Lesson 1 Editing in the Edit Page

8 From the media pool, open Interview 02.mov in the source monitor.

Go to the first frame of the clip and play through from the start. 

You only need to use a part of this sound bite from Brian’s interview. When working 
with clips with audio like this, it’s useful to see a representation of the audio waveform 
along with the video in the source viewer.

TIP You can tell if a clip has audio as well as video by the presence of the 
audio symbol displayed in the bottom left of the clip’s thumbnail in the 
media pool.

9 Click the options menu (displayed as three dots) in the upper-right corner of the 
source viewer and select Show Zoomed Audio Waveform.
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An audio waveform is displayed in the source viewer. 

How cool is that? Now, as you scrub or play through this clip, you can see from the 
waveform where he starts and stops speaking.

Controlling Playback
An important part of editing is learning how to control the playback of your video. 
DaVinci Resolve’s default keyboard layout supports all the usual shortcuts for 
playback that professional editors around the world recognize. You can use the 
Spacebar to start and stop playback and the Left Arrow and Right Arrow keys to 
move forward and back one frame at a time. More experienced users will be 
happy to know that the J, K, and L keys also control playback at different speeds.

The order of the JKL keys match the layout of the Play Reverse, Stop, and Play 
transport controls in both the source and timeline viewers. 

Try the following to practice controlling the playback of the source or 
timeline viewer:

 — Hold K and tap L to jog forward 1 frame

 — Hold K and tap J to jog backward 1 frame

 — Hold K and Hold L to scrub forward at half speed

 — Hold K and hold J to scrub backward at half speed

 — Press L twice to shuttle forward at twice normal speed

 — Press J twice to shuttle backward at twice normal speed

You can keep tapping the J or L keys to increase the shuttling speed up to 64x 
normal speed.
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10 Play the clip from the start once more and then stop playback just before Brian says, 
“If it was possible to shoot it, we wanted to go shoot it.”

11 Press I to set an In point at this location.
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12 Play the clip through and stop after Brian says “…everything was real.”

13 Press O to set an Out point at this location.

14 In the timeline toolbar, click the Overwrite Clip button, or press F10.
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The second interview clip is edited into the timeline starting at the position of the 
timeline playhead. The end of the first clip has been overwritten by the new clip.

NOTE If you’re using DaVinci Resolve on macOS, you may need to configure 
your keyboard settings in System Preferences to “Use F1, F2, etc. keys as 
standard function keys” to use the default editing shortcuts. Alternatively, you 
can use the fn key with any F-key to override the macOS shortcuts.

15 Press the Up Arrow on your keyboard to move your timeline playhead back to the edit 
between the two interview clips.

16 Choose Playback > Play Around/To > Play Around Current Selection or press / 
(forward slash) to review the edit.

The edit is successful enough, but it’s a nasty jump cut, which you’ll fix in the 
following steps.
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Inserting the B-Roll
It’s time to add some B-Roll footage to bring Brian’s passion for airplanes alive.

1 Select the B-Roll smart bin and open 01 A380 TAKEOFF.mov in the source viewer. Play 
the clip from the start to review the footage.

2 Press I to set an In point as the plane’s wheels begin to lift off the runway. 
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3 Press O to set an Out point once the tail of the plane has left the frame.

4 Ensure your timeline playhead is still on the edit point between the two interview clips 
and drag the clip to the Insert overlay in the timeline viewer.

The clip is added in between the two interview clips in the timeline but has been 
inserted between them rather than overwriting the clip at the playhead.
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5 Move the timeline playhead back to the edit between INTERVIEW 01.mov and 
01 A380 TAKEOFF.mov. This will be the location for your next edit.

NOTE Using the Up Arrow and Down Arrow keys are fast ways of moving 
between the different edit points in your timeline. If you prefer, you can 
always drag the timeline playhead, and it will snap to the nearest edit point as 
long as your Snapping option is enabled. Press N to toggle snapping on or off.

6 From the media pool, open 02 A380 TAXI.mov in the source viewer. Play the clip 
through to review.

This is a nice overhead shot of the same type of plane that you’ve just edited into the 
timeline, but the audio is a little distracting.
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7 Place your mouse pointer over the source viewer, and then click and drag the video-
only overlay to the Insert overlay in the timeline viewer to insert just the video of 
this clip.

NOTE These overlays will allow you to edit only audio and video for the clip in 
the source viewer if you are using drag-and-drop editing, or the timeline 
viewer overlays. You will learn more sophisticated ways of specifying whether 
to edit audio or video only to the timeline, and which tracks to target, 
in Lesson 2.

You’ll now insert a clip to split an existing clip. 

8 In the timeline, play through the second interview clip and stop after Brian says, “If it 
was possible to shoot it, we wanted to go shoot it.” This will be the location for your 
next edit.

9 Open 03 MALDIVES.mov in the source viewer and review the clip.
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10 Set an In point just before the shadow of the plane starts to pass across the coral.

11 In the source viewer, type +300 and press Return (Enter) to jump the playhead forward 
3 seconds.

12 Press O to set the Out point.
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NOTE Although you can’t set a duration directly in the source viewer, moving 
the playhead forward and setting the Out point is the next best solution. 
However, you will probably notice that the duration of the marked clip 
(represented by the timecode in the upper-left corner of the source viewer) 
indicates the duration you have marked is 03:01 (3 seconds and 1 frame). This 
is because Resolve sets In points at the head, or start, of the frame, and Out 
points at the tail, or end, of the frame. This means the minimum duration you 
can mark is 1 frame. If you wish to make sure you are marking exactly 3 
seconds, you’ll need to move one frame back before setting the Out point. At 
this stage though, an extra frame is nothing to worry about.

13 Press F9 to insert the clip into the timeline at the playhead position.

NOTE If you need to catch up before moving to the next step, select the 
TIMELINES bin and choose File > Import > Timeline, navigate to R18 Beginner 
Guide Lessons / Lesson 01 / Timelines / Age of Airplanes Catchup 1.drt and 
click Open.
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Removing and Trimming 
Timeline Clips
Great. Your edit is starting to come along, and you’re now at the stage where you’re 
probably thinking it may benefit from some refinement.

1 Move the timeline playhead to the start of the middle interview clip and click the Detail 
Zoom button.

Do you notice the small chain icons on the video and audio of this clip? That means 
the two parts of this clip are linked. This can be useful if you want to remove or move 
both parts of this clip (meaning it would be quite difficult to move them out of sync 
with each other, for example). 

2 Click the Linked Selection button in the timeline toolbar.

With Linked Selection disabled, the linking between clips is ignored.
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3 Select the video part of the interview clip and choose Edit > Ripple Delete or press 
Shift-Delete (Backspace).

The video portion of the clip is removed, and the remaining audio moves nicely under 
the preceding shot of the A380 taking off.

Did you notice what else happened in the timeline? Because you performed a ripple 
delete, it meant you didn’t leave a gap, and the rest of the footage in the timeline 
moved up. More to the point, the audio and video in the last interview clip 
remained in sync. 

Another way to remove sections of clips from your timeline is by using Blade 
Edit mode.

4 Click the Linked Selection button again to enable linked selection for the timeline.

5 Click the Full Extent Zoom button and play through the last clip on the timeline.

To tidy up this sound bite, you will remove the portion where Brian says “…stay at that 
location longer…”
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6 Play through the last clip on the timeline and stop just before Brian says “… stay…”

7 Click the Detail Zoom button to zoom in on the playhead location.

8 From the timeline toolbar, click the Blade Edit mode button or press B.

9 With Blade Edit mode selected, position your mouse at the playhead location and click 
the interview clip to add an edit point.

10 Play forward and stop before he says “…or it didn’t make the movie.”

11 Add another edit point by clicking at the playhead location on the clip.
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12 In the timeline toolbar, click the Selection mode button or press A.

13 With Selection mode enabled, click the unwanted middle portion of the interview clip 
you just added the edit points to.

14 Press Shift-Delete (Backspace) to ripple delete the portion between the In and 
Out points.

15 Press / (forward slash) to preview the new edit.

Don’t worry if the audio edit isn’t quite as tidy as you’d like; you’ll have an opportunity to 
refine it soon.

Using Trim Edit Mode
The Blade Edit mode isn’t the only mode you have in your timeline to help you refine the 
edit. For the next exercise, you’ll use the Trim Edit mode.

1 Click the Full Extent Zoom button to view the whole timeline and move the playhead 
back to the beginning of the timeline. 

2 Play through the first clip.

Obviously, there’s some unwanted portion of his interview that you need to trim off at 
the beginning.
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3 Place your timeline playhead just before Brian says, “In this film,…”

4 In the timeline toolbar, click the Trim Edit mode button or press T.

5 Click the beginning of the first clip and drag the edit to the right until it snaps to 
your playhead.

TIP If snapping isn’t enabled, just press N to quickly enable it during the 
trimming operation.

Notice that because the audio and video of this clip are linked, you’re trimming both 
parts of the clip together, and because you are in Trim Edit mode, you’re automatically 
rippling the timeline; all clips in the timeline after the selected edit are rippled to 
maintain their sync’d relationships.

You can also use keyboard shortcuts for more precise trimming.
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6 Place the playhead on the cut between the last two interview clips and click 
Detail Zoom.

7 Position your mouse on the left side of the cut and click to select the outgoing side 
of the edit.

8 Press . (period) twice to add two extra frames to the outgoing clip.

From the waveform, you can clearly see the part of the clip you cut out with the 
Blade mode.

9 Now press , (comma) to trim the same edit point back until the waveform has 
disappeared. 
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10 Select the other side of the edit and repeat the process, using the , (comma) key to add 
frames to the clip and . (period) to remove frames (because you selected a different 
side of the edit).

11 When you think you have a good audio edit, press / (forward slash) to play around the 
selected edit, listening to the changes. Refine if necessary to make the edit sound as 
natural as possible.

12 When you’re happy with the edit, click Full Extent Zoom to display the entire timeline 
and press A to switch back to Selection mode.

Don’t worry if you find these last few steps difficult. Trimming an edit like this so precisely 
that it sounds as if there’s no edit takes practice, experience, and a good ear. The more you 
practice, though, the easier it becomes. Also, because you were in Trim Edit mode 
throughout those steps, it meant that the timeline was rippling with each change. In the 
edit page, this is only possible if you use Trim Edit mode.

Adding the Music
Now that you’ve started refining the timeline, you might want to add the music and then 
build in the final clips.

1 Move your playhead back to the beginning of the timeline.

2 If necessary, use the disclosure arrow to open the AUDIO CLIPS bin, and then select 
the Music bin.

3 There’s just one clip in this bin.
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4 Open the clip Music Score for Trailer.wav in the source viewer.

5 In the edit page, audio clips are displayed in the source viewer with a waveform at the 
top of the whole clip, and a zoomed-in portion below to make seeing the waveform 
and adding any required In or Out points easier.

6 As with the previous lesson, you want to use the whole audio clip, so there’s no need 
to add any In or Out points here.

7 Drag this clip from the source viewer to the Place on Top overlay in the timeline viewer.
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Despite its name, in this instance, the Place on Top edit has actually added a new audio 
track below your existing audio tracks. The Place on Top edit actually places the edited 
clip into the first available empty track in your timeline, working its way upward 
through the video tracks or downward through the audio tracks. If it can’t find an 
empty timeline track for the duration of the source clip, then a new track is created to 
accommodate the new clip. 

You’ll need to attenuate (lower) the level of the music clip; otherwise, you won’t hear 
the interview audio.

8 Use the volume overlay line on the Music Score for Trailer.wav audio clip to lower the 
clip’s volume by about -18 dB.

TIP Hold the Shift key on your keyboard when changing audio levels for more 
precise adjustments.
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NOTE If you need to catch up before moving to the next step, select the 
TIMELINES bin and choose File > Import > Timeline, navigate to R18 Beginner 
Guide Lessons / Lesson 01 / Timelines / Age of Airplanes Catchup 2.drt and 
click Open.

Adding the Final Cutaways
1 Now that you have the music track in the timeline, you need to fill the rest of the time 

with more airplane footage.

2 Move your timeline playhead to the edit point between the last two interview clips.

3 From the B-Roll smart bin, open the clip 04 SOUTH POLE.mov in the source viewer.

4 From the start of the clip, type +200 and press Return (Enter) to jump forward 
2 seconds.

5 Set an In point.

6 Type +500 and press Return (Enter) and set an Out point.
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7 Press F10 to overwrite the clip into the timeline.

8 You’re overwriting the video of Brian’s final interview clip in the process and neatly 
solving the problem of that jump cut at the same time!

9 From the B-Roll smart bin, Command-click (macOS) or Ctrl-click (Windows) the clips 
05 ST MAARTEN.mov, 07 KENYA.mov, and 08 AERIAL ALASKA.mov.

10 Click and hold any of these selected clips and drag across to the Append at End 
overlay in the timeline viewer.
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The three clips are edited at the end of the timeline based on their sort order in the media 
pool. However, because they didn’t have any In or Out points set, they are currently too 
long and need rearranging to make more sense to the story you’re trying to convey.

11 Ensure your timeline is in Selection mode, and then select the three clips you’ve just 
appended to your timeline.

12 Once the clips are selected, click the Trim Edit mode button or press T to enter Trim 
Edit mode.

13 Right-click the selected clips in the timeline and choose Change Clip Duration or press 
Command-D (macOS) or Ctrl-D (Windows).
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14 Type 600 in the Duration field and click Change.

15 The tails (ends) of each of the clips are trimmed so they are all 6 seconds long, and 
because you were in Trim Edit mode when you clicked Change, no gaps are left in 
the timeline.

Shuffle Insert Edits
To quickly change the order of these three clips in the timeline, you will use a Shuffle Insert 
edit (or Swap Insert edit). You will start by shuffling the Aerial Alaska clip backward.

1 Press A or click the Selection Mode button to return to Selection mode.

2 In the timeline, select the last clip, 14 AERIAL ALSAKA.mov.

3 Press Shift-Command-, (comma) in macOS or Shift-Ctrl-, (comma) in Windows.

The selected clip quickly switches position in the timeline with the clip just before it!

4 Press Shift-Command-, (comma) in macOS or Shift-Ctrl-, (comma) in Windows again to 
have the Aerial Alaska clip shuffle back to before the St Maarten clip.



50 Lesson 1 Editing in the Edit Page

5 Select the St Maarten clip and press Shift-Command-. (period) in macOS or Shift-Ctrl-. 
(period) in Windows to shuffle it after the Kenya clip.

Excellent. Now that you have these clips in the correct order, it’s time to trim these clips so 
the whole timeline is the correct duration.

Finessing the B-Roll
You now need to trim the clips to bring your edit to the correct time, before adding the 
credits. To begin with, you will roll the South Pole shot back over the interview to create 
more of an overlap.

1 Place the timeline playhead at the edit point between the Interview clip and the South 
Pole clip and click the Detail Zoom button.

TIP If you find the detail zoom makes the clips too big in the timeline, hold 
Option (macOS) or Alt (Windows) and use the scroll function on your mouse 
or trackpad to reduce the zoom to a more comfortable level.
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2 Ensure that Linked Selection is turned off and click the Trim Edit mode button 
or press T.

3 Place your mouse pointer over the center of the edit point so it displays the trim icon.

4 Click and drag left to trim the start of the clip back by just over 1 and a half seconds 
(about -01:15 in the tooltip) over the previous interview clip, so it starts just after Brian 
says the word “…right…” as indicated in the waveform.

5 Trim the end of the 04 SOUTH POLE.mov clip back until the gray tooltip reads 04:00, 
which indicates a 4-second duration and the timeline ripples.

6 Scroll the timeline forward so you can see the Kenya clip clearly.

7 Trim 1 second off the beginning of the 07 KENYA.mov clip to remove the yellow plane 
from the top of the frame, tidying up this shot.

Next, you will add the closing credits to the end of these clips.
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8 Click the Full Extent Zoom button so you can see the entire timeline.

9 Play the last video clip in the timeline 05 ST MAARTEN.mov and, when you hear the 
final beat of music, stop playback.

10 Click the Titles smart bin and open the CREDITS.mov clip in the source viewer.

There’s no need to add any In or Out points here since you want to use the whole 
credits clip.
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11 Click the Overwrite Clip button or press F10 to overwrite the clip in the timeline.

12 Return the playhead to the start of the timeline and play back to see the results.

The edit is looking good, but there are still a few “nips and tucks” you can apply.

NOTE If you need to catch up before moving to the next step, select the 
TIMELINES bin and choose File > Import > Timeline, navigate to R18 Beginner 
Guide Lessons / Lesson 01 / Timelines / Age of Airplanes Catchup 3.drt and 
click Open.

Slipping and Sliding Clips
Now that you have the edit running at the right time, and the credits appearing on the final 
beat of the music, you need to be careful that any trimming you do doesn’t disrupt this 
timing. This is where Trim Edit mode comes in.

1 Place the timeline playhead at the start of the Aerial Alaska clip and play until the start 
of the credits to review the current clips.

Both the Kenya and St Maarten clips are only using the beginning few seconds of each 
clip. To correct this, you will slip each shot to use a later portion of the clip.

NOTE Slipping a clip doesn’t mean that you’re adjusting the clip’s length in 
the timeline; instead, you’re moving the content of the clip within the clip on 
the timeline.
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2 Place the timeline playhead over 05 ST MAARTEN.mov clip and click the Detailed 
Zoom button. Use Option-mouse scroll (macOS) or Alt-mouse scroll to adjust the 
timeline zoom if necessary.

3 Click the Trim Edit mode button or press T.

4 Position you mouse pointer over the top half of the clip in the timeline, where the 
filmstrip is displayed.

The icon changes to the slip symbol.

5 Click to select the clip and slowly drag the clip to the left.

The timeline viewer switches to a four-up display. The top two images display the start 
and end frames for the clip you have selected (St Maarten), and the bottom two 
images represent the end frame of the previous clip (Kenya) and the start frame of the 
next clip (Credits) in the timeline.
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6 Continue dragging left until the plane in the St Maarten clip has flown out of shot in 
the top right image.

You have successfully slipped the clip to refine the portion of the shot you want to use. 
You can do the same on the previous Kenya clip.

7 Hold Option (macOS) or Alt (Windows) and use the scroll function on your mouse to 
zoom out on the timeline so you can clearly see several clips.

8 Scroll the timeline so it is centered around the 07 KENYA.mov clip, and then place the 
mouse pointer over the Kenya clip’s filmstrip to switch to the slip icon.

9 Click and hold on the clip 07 KENYA.mov and slip the clip backward by about 18 
seconds (-18:00 in the tooltip) to reveal the part of the clip where the plane flies over a 
flock of flamingos.
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Slipping shots like this is very powerful and very intuitive in DaVinci Resolve, as you can 
clearly see and understand what is happening as you make changes in the timeline.

Next, you will just refine the position of the Kenya clip in relation to the two clips on 
either side of it. To do this, you will slide the clip.

10 Adjust the timeline scroll and zoom so you can clearly see the 
08 AERIAL ALASKA.mov, 07 KENYA.mov and 05 ST MAARTEN.mov clips.

11 Ensure that you are still in Trim Edit mode and position you mouse pointer over the 
07 KENYA.mov clip. This time, though, place it in the lower part of the clip below the 
filmstrip and over the bar that displays the clip’s name.

The icon changes shape to the slide icon. This will allow you to slide the clip backward 
and forward between its neighboring clips.

12 Click and hold the clip.

The same four-up display appears in the timeline viewer.

13 Drag the clip slightly to the left a few frames.

This time, the top two images remain still, but the bottom two images are changing. 
This indicates that the clip you have selected is not being affected, but the two clips on 
either side are. 

14 Slide the clip back by 1 second (-01:00 in the tooltip).
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15 Press A or click the Selection Mode button to return to Selection mode.

Play back to review the changes. The Kenya clip lines up much nicer with the beats of 
the music. However, it might not be perfect, so continue making further adjustments if 
necessary until you’re happy with the results.

Trimming Limitations
Whenever you’re trimming clips in the timeline, you are relying on the clips having 
enough handles—that is, extra footage that will allow you to make the trim.

When trimming, you will see a white outline extend from the clip in the timeline. 
This box indicates the amount of extra footage available to you.

If you ever encounter a red selection indicator when trying to trim a clip, you know 
that the clip doesn’t have any handles beyond that point, so if the trim you’re 
trying to make needs this extra footage, you won’t be able to make the change.

Adjusting Pacing
One final change you’ll make to this edit is to adjust the pacing of Brian’s interview slightly 
by introducing a small pause.

1 Move your playhead to the start of the 04 SOUTH POLE.mov clip.

2 Play through Brian’s last audio clip and stop just after he says “…it didn’t make the 
movie” and select the clip.

3 Press Command-B (macOS) or Ctrl-B (Windows) to add an edit to the selected clip at 
the position of the playhead.
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TIP Using this shortcut on selected clips is the same as clicking the clip with 
the Blade Edit mode selected, but it’s a much more efficient way of adding 
edit points.

4 Select the second of the newly-cut clips in the timeline and drag it to the right until it 
snaps to the beginning of 08 AERIAL ALASKA.mov.

Moving the clip forward a second or so in this manner has created a short space in 
Brian’s interview that wasn’t there originally. This allows Brian’s thoughts to “breathe” 
and gives an added emphasis to the line about everything being “real”—the equivalent 
of punctuation for moviemaking.

5 Click the Full Extent Zoom button, return the playhead to the start of the timeline, and 
play back the timeline to review your hard work.

Well done! You’ve built a sophisticated trailer using the editing toolset in the edit page. 
However, there’s still a few things to do before the director will be happy, and you can call 
this edit completed.

In the next lesson, you will continue working on this trailer in the edit page and explore 
some of the features used for editing and mixing audio and for adding transitions, effects, 
and titles.
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Lesson Review
1 What element is most often used to organize imported clips in DaVinci Resolve?

a) Timelines

b) Thumbnails

c) Bins

2 Which zoom function allows you to manually zoom in and out of the timeline?

a) Full Extent Zoom

b) Detail Zoom

c) Custom Zoom

3 True or false? In the edit page, you can insert a clip by dragging and dropping it at an 
edit point in the timeline.

4 Which timeline mode allows you to add edit points (cuts) when you click on a clip?

a) Selection mode

b) Trim Edit mode

c) Blade Edit mode

5 Which of the following can be performed when in Trim Edit mode?

a) Rolling edits

b) Slipping clips

c) Sliding clips
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Answers
1 c) Bins are most commonly used to organize imported clips in DaVinci Resolve.

2 c) Custom zoom allows you to change the zoom around the playhead manually. You 
can use the custom zoom slider, keyboard shortcuts, or Option-scroll (macOS) or 
Alt-scroll (Windows).

3 False. In the edit page, drag-and-drop editing only supports overwrite editing functions.

4 c) Blade Edit mode adds an edit point when you click a clip. You can add edit points in 
Selection mode by positioning the playhead over a selected clip and pressing 
Command-B (macOS) or Ctrl-B (Windows).

5 a), b), and c) You can roll edits and slip and slide clips in Trim Edit mode.



Now that you have the basic structure 
of the edit in place, you will learn how 
to take it to the next level by editing in 
voiceover and sound effects, and then 
mixing the audio together using the 
edit page’s audio tools. Then you’ll look 
at refining the timeline further by 
exploring some tricks that many 
editors often employ to quickly replace 
shots, adjust clip playback speed, and 
change shot size.

There’s a wealth of effects to explore 
further too, including working with 
video transitions and filters and the 
library of Fusion title templates.

With so much to explore, it’s little 
wonder that films are never really 
finished; it’s just that the filmmakers 
run out of time or money or both.
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Setting Up the Project
If you completed the previous lesson and are happy with your timeline, you can go to the 
next section, “Duplicating the Timeline.” However, if you didn’t complete the entire previous 
lesson or are unhappy with how your timeline turned out, you can import a prepared 
timeline to help you get started with this lesson.

1 If necessary, open DaVinci Resolve.

2 In the Project Manager, open the Age of Airplanes project.

NOTE If you didn’t complete the first part of the previous lesson and haven’t 
imported the Age of Airplanes project, refer to the beginning of Lesson 1 to 
learn how to import the project file and relink the offline media.

3 Select the TIMELINES bin and choose File > Import > Timeline.

4 Navigate to R18 Beginner Guide Lessons > Lesson 2, select the file 
Age of Airplanes Trailer Catchup 4.drt and click Open.

The timeline is imported into your project and opens in the timeline window. You can 
now continue with this lesson.

NOTE You will learn more about exporting and importing DaVinci Resolve 
timelines in Lesson 9. 

Duplicating the Timeline
Before going much further, it’s always a good idea to periodically duplicate the timeline 
you’re currently working on. This means that if you (or your client/director) don’t like the 
subsequent changes you make, you always have a backup copy of the timeline to return to. 
It is good practice to duplicate the timeline before you start making major changes.
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1 In the Timelines bin, select the Age of Airplanes Trailer timeline you’ve been working 
on and choose Edit > Duplicate Timeline, or right-click the timeline and choose 
Duplicate Timeline.

A copy of your timeline appears in the same bin called Age of Airplanes Trailer copy.

You can now continue working on the currently loaded timeline, knowing that you 
have a backup of your work up to this point. 

Many editors often like to rename the duplicated timeline, so they know what they are 
looking at in the bin. However, if you leave the name of the duplicated timeline as is, 
subsequent duplication of the original timeline will result in the name of the new 
duplicated timeline being incrementally increased. For example, duplicating the 
Age of Airplanes Trailer timeline again will result in another copy called Age of 
Airplanes Trailer copy 1. This can be very useful when helping to “backtrack” to a 
previous version of the timeline.
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TIP Projects edited over a long period of time can often result in many 
dozens of timelines being created. You can use bins to help organize these 
duplicated timelines so you always know which timeline you should be 
working on. Alternatively, you can always disable a timeline you’re not using 
by right-clicking the timeline in the media pool and choosing Disable Timeline. 
Disabled timelines cannot be opened without first re-enabling them and will 
not appear in the timeline viewer dropdown list.

With a backup copy of your timeline in your bin, you can now continue to work on the 
trailer. You’ll begin by editing the voiceover and some sound effects to the B-Roll 
footage to give it more of an impact.

Adding the Voiceover and 
Sound Effects
In the previous lesson, when you added the music, you let DaVinci Resolve automatically 
create a new track for you. In this instance, you will manually create the new tracks, 
choosing where they will be added in relation to tracks already in the timeline.

1 Right-click anywhere in the timeline track headers and choose Add Tracks.
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2 In the Add Tracks dialog, change the number of video tracks to 0 and the number of 
audio tracks to 2. Ensure that the Insert Position for the new audio tracks is set to 
Below Audio 1 and leave the Track Type at Stereo. Click Add Tracks.

The additional audio tracks are added as specified.

Depending on your screen resolution, you may now need to reframe the timeline so 
you can see as many tracks as possible.

3 First, move your mouse over the track divider between the video and audio tracks. 
When it changes to a resize indicator, click and drag upward so that you can see more 
of the audio tracks.

You may also need to further adjust the track heights of the video and audio tracks so 
you can see all five tracks together.
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4 Click the timeline view options menu on the left side of the timeline toolbar. Use the 
Track height sliders to resize the video and audio tracks and adjust the track divider 
as appropriate.

5 Once you are happy that you’re seeing all the timeline tracks, click the Full Extent 
Zoom button to ensure that you’re seeing the entire timeline.

Before you start editing the audio clips into these new tracks, it’s useful to name the 
tracks appropriately.

6 In the track headers on the left side of the timeline, click on the name for Audio 1 to 
highlight it and type DIALOGUE to rename the track.

7 Repeat the previous step for Audio 2, renaming it to VO, short for voiceover.

8 Rename Audio 3 to SFX, which is short for sound effects.
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9 Finally, rename Audio 4 to MUSIC, for obvious reasons.

You are now ready to add the new audio clips to their appropriate tracks.

Editing the VO
Editing audio clips in the timeline doesn’t differ much from editing video clips, so you will 
begin by using some familiar techniques. 

1 In the media pool, click the disclosure triangle for the AUDIO CLIPS bin and select 
the VO bin.

This bin contains two audio clips.

2 Open the first clip, HF VO 1.wav, in the source viewer and play back the clip to 
listen to it.

3 Set an In point at the start of the waveform just before the narrator says, “In the age 
of airplanes…” and set an Out point at the end of the waveform where he says “…
once again.”
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You will add this first VO clip using drag-and-drop editing.

4 In the timeline toolbar, click the Snapping button to disable it.

TIP Snapping is useful for quickly aligning clips in the timeline and can be 
enabled and disabled by pressing N on your keyboard.

5 Click and drag the audio clip from the source viewer into the timeline between the first 
two clips on the DIALOGUE audio track, but on the VO track. Play back to hear the 
narration that occurs between Brian’s sound bites.

Drag-and-drop editing works well, up to a point, but it can be much more efficient to 
use the editing functions that you’re already familiar with.

6 Press N to re-enable Snapping for the timeline and position the timeline playhead at 
the start of the Kenya clip.

TIP If you prefer to leave Snapping off, you can still use the Previous/Next 
Edit buttons to jump to the edit point.

7 From the VO bin in the media pool, open the HF VO 2.wav clip in the source viewer. 
Play the clip to listen to it.
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This is a section of voiceover from the original film that you will repurpose for 
the trailer.

8 In the source viewer, mark In and Out points around where the narrator says “…leave 
behind everything you know about airplanes….”

Since you want this clip to be edited onto the VO track, you’ll need to change the track 
destination selection to that track.

9 In the timeline track controls, drag the red-outlined A1 control (which represents the 
audio in the source viewer) down to the VO track (A2). This changes the targeting of 
the source audio to the VO track.
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10 Drag the clip from the source viewer to the timeline viewer for an Overwrite edit or 
click the Overwrite Clip button in the timeline.

The clip is edited into the targeted track, starting at the playhead position.

11 In the source viewer, set In and Out points around the last line of voiceover where the 
narrator says “…and prepare to see them again – for the first time.”

12 Click the Overwrite Clip button in the timeline toolbar or press F10, and then play this 
section of the timeline with the new voiceover added.

Excellent. With the voiceover added, you can now turn your attention to adding the 
sound effects to help bring the B-Roll shots to life.
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Editing the Sound Effects
1 In the track header, click the A3 track destination selection to move the red-outlined 

A1 button to the SFX Track.

Now that you’ve specified the destination track, you will now specify where on this 
track you will edit the sound effect clips. 

2 In the timeline, select the second clip 02 A380 TAXI.mov and choose Mark > Mark 
Selection, or press Shift-A.

3 In and Out points appear around the selected clip in the timeline, marking where you 
want the clip you will edit to start and stop.

NOTE If you Command-click (macOS) or Ctrl-click (Windows) the selected clip 
to deselect it, you will see the duration clearly highlighted through 
the timeline.

4 In the media pool, select the Sound Effects bin and open the SFX 01 Jet Taxi.wav clip 
in the source viewer and click the Go To First Frame button or press the Up Arrow key.
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5 In the source viewer, type +100 and press Return (Enter) and press I to add an In point 
1 second from the start of the clip. 

6 Click the Overwrite Clip button in the timeline toolbar or press F10.

The clip is overwritten to the correct track in the timeline and between the In and Out 
points, removing the In and Out points in the timeline in the process.
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NOTE Drag-and-drop editing will not honor the In and Out points in the 
timeline because it always uses the duration marked in the source viewer. This 
is one of the main advantages of not using drag-and-drop editing if you know 
where you want to edit a clip into the timeline.

You will continue to use this technique to keep editing the rest of the sound effects.

7 Select the 04 SOUTH POLE.mov clip and press Shift-A to mark the selection.

8 From the Sound Effects bin, open SFX 02 Prop.wav in the source viewer.

9 Set an In point somewhere in the middle of this clip.
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10 Make an Overwrite edit.

11 Select the clip 08 AERIAL ALASKA.mov clip and press Shift-A.

12 From the Sound Effects bin, open SFX 03 Distant Prop.wav in the source viewer.

13 Mark an In point after the audio settles down to more of a drone (after the big 
waveform at the start of the clip).
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14 Make an Overwrite edit.

15 Select the Kenya clip in the timeline and press Shift-A to mark the selection.

16 From the Sound Effects bin, open SFX 04 Light Wind.aiff in the source viewer.

17 Listen to the clip and mark an In point where you would like the edited clip to start.

18 Make an Overwrite edit.

Fantastic. Hopefully, you can see just how efficient it is to be able to target different 
portions, and specific tracks in the timeline when you’re editing to other timeline clips. 
However, there are still some shots that need sound effects, so you will use some 
slightly different techniques for these.

Backtimed Edits
Backtiming an edit means you specify where you want a shot to end by just adding an Out 
point rather than an In point in the source viewer.

1 Select the third clip in the timeline 01 A380 TAKEOFF.mov and press Shift-A to mark 
the selection.

2 From the Sound Effects bin, open the SFX 05 Jet takeoff.wav clip in the source viewer.

3 Play through the clip until the sound of the jet starts to fade away.
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4 Press O to add an Out point.

NOTE For backtimed edits to work, you only need an Out point. If necessary, 
you can remove an In point by choosing Mark > Clear In or by pressing Option-I 
(macOS) or Alt-I (Windows). Similarly, to remove an Out point completely, simply 
choose Mark > Clear Out or press Option-O (macOS) or Alt-O (Windows). To 
remove an In and Out point at the same time, choose Mark > Clear In and Out 
or press Option-X (macOS) or Alt-X (Windows).

5 Make an Overwrite edit.

This time, the Out point you set in the source viewer has specified where the new clip 
should stop. Pretty neat, huh?
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You can reuse this same sound effect for the final shot before the credits.

6 In the timeline, select the 05 ST MAARTEN.mov clip and press Shift-A.

7 Make an Overwrite edit.

That just leaves one clip left to add a sound effect to.

Syncing Sound to Action Using Replace Edit
The Replace edit is slightly different from the editing functions you’ve become familiar with, 
as it primarily uses the positions of the timeline and source playheads to align the edits.

1 Move the timeline playhead over the clip 03_MALDIVES.mov just before you see the 
wings come into the shot in the timeline viewer.
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2 From the Sound Effects bin, open the clip SFX 06 Overhead.wav in the source viewer.

3 In the source viewer, position the playhead over the highest point of the waveform.

4 Drag the audio clip from the source viewer to the Replace option in the timeline 
viewer overlay.

5 Press / (forward slash) to preview the results of this edit.

The sound effect is quickly synced to the action onscreen as the two playhead 
positions specified how the clip should be aligned in the timeline. This would have 
been much harder to judge if you were manually trying to sync the action by dragging 
the clip in the timeline or trying to judge where the In or Out points should be placed.
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You’ll use Replace edit again in a later exercise, but it’s worth noting that this is one of 
the most useful types of edits beyond the usual Overwrite and Insert edits. In fact, it’s 
so common to use Replace that it is one of only three editing functions available in the 
timeline toolbar.

NOTE If you need to catch up before moving on to the next step, select the 
TIMELINES bin and choose File > Import > Timeline, navigate to R18 Beginner 
Guide Lessons / Lesson 02 / Timelines / Age of Airplanes Catchup 5.drt and 
click Open.

Mixing the Soundtrack
Now that you’ve got some sound effects in your edit, the whole timeline seems to come 
alive, which just goes to prove how important audio is to a successful edit. However, the 
sound effects are currently too loud and are drowning out the other audio clips. Time for 
some audio mixing!

1 In the upper-right corner of the interface, click the Mixer button.

The audio mixer opens to the right of the timeline.

2 Click and drag the left side of the audio mixer to resize it so you can see the controls 
for all the tracks in the timeline.

TIP If you’re struggling for screen space with the mixer open, click the Media 
Pool button in the top left of the interface to hide the media pool.

3 Return the playhead to the beginning of the timeline and play back, watching the track 
meters in the mixer.
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Reading the Audio Meters
Before you make any clip volume adjustments, it is a good idea to know how to 
read the meters in DaVinci Resolve, which use decibels full scale (dBFS) scale to 
measure the volume of your audio clips. These meters range from a maximum of 
0 dBFS down to -50 dBFS. Any audio levels above 0 dBFS are clipped and will 
sound distorted, so you must always keep audio levels below 0 dBFS. Although 
not a hard and fast rule, tracks such as dialog, sound effects, and music generally 
have target dB levels you can use as good starting points. 

Clipping Level 

Dialogue Target 

Sound Effects Target

Music Target 

Normal spoken dialogue should average around -12 dBFS on the meter and 
remain in the yellow area. 

Sound effects have a wider target range because they have such a wide variety, 
but in general, try to target sound effects to fall between -10 and -30 dBFS. 

Music tends to sound much louder due to its narrower dynamic range. You should 
aim to have music tracks set between -20 and -30 dBFS. 

These level guidelines are good starting points, but in the end, your ears must be 
the final judges of what sounds right. 
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Setting Dialogue Levels
Because dialogue is the most important element in any soundtrack (if you can’t hear what 
someone is saying, then there’s really no point in watching), that’s usually a good 
place to start.

In this timeline, you have two dialogue tracks: Brian’s interview and the VO. Both need to 
be at a consistent level, averaging around -12 dBFS on the audio meters. You will start by 
normalizing the dialogue clips.

NOTE Normalizing clips doesn’t necessarily make them right, since it is based on 
the peak level (the loudest point) of the clip, but it is a useful technique for getting 
the levels of different clips to be more consistent. 

1 In the audio track headers in timeline, click the Solo buttons for the Dialogue and 
VO tracks.

TIP There are Mute and Solo buttons in the Mixer too.

2 Play the timeline again with just the two dialogue tracks playing and watch their audio 
meters in the mixer.

Some of the clips are louder than others, with some peaking at about -8 dBFS and 
others barely reaching -18 dBFS!
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3 Drag a lasso across all the clips on the Dialogue and VO tracks to select them.

4 Right-click any of these selected clips and choose Normalize Audio Levels.

5 In the Normalize Audio Level window, leave the Normalization Mode set to Sample 
Peak Program and the Target Level at -9 dBFS. Change the Set Level to Independent 
and click Normalize.

TIP You may be wondering, why choose -9 dBFS when the average levels for 
dialogue should be at -12 dBFS? The answer is simple: -9 dBFS is referring to 
the peak level, not the average level. The peak level is the highest point in the 
audio clip. It is a useful starting point when normalizing dialogue.
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All the selected clips on the timeline change to a slightly darker shade, indicating that 
they have been adjusted in some way.

6 Play the timeline again from the beginning, looking at the audio meters and checking 
the levels.

The levels of the clips on the two dialogue tracks are much more consistent now, but 
there are still some clips that need fine tuning.

7 In the timeline, play from the third clip on the DIALOGUE track.

The fourth clip, where Brian says “…or it didn’t make the movie…” sounds a little too 
loud because the peak level for this clip wasn’t as high as the others, so it’s been 
adjusted more.

8 Place your playhead over the fourth clip on the DIALOGUE track and Option-mouse 
scroll (macOS) or Alt-mouse scroll (Windows) to zoom in on the clip.

TIP To expand the track size, use Shift-mouse scroll.
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9 Click and drag the volume overlay to lower the audio level back down until the tooltip 
reads about 4 dB.

10 Do the same with the fifth clip on the DIALOGUE track, bringing the clip level down a 
couple of decibels, to about 7 dB.

11 Click the Full Extent Zoom button and play the timeline again to hear the changes and 
watch the new levels in the meters.

There’s much more consistency between the different dialogue clips now, but there’s 
still a problem with the first clip on this Dialogue track because it seems much lower 
than it did before the normalization.

12 Stop playback and return the playhead to the beginning of the timeline.

13 Use Option-mouse scroll (macOS) or Alt-mouse scroll (Windows) to zoom in on the first 
audio clip.

14 Use Shift-mouse scroll to resize the audio track heights, making it easier to see 
the waveform.

Notice the large spike in the waveform at the start of the clip. This explains why the clip 
level was lowered when it was normalized. You will correct this by adding a couple of 
keyframes to change the level within the clip.
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15 Option-click (macOS) or Alt-click (Windows) the volume overlay just after the waveform 
spike at the start of the clip.

A red keyframe is added to the volume overlay.

16 Option-click (macOS) or Alt-click (Windows) the volume overlay again just after the next 
part of the waveform to add a second keyframe.

17 Drag the volume overlay after the second keyframe to increase the part of the 
waveform after the keyframes to about 2 dB.

18 Play back the timeline to review the changes and ensure that the audio for the first 
track remains at a consistent level.

19 Click the Full Extent Zoom button and resize the track heights so you can see the 
entire timeline again.

Well done. You have successfully set your dialogue levels for this timeline. Now you can 
begin mixing the sound effects and music around this.
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Mixing the Sound Effects
Now it’s time to turn your attention to the clips on the SFX track. First, you’ll want to adjust 
the levels and then apply fades. 

1 In the timeline track header, click the Solo button for the SFX track to include it with 
the playback with the dialogue tracks.

Since these clips are all roughly at the right level relative to each other, instead of adjusting 
each clip to the appropriate level individually, you will adjust the level for the entire track.

2 Begin playing the timeline from the beginning and, in the mixer, lower the SFX track 
slider down by about -12 dB so that the meters are bouncing between the -20 dBFS to 
-30 dBFS area.
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TIP You can see how much you have adjusted the track level by the small 
white value above the track slider in the mixer.

You can still adjust the level of each clip individually in the timeline, so if you feel that a 
clip is too loud or too quiet compared to the other clips on the same track, you can 
always adjust that clip to bring it in line with the others.

3 Increase the level of SFX 03 Distant prop.wav by about 2 dB and 
SFX 04 Light Wind.wav by about 4 dB so that the level of these clips are more 
consistent with the others in the track.

Now that you’ve set the track level for the sound effects, you can start transitioning in, 
out and between each of these clips.

4 Position the playhead over the first clip on the SFX track, SFX 01 Jet Taxi.wav, and 
zoom in to the clip using the Detail Zoom button.

5 Place you mouse pointer over the SFX 01 Jet Taxi.wav clip and select the white 
indicator in the top-left corner of the clip.

This indicator is the fade handle for the start of the clip. There is a similar fade handle 
in the top right for fading the end of the clip.
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6 Drag the incoming fade handle to the right by 1 second (+01:00 in the tooltip).

7 Trim back the start of this clip by about 18 frames so the fade in starts just as Brian 
says “…the real world.”

8 Play back to review the changes.

The fade handles are a very effective and flexible way of fading clips in and out.

9 Scroll to the middle of the timeline and apply a fade-in to the clip SFX 02 Prop.wav.
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10 Scroll forward and zoom out slightly so you can see the last clip in the SFX track, 
SFX – Jet Take off.wav.

11 Trim the end of this clip to the right as far as it will go and apply a 4-second fade to the 
end so that the sound of the plane trails out underneath the credits.

The fade handles are great for when you want to fade a clip in or out, but not so useful 
if you want to fade between clips on the same track. For that, you will need to add an 
audio transition.

12 Click the Full Extent Zoom button to display the entire timeline.

13 Click the Effects button in the top left of the interface to open the Effects Library.
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14 Click the Audio Transitions category and drag and drop the Cross Fade 0db transition 
to the edit point between the first and second clips on the SFX track.

NOTE The red icon to the left of the transition name indicates that this is the 
standard transition. To change the standard transition, right-click another 
transition and choose Set As Standard Transition.

15 Drag the same transition to the next edit point on the SFX track.

16 Close the Effects Library by clicking the Effects button again.

You can add multiple transitions at the same time.

17 Command-click (macOS) or Ctrl-click (Windows) the three edit points between the last 
four clips on the SFX track.
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18 Choose Timeline > Add Audio Only Transition or press Shift-T to instantly add the 
current standard transition to the selected points.

TIP You can also right-click these selected edit points and choose to add the 
standard transition in quarter-, half-, one- or two-second durations.

The cross-fade transitions allow the audio to fade gracefully from one audio clip to 
another, rather than cutting suddenly to the next sound.

Finishing the Mix
The last thing you need to do for the audio for this trailer is to add the music track back 
into the mix. To do this, you will unsolo all the other tracks to hear how all the elements 
mix together.

1 In the timeline track header, Shift-click the Solo button for any of the soloed tracks, 
making all tracks active.
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2 Play the timeline, listening to how the music integrates with the rest of the mix, and 
making further adjustments to the clip or track level as you see fit.

When you’re happy with the overall level of the music, you can add a touch of drama 
toward the end of the edit, after the narrator’s final words.

3 In the timeline, place the playhead over the 05 ST MAARTEN.mov clip and zoom in so 
you can clearly see the waveforms of the last few clips.

4 Using the waveform of the clip on A2 as a guide, Option-click (macOS) or Alt-click 
(Windows) the volume overlay for the music clip to add a keyframe, just as the narrator 
is saying their final words.



93Mixing the Soundtrack

5 Option-click (macOS) or Alt-click (Windows) the volume overlay again just before the 
final beats of music to add a second keyframe and raise the volume overlay after this 
second keyframe by 6 dB so the music swells for the credits.

6 Click the Full Extent Zoom button, return the playhead to the start of the timeline, and 
play to listen to the overall mix, making further adjustments if necessary.

7 When you’re satisfied with the mix, click the Mixer button to close the mixer.

NOTE If you need to catch up before moving on to the next step, select the 
TIMELINES bin and choose File > Import > Timeline, navigate to R18 Beginner Guide 
Lessons / Lesson 02 / Timelines / Age of Airplanes Catchup 6.drt and click Open.

The trailer is coming along well, but as always there are some minor tweaks you will want 
to make before you can call this project a wrap. To begin with, you will look at replacing one 
shot with another and adjusting the speed of a clip to enhance the action. Then you will 
add some considered transitions and other effects, before finally adding the titles. So, 
there is still quite a bit to do.
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Replacing Shots
Earlier in this lesson, you used the Replace edit to match an audio clip with the onscreen 
action. This time, you will use the same function to be able to quickly exchange one shot 
for another: either a completely different shot or another take of the same shot.

1 In the timeline, position the playhead at the start of the 04 SOUTH POLE clip.

This clip has served you well through this edit, but looking at it objectively, it’s not the 
most dynamic of shots. It’s time to see if there are any more clips that can be used 
instead of this.

2 If the media pool is currently closed, click the Media Pool button in the top left of the 
interface to reopen it, and then select the B-Roll smart bin.

3 Open the clip 09 LAKE TAXI.mov in the source viewer. 

This clip is a nice replacement for the 04 SOUTH POLE.mov clip.
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4 In the source viewer, locate a frame where the plane enters the sunlit part of the lake.

5 Click the Replace Clip button in the timeline toolbar to replace the clip in the timeline.

Remember, the Replace edit uses the source and timeline playhead locations to complete 
the edit. That’s why both frames in the source and timeline viewer are now identical.
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NOTE Replace will always ignore any In or Out points placed in the source 
clip but will use In and Out points in the timeline. This is useful when you want 
to limit the duration of the replaced part of the timeline.

Now you can see just how easy it is to replace one shot with another. You’ll do the 
same with another clip, but in a slightly more sophisticated manner.

6 In the timeline, place your playhead over the last clip before the credits, 
05 ST MAARTEN.mov.

You will want to try to find a frame in this shot that is recognizable.

7 Refine the position of the playhead within this clip so that the jet engines of the plane 
are centered in the frame.

8 Right-click the clip in the timeline and choose Find In Media Pool.
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The media pool opens with the original source clip of the St Maarten shot selected. 
This process is very useful for finding the original clips used in the timeline, mainly 
because other takes for the same material are often located near it.

9 In the media pool, find the next sequentially named clip, 06 ST MAARTEN 2.mov, and 
open it in the source viewer.

This is a very similar shot to the one you’ve been using in the timeline up until now, but 
it has the added drama of having people in the foreground, making for a much more 
exciting finale to the main trailer.

10 In the source viewer, position the playhead at a frame that has the most visual 
similarity to the frame shown in the timeline viewer.

11 Click the Replace Clip button in the timeline toolbar or press F11.

12 Play the timeline to review the change.
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The clip in the timeline was replaced with the more exciting version, using the position of 
the source and timeline playheads and the timeline clip’s duration, making the timing of 
the new shot mostly the same as the original. Hopefully, you can now see another reason 
why the Replace edit is one of the most used editing functions!

Changing Clip Speed
Another commonly used editing trick is to adjust the speed of a clip to make it play faster 
or slower than it was originally shot. This can be used to enhance action in several ways.

1 In the timeline, select the 08 AERIAL ALASKA.mov clip.

This is a great shot of the red plane flying through the mountains but adjusting the 
speed of the clip will make it a little more interesting.

2 Click the Inspector button in the top-right corner of the interface to open the Inspector.
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3 Click the Speed Change section to reveal the speed controls for the selected clip.

The Direction options allow you to play the clip forward or backward or to create a 
freeze frame of the clip at the position of the playhead. Alternatively, you can use the 
Speed % or Frames per Second fields to adjust the playback speed of the clip.

4 Click the Speed % value field and type 200 and press Return (Enter).
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The clip is now running at 200% (twice) its original speed, and a speed icon appears 
next to the name of the clip on the timeline to indicate a change has been applied to 
the playback speed.

5 Play back the clip in the timeline to review the results of this change.

NOTE The duration of the clip didn’t change in the timeline because you 
didn’t select Ripple Timeline as an option before you changed the speed. 

In addition to speeding up a clip, you can also slow down a clip in the same manner.

6 Select the 09 LAKE TAXI.mov clip you recently added.

7 In the Speed Change controls in the Inspector, change the Speed % value to 50.

The clip is now playing back at 50% (half) its original speed. Unfortunately, the clip now 
plays by repeating frames because it’s now running at just under 12 frames per 
second (as indicated in the Speed Change controls). Thankfully, Resolve provides a way 
to smooth these types of speed changes.
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8 Scroll to the bottom of the Inspector and click the Retime and Scaling section to open 
the controls.

9 Change Retime Process to Optical Flow for the selected clip and play back the 
09 LAKE TAXI.mov clip in the timeline to see the results.

Optical flow is a useful process to apply to clips running slower than 100% since it will 
attempt to create new frames in between the original, actual frames. In cases such as 
this clip, it can work well, but when one object passes in front of another, it can often 
result in an undesirable rippling of pixels.
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About Real-Time Performance and the Render Cache
DaVinci Resolve is high-performance software that is optimized to deliver real-
time effects at high resolutions on a variety of workstations. To ensure that your 
system is maintaining real-time performance, you can check the GPU and frame 
rate playback indicator at the top of the viewers. If the indicator is green, all is well. 
However, if it changes to red, this indicates that the available GPU power of your 
computer is insufficient for real-time playback, and the frame rate indicator drops 
accordingly. Depending on your system specs, this is probably most noticeable 
when trying to play back clips with multiple color corrections or a portion of the 
timeline with many effects and/or titles.

While DaVinci Resolve includes several options you can employ when your 
real-time performance drops, one of the simplest solutions is to enable the 
Render Cache by choosing Playback > Render Cache and choosing one of the 
three options:

 — Off – no render caching takes place, and all timeline clips, grades, effects, and 
titles are attempted to be played in real time.

 — Smart – automatically caches intensive effects and timeline clips in formats 
judged too processor-intensive to play in real time.

 — User – allows you to manually specify which timeline clips will be cached, 
along with automatically caching all Fusion titles and effects as part of the 
Project Settings (see Lesson 6).

Smart is arguably the easiest option to use as it will do much of the work for you, 
and you can always manually flag a clip to cache by right-clicking the clip and 
choosing Render Cache Color Output.

You can clean up the render cache for the current timeline at any point by 
choosing Playback > Delete Render Cache and choosing All, Unused, or 
Selected Clips.

Option-R (macOS) or Alt-R (Windows) allow you to cycle between the three render 
caching options.



103Changing Shot Framing

Changing Shot Framing
The Inspector also contains several Transform controls that you can use to adjust the size, 
position, and rotation of a clip. This can be very helpful if you wish to change the shot size 
for visual variety.

1 Move the timeline playhead over the shot of Brian in the middle of the timeline, 
between 03 MALDIVES.mov and 09 LAKE TAXI.mov. Click to select the clip.

2 Use the scroll function on your mouse or trackpad to zoom out the timeline viewer, so 
you can see the sides of the clip easily.
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3 Click the timeline viewer’s onscreen adjustment controls, to the left of the timeline 
viewer’s jog wheel.

The white box that appears allows you to adjust the Transform controls for this clip.

NOTE You can also use the Transform controls in the Video tab of the 
Inspector to make the same adjustments.

4 Click and drag any of the corner handles to adjust the Zoom values to resize the shot 
of Brian in the timeline viewer without changing the aspect ratio of the clip.
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5 Reframe the shot by clicking inside the box (avoiding the round control handles) and 
drag to change the Position X and Position Y controls.

6 When you have successfully reframed this clip, click the Transform onscreen controls 
button to turn off the onscreen controls.
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7 Click the timeline zoom pop-up menu in the top-left corner and choose Fit, or press Z, 
to return the timeline viewer zoom to Fit.

Dynamic Zoom
1 Place the playhead at the start of the 06 ST MAARTEN 2.mov clip and select the clip 

to see its settings in the Inspector.

2 Enable Dynamic Zoom by clicking the toggle control.
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3 In the Timeline onscreen controls pop-up menu, select Dynamic Zoom.

The green box in the timeline viewer shows the starting size and position of the shot, 
and the red box shows the ending size and position of the shot.

4 Click a corner handle for the green box and make it slightly smaller for a tighter 
framing at the beginning of this clip.
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5 As before, click the onscreen controls to disable the controls in the timeline viewer.

6 Play back the clip to see the changes.

The clip now has an additional “camera move” applied that pulls out to follow the 
airplane flying overhead.
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Keyframing Animation
If you want more control over how a clip is adjusted over time, you can manually 
apply keyframes to the different parameters in the Inspector. Use the small 
diamond button to the right of each parameter’s value field in the Inspector to 
add a keyframe at the position of the timeline playhead, holding the parameter 
values at that point. Move the playhead to a new position in the timeline and 
adjust the parameter values further to automatically add a new keyframe. Resolve 
will change the parameter value from the first keyframe to the second keyframe 
during playback.

Click the Animation Curve button to view and adjust the keyframe graph for any 
clip that contains keyframes in the timeline.

Adding Transitions
You should always add transitions to your projects with great care. Transitions should be 
inserted with consideration of the story you are telling and should not be used if they 
detract from that story. As a wise man once said, “With great power comes great 
responsibility.”

Sage advice aside, transitions are a good way to show a change of location or time that 
might be a bit too abrupt for your audience if left with just a straight cut.

1 Position the timeline playhead at the edit point between 01 A380 TAKEOFF.mov and 
03 MALDIVES.mov and click Detail Zoom in the timeline toolbar.
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2 Click the Effects button to open the Effects Library and choose the Video 
Transitions category.

NOTE As with clips in the media pool, and filters and titles in the Effects 
Library, transitions can be live previewed.

3 From the Wipe transitions category, select Edge Wipe and drag it directly to the edit 
point between 01 A308 TAKEOFF and 03 MALDIVES. Play back the transition to see 
the results.

4 The transition uses the default settings to wipe up from the bottom of the screen, 
revealing the incoming clip.



111Adding Transitions

5 Select the transition in the timeline, and in the Inspector, change the Duration to 12 
frames and the Angle to about -80.

NOTE Transitions are added at a default duration of 1 second. This can be 
changed in the DaVinci Resolve User Preferences, which you will explore 
in Lesson 6.

6 Check the Feather box and increase the border to around 100.
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7 Finally, press / (forward slash) to preview the selected transition and channel your 
inner George Lucas.

As with audio transitions, there is a standard video transition, indicated by the red icon 
to the left of the transition. The default standard transition is the humble 
Cross Dissolve.

TIP To change the standard transition, right-click another transition in the 
Effects Library and choose Set as Standard Transition.

You can also add this standard transition to multiple edit points as you did previously 
with the standard audio transition.

8 In the timeline, Command-click (macOS) or Ctrl-click (Windows) the three edit points 
between 09 LAKE TAXI.mov, 08 AERIAL ALASKA.mov, 07 KENYA.mov and 
06 ST MAARTEN 2.mov.

Notice the red handle on the incoming side of the 09 LAKE TAXI.mov and 
14 AERIAL ALSKA.mov edit. This indicates that there are no handles available at the 
start of the 08 AERIAL ALASKA.mov clip.

9 Choose Timeline > Add Video Only Transition.

A warning appears informing you that if you want to continue to add the transition, the 
clips with insufficient handles will be trimmed, disrupting all the careful editing you’ve 
achieved so far. To prevent this from occurring, you’ll need to adjust the clip to provide 
the required handles.
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10 Click Cancel.

11 Click the Trim Edit mode button in the timeline toolbar, or press T.

12 Slip the 08 AERIAL ALASKA.mov clip backward by at least a second (-01:00 in the 
tooltip), but feel free to slip it further if you wish.

Using a later part of the clip means there’s now plenty of handles on either side for 
the transitions.

13 Command-click (macOS) or Ctrl-click (Windows) each of the edit points between 
09 LAKE TAXI.mov, 08 AERIAL ALASKA.mov, 07 KENYA.mov and 
12 ST MAARTEN 2.mov to reselect them.

14 Choose Timeline > Add Video Only Transition or press Option-T (macOS) or Alt-T 
(Windows) to apply the current standard transition. 

TIP You can change the duration of all multiple transitions by Command-
clicking (macOS) or Ctrl-clicking (Windows) each of them in the timeline and 
pressing Command-D (macOS) or Ctrl-D (Windows) to open the Change 
Transition Duration window.
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Adding Filters
Another common type of effect you can apply to clips are filters to change the look of a 
video clip or the sound of an audio clip.

DaVinci Resolve provides several Open FX video filters, along with a series of Fairlight FX.

1 Position the timeline playhead over the first clip in the timeline and select it.

2 In the Effects Library, select the Open FX Filters category and scroll down to the 
Resolve FX Stylize group.

3 Select the Vignette filter and drag it to the selected clip in the timeline.

The vignette effect is applied to the selected clip with the default settings that darken 
the edges of the frame a little too much.
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TIP You can double-click a filter to apply it to the selected timeline clip(s).

4 Click the Effects tab in the Inspector to reveal the Vignette effect controls.

5 Change the Softness value to 0.0 to better see the shape of the vignette.

6 Decrease the Anamorphism to around0.6 and increase the Size value to about 1.4.
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TIP The Size slider only allows you to adjust the value to a maximum of 1. To 
increase it further, click and drag in the value field, or select the field and type 
in the value you desire.

7 Increase the Softness back up to about 0.4.

8 Change the Operating Mode to Advanced and change the Center X value to about 0.56 
to move the center of the vignette more over Brian’s face, subtly drawing the viewer’s 
attention more toward him.

You now need to apply this same effect to the other time that you see Brian. To do this, 
you will copy the filter from the first clip.

9 With the first clip still selected, choose Edit > Copy or press Command-C (macOS) or 
Ctrl-C (Windows).

10 Scroll the timeline until your see the next clip of Brian. Click the timecode bar to have 
the playhead jump over this clip and select the clip in the timeline.

11 Choose Edit > Paste Attributes or press Option-V (macOS) or Alt-V (Windows).

The Paste Attributes window appears, allowing you to choose which attributes you 
wish to paste from INTERVIEW 01.mov to INTERVIEW 02.mov.
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12 Select Plugins and click Apply.

The effects applied to the copied clip are pasted to this clip, with the same settings. 

You can now use the controls in the Effects tab of the Inspector to refine the effect for 
this clip further.
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Studio Only Filters
If you’re using the free version of DaVinci Resolve to work through this book, as 
you are live previewing the Open FX filters, you will no doubt come across filters 
that bring up the DaVinci Resolve Studio watermark in the viewer. These filters are 
only fully available in DaVinci Resolve Studio.

You can still apply these filters, but you will see a dialog telling you that you have 
reached the limitation of the free version of DaVinci Resolve.

If you choose to continue without upgrading, the watermark will continue to 
display in the timeline viewer when playing that clip. However, if you open the 
same project in DaVinci Resolve Studio, the watermark will disappear.
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Adding Fusion Titles
The final step for this edit is to add a title so that everyone knows who Brian is and all the 
different locations featured in the film.

1 Click the Full Extent Zoom button and move your playhead to the beginning of 
the timeline.

2 In the Effects Library, select the Titles category.

The Titles category lists all the title generators and Fusion title templates.

TIP Place your mouse pointer over any of the title templates to live 
preview them.

3 From the list of Fusion titles, select the template called Simple Underline Lower Third.
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4 Drag the title to the timeline into the space above the interview clip.

The Fusion title gets placed above the first video clip on a new track.

5 Place the playhead over the title and select the title clip in the timeline.

The controls for this title appear in the Inspector.

TIP You can double-click a title in the edit page to automatically open the 
Inspector and adjust the controls.

These controls allow you to adjust the main characteristics of the text within this 
Fusion title.
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6 Place your timeline playhead over it to see the changes as you make them.

7 In the text box, highlight the “SAMPLE TITLE” text and type BRIAN J. TERWILLIGER.

8 Adjust the tracking value to about 1.03 to reduce the spacing between the letters.

TIP To reset any Fusion title parameters to their defaults, click on the small 
gray dot that appears below the slider once you make a change to the 
parameter. To reset the entire template, click the Reset control to the right of 
the title’s name at the top of the Inspector.

9 Scroll down to the bottom of the Inspector to the Line Controls section.

10 Change the Type pop-up menu to Horizontal.

11 Change the color of the left side of the line to a bright shade of yellow.
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12 Change the color of the right side of the line to a warm orange.

13 Finally, in the timeline, trim the end of the title to the end of the first clip on V1.

You will reuse this title, together with the changes you’ve made throughout the rest of 
this trailer for the different locations that will be featured in the film.

14 Make sure the title clip is still selected in the timeline and choose Edit > Copy or press 
Command-C (macOS) or Ctrl-C (Windows) to copy the clip.
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15 Place your playhead at the start of the 03 MALDIVES.mov clip and choose Edit > Paste 
or press Command-V (macOS) or Ctrl-V (Windows).

16 A copy of the title is pasted over the 03 MALDIVES.mov clip.

NOTE By default, Resolve will paste a clip back into the same track it was 
copied from.

17 Trim the end of the title to the end of the 03 MALDIVES.mov clip.

18 Select the title and, in the Inspector, change the text in the text box to MALDIVES.
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19 Repeat these steps to paste additional copies of the title over the 
09 LAKE TAXI.mov and 08 AERIAL ALASKA.mov, changing the text of this instance 
to ALASKA. Paste another copy of the 07 KENYA.mov clip, changing the text to 
KENYA, of course.

TIP You can drag a copy of the title from the timeline to the media pool to 
save a copy of the edited title for later use in the current project.

NOTE To import a finished version of this timeline that was completed following 
the steps in the two previous lessons, select the TIMELINES bin and choose File > 
Import > Timeline; navigate to R18 Beginner Guide Lessons / Lesson 02 / 
Timelines / Age of Airplanes FINISHED.drt and click Open.

Congratulations! You have successfully completed the trailer for Living in the Age of 
Airplanes, and along the way you’ve learned how DaVinci Resolve’s edit page can be used 
to build and enhance the edit. 
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Lesson Review
1 Which editing function uses the position of the source and timeline playheads?

a) Overwrite

b) Replace

c) Place on Top

2 Which function allows you to set the peak level of selected audio clips to a 
desired level?

a) Paste Attributes

b) Dynamic Zoom

c) Normalization

3 Which Retime process can result in smoother playback of speed changes below 100%?

a) Nearest

b) Frame Blend

c) Optical Flow

4 True or false? DaVinci Resolve Studio effects cannot be applied in the free version of 
DaVinci Resolve.

5 Which term is used to describe an edit that has In and Out points in the timeline but 
only an Out point in the source viewer?

a) Reversed

b) Backtimed

c) Append at End
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Answers
1 B. The Replace edit uses the position of the source and timeline playheads.

2 C. Normalization automatically adjusts the level of audio clips so the peak level is at the 
value specified in the normalization dialog.

3 C. Optical Flow can result in smoother playback for clips at speeds below 100%.

4 False. Studio-only effects applied in the free version of DaVinci Resolve will display a 
watermark.

5 B. An edit that uses In and Out points in the timeline but only an Out point in the 
source viewer is called a backtimed edit.



An Introduction to 
Color Correction 
Before you get into the technical side of color correction and learn how DaVinci Resolve’s 
powerful color correction tools work, it’s important to take a moment to understand color 
correction and the creative medium it is. 

Color correction is not something you can do by learning the controls of the color 
corrector, and it’s not something you can do well just using the scopes. It’s a highly creative 
skill. Just as a good editor can tell a story and bring a dramatic flow to a program, the 
colorist evokes an emotion in a viewer via visual manipulation of the image. While it can 
take time to learn how to be a top-level colorist, like all creative skills, it never gets boring 
because you’ll always have something new to learn and a new creative style to explore! 

When using DaVinci Resolve, you have the advantage of more than 30 years of color 
correction experience. Blackmagic Design pioneered the development of color correction 
hardware and software specifically designed to artistically enhance visual images acquired 
from film, video, and digital sources. As a result, DaVinci Resolve possesses an incredibly 
deep, sophisticated, and efficient toolset for adjusting the look of the clips in your program 
and managing these adjustments over an entire timeline. 

Furthermore, DaVinci Resolve has continuously evolved thanks to feedback from countless 
professional colorists worldwide working at all levels of the film and broadcast industry. 
So, the DaVinci Resolve color page has been developed to work the way colorists think. 
Still, for all its technological sophistication, it’s important to remember that DaVinci Resolve 
is merely a tool that requires an artist to realize its full potential. But, of course, that’s the 
fun part! 

The following lessons cover the basics you’ll need to learn to begin harnessing the power 
of the color page in your own projects—be they feature films, episodic television, web 
series, short subjects, spots, promos, or corporate videos. No matter what you work on, 
these formats employ the same fundamental grading techniques and the same basic tools; 
so, if you’re new to the world of professional color grading, don’t worry. All rock star 
colorists once had to learn these first steps for themselves, and you’ll use the 
fundamentals you learn here for the rest of your career.
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Gone are the days when high-quality color grading was unaffordable. Blackmagic Design 
has put the powerful color tools of DaVinci Resolve within reach of any editor who has a 
reasonably capable workstation or laptop. The polish you’ll need to achieve world-class 
results is only a click away on the color page. 

However, before you start getting into the specifics of color, it’s important to step back 
and consider, what are these tools really used for? 

Why Color Correct Your Work? 
This is a tempting question, and one that countless producers and directors have asked: 
“The program looks fine the way it was shot; why spend the time to color grade it?” It’s a 
good question in an industry where time is money; if the program you’ve cut in the edit 
page looks fine, why bother grading it? 

The answer is because your program won’t look as good as it will after being graded. 

The process of adjusting the contrast and color of every clip in a program is variously 
called color correction, color grading, or just grading. The difference in terminology is 
largely superficial, but most experienced colorists prefer “grading” because “correction” 
implies that you only adjust things that are wrong, whereas “grading” implies that you’re 
holding each clip in your program up to a higher artistic standard. A colorist doesn’t ask, 
“Does this clip look good?” A colorist asks, “Could this clip look better?” 

Setting the Tone of the Visuals 
Much has been said about the emotional power of color to shape audience mood, and 
everyone would agree that a scene lit by cool blue lighting will have a very different vibe 
than one that’s lit by warm orange lighting. The greenish tinge of fluorescent fixtures, and 
the salmon-hued wash of mercury vapor streetlights each paint the scenes of a show with 
different atmospheric feelings that, when done right, add to the narrative and how your 
audience perceives it. 

Cooler Warmer
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Of course, what these varied illuminants mean depends on the visual palette you develop. 
Warm lighting that denotes romance in one film may instead portray roiling, desert-bound 
discomfort in another. Their impact depends on the associations that your grading makes 
between the visuals and the story. Should this scene seem later in the day? Should the 
colors be more subdued? Should the sky be an inescapable presence? You control these 
audience perceptions when you exercise subtle control over the picture via color grading. 

The important takeaway is that the color page gives you the tools to mold these 
associations to suit your needs – intensifying, attenuating, or completely counteracting 
their effect, as necessary, to strike the right tone for every scene. 

Portraying the World Subjectively 
Narrative cinematography is rarely concerned with capturing objectively lit renditions of 
locations with perfectly accurate, neutral color and tonality. Instead, truckloads of lighting 
instruments and careful art direction manipulate the light and color of the location to make 
it look somber, magical, frightening, or sultry. These efforts extend to the grading suite, 
where your job is not to portray the world as it is, but the world that the cinematographer 
and director want the audience to see. 

What the camera saw (left) and what you want audiences to see (right).

Documentary photography may very often be concerned with presenting a supposedly 
unvarnished (yet gloriously rendered) look at the world. And yet even this “realistic” look 
at the world is a fabrication, since every adjustment you make to improve the visibility of a 
subject, enhance the glory of nature, clean up some archival footage, or push the 
surroundings of the frame to recede artfully into the background, can be as carefully 
thought out and manipulated as any music video grade. 

The point is, whether you’re making a horror movie, an architectural documentary, a sales 
video, or an automotive advertisement, you’re using the tools and techniques of color 
correction to create a subjective representation of the imagery. The more control you can 
exercise over this representation, the larger palette of emotional response you’ll have to 
draw from. 
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Evolving toward High-End Work 
If you want to learn and stay competitive, and especially if you intend to work on client 
projects rather than your own, it’s good to make yourself aware of current styles and 
trends. You’ve no doubt heard that if you want to write, you should read (and write) as 
much as you can, and the same holds true for color grading. Watch movies, television, 
music videos, and web shorts. And if you’re watching television, make yourself watch the 
ads. Once you’ve had a chance to learn the grading controls that DaVinci Resolve offers, 
you’ll start to see how different looks correspond to adjustments you can make in your 
own projects. 

Finally, get out into the world and look at other visuals. Flip through fashion magazines, go 
to art galleries, take a hike in the woods, and observe. Fill your mind with diverse images 
and analyze them to see what inspires you. The more aware you are of other 
visual disciplines, the more ideas you’ll bring to your own work. 

A last issue to consider is the effect that affordable color grading has had on the television 
industry. In most current episodic television productions, the visual style is now as good 
as in a feature film. This dramatic change in quality has made television programming 
better than ever. 

An unintended benefit of this change is that top-level feature film actors now move into 
television work and back to film with amazing freedom because television no longer looks 
like an inferior medium. Also, high-level film crews and facilities can do a wider range of both 
television shows and feature films, while still retaining their premium status. It’s an exciting 
time when you consider the additional increase in the number of distribution platforms for 
high-quality work, such as streaming services. The industry is growing more quickly than 
ever, which means talented editors and colorists are more in demand than ever!

The Goals of Color Grading 
Color correction can be considered the process of choosing which parts of the raw image 
data to display to create a pleasing image for the viewer. 

Developing the Image
The latest generation of digital cinema cameras are almost all capable of either shooting raw 
color space image data or at the very least recording RGB image data with a log-encoded 
exposure. Doing so preserves the maximum amount of image data for manipulation during 
the color correction process. While this is great for flexibility in workflow and for making 
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high-quality adjustments, acquiring media in this way forces you to take the extra step of 
transforming it into a viewable image for editing and finishing (in much the same way that 
film negatives required development and printing to yield a viewable image). 

DaVinci Resolve simplifies this task with built-in camera raw controls, DaVinci Resolve color 
management (RCM), and LUT support, so you can quickly get your media to a solid starting 
point upon which to build the rest of your grade. 

Log encoded source (left) and the same source color managed to a deliverable color profile (right).

Making Every Clip Look Its Best 
While the job of the cinematographer is to light and expose the image with an artistic 
intent, your job as an editor and colorist is to realize this intent by adjusting the color and 
contrast of the image of each clip so the result is as close to the director’s and 
cinematographer’s intentions as possible. In the process, you can overcome 
inconsistencies with exposure and color balance that were otherwise unavoidable. 
Furthermore, you can subtly adjust warmth and contrast to realize looks that were not 
achievable during the shoot, but that the director and cinematographer would have liked.

An overexposed image (left) and the corrected image for the audience (right).

Of course, in some situations, you may find it necessary to fix media that has more 
substantial problems in color and exposure. In these cases, the tools exist to make far 
more involved changes to the image; however, the quality of your results will depend 
heavily on the quality and “latitude” of your source media. For example, Blackmagic URSA 
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Mini cameras record quite a bit of image data within raw or minimally compressed media 
formats, allowing you to make extreme corrections that would be impossible with data 
from consumer cameras. Happily, in either case, the color page provides the tools to 
process images in many ways to adjust the image to achieve a better look.

Quality Control
While you’re doing all this, it’s important to keep in mind that for all the creative 
possibilities that DaVinci Resolve affords, it’s still important that the deliverables you 
provide to your client have appropriate signal levels relative to their distribution 
requirements. Programs destined for cinema, broadcast, or streaming usually have very 
specific outer boundaries of luma, chroma, and gamut that you must not exceed, or you’ll 
risk having a show kicked back to you for quality control violations. 

DaVinci Resolve provides tools specifically designed to help you keep an eye on how the 
image data is affected, and to fine-tune the image. In particular, the scopes display the 
standard Waveform, Parade, Vectorscope, and Histogram graphs that you can use to 
objectively analyze image data. These scopes let you see the boundaries of what’s possible 
and make it easy to spot subtle problems and compare the characteristics of one image 
to another.

Balancing Scenes
It’s rare for uncorrected shots to match one another seamlessly. Even the most carefully 
exposed angles of coverage can have small variances that should be evened out. For 
example, run-and-gun programs using available light often result in edited scenes with 
huge changes in lighting and color as one shot cuts into the next. 

Small or large, variations between shots can call undue attention to the editing and jar the 
audience in ways that distance them from the program. Balancing these differences is 
another fundamental task of the colorist. You know you’re finished when every shot in a 
scene looks like the same time and the same place, and the color and contrast adjustments 
you’ve made flow unnoticeably from one clip to the next.

Adding Style or Custom “Looks” 
Of course, it’s not all about subtlety and correction. It’s often appropriate—when grading 
music videos and commercials, for instance—to bring some radical visual style to a piece. 
Here, too, DaVinci Resolve provides an abundance of features for manipulating unexpected 
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aspects of the image. For example, you can use custom curves to create an illusion of 
chemical cross-processing. 

Grading an image (left) with several primary and secondary grades to create the look (right).

The Tool Hollywood Uses 
If all that isn’t enough incentive to plunge forward into the next few lessons, keep in mind 
that DaVinci Resolve has become the tool of choice for some of the largest post-production 
facilities in the industry, worldwide. And yet, thanks to its accessibility, within the last 
several years, DaVinci Resolve has also become the go-to tool for a wide variety of smaller 
boutique post companies and individual artists. Considering only projects completed 
recently, DaVinci Resolve was used to grade blockbusters like Rocketman and John Wick: 
Chapter 3 - Parabellum, along with indie productions such as The Big Sick and A Ghost Story; 
not to mention television shows including HBO’s Westworld, AMC’s The Walking Dead, and 
Amazon Prime’s The Marvelous Mrs. Maisel.

Whether you’re looking to build a foundation of skills to enter the post-production industry 
as a contributing artist, or you want to develop the ability to finish your personal creative 
work in your own way, the following lessons will usher you into a much larger world of 
image manipulation and artistic expression than has ever been available in the average 
nonlinear editing application.

Lastly, color grading is just fun! The feeling of resting your hands on the trackballs and 
holding the emotion of your images in your hands is exhilarating. It’s like no other feeling 
in the world; you can make adjustments in real time, instantly see the results, and feel the 
emotional impact in your heart. We believe that color correction is one of those tasks that 
is more creative than cerebral. It’s also one of those jobs that surprises you every day and 
has an emotional connection that reminds us why we fell in love with the film and television 
industry in the first place!

Enjoy the journey!
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Like editing, audio mixing, and visual 
effects, color correction is an art form 
that takes time to learn and master. 
Color is an incredibly powerful creative 
tool that can define the style and convey 
the mood of your film. If you give 
yourself the time to practice and learn, 
you’ll be able to master this exciting skill 
and create images that look amazing! 

These next three lessons provide a 
valuable overview of the most 
important color-correction tools to get 
you comfortable with how they work. 
You’ll learn about the primary corrector, 
secondary adjustments, nodes, and 
even applying DaVinci Resolve FX for 
special effects. You’ll use the same tools 
that Hollywood’s top colorists use to 
correct and finish the biggest 
blockbuster films, episodic television 
shows, and commercials. Experience is 
key, and with so many controls at your 
fingertips, these lessons will give you 
the start you need toward learning this 
creative skill.
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Exploring the Color Page Interface
The exercises in this lesson will teach you how to make color adjustments on clips to 
correct commonplace issues like overexposure, low contrast, and incorrect white balance. 

All these corrections, along with the creative process of color grading, take place within the 
color page in DaVinci Resolve. Let’s start by examining the color page layout. 

1 Open DaVinci Resolve to the Project Manager window. 

In Lessons 3–5, you’ll learn a color-grading workflow using a documentary about 
cattle ranchers in the U.S. state of Wyoming. The project you will use was archived 
using DaVinci Resolve. An archive is a self-contained project that includes all its media. 
All you need to do is restore the archive, and the project will be available with all the 
media already linked. 

2 Right-click in the Project Manager window and choose Restore Project Archive. 

TIP A Project Archive is a folder that contains the DaVinci Resolve project file 
and all the media used for the project. When they are restored, the project will 
open in DaVinci Resolve and all the media will be connected automatically.

3 Navigate to R18 Beginner Guide Lessons > Lesson 3. Select the Wyoming Cattle Ranch.
dra folder and click Open. 

4 In the Project Manager, open the Wyoming Cattle Ranch project, and then from the 
edit page Timelines bin, double-click Primary Grading to load the timeline.
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This timeline has only five clips. All the clips are from a single HD camera.

One of the best aspects of DaVinci Resolve is that editing and color grading are 
completely integrated into a single application, so you can easily move between 
the two with a single click. 

5 At the bottom of the DaVinci Resolve window, click the Color button to go to the 
color page. 

NOTE If your UI layout does not look like the image below, go into the 
Workspace menu and choose the Reset UI Layout option.

The Node Editor connects 
color corrections, image 

adjustments, and effects to 
create unique looks.

The timeline is divided into thumbnails 
and a mini-timeline.

The left palettes contain 
primary adjustments for 
color, contrast, and RAW 

image processing.

The center palettes 
provide access to curves, 
Windows, tracking, and 

keying controls.

The lower-right area may 
display the Keyframes 

Editor, scopes, or a 
metadata display.

The gallery includes saved 
adjustments that you 

can copy to other clips in 
the timeline.

The viewer shows the 
frame at the playhead’s 

current position in 
the timeline.
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NOTE When you’re using DaVinci Resolve on a computer display with a 
resolution lower than 1920 x 1080, the left and center panels and buttons 
might be consolidated and might not look exactly like the images in 
this lesson. 

When you switch to the color page, the playhead’s position from the editing timeline 
remains the playhead’s position in the color page timeline. The color page does not 
change or alter any cuts or transitions; it just provides a way of looking at your timeline 
that’s more appropriate for color correction. 

6 Click thumbnail number 02, the second clip in the timeline. 

An orange outline appears around the selected thumbnail, and the playhead jumps 
to the first frame of that clip. 

7 Below the thumbnail, double-click the Apple ProRes 422 HQ name to switch to viewing 
clip names. 

The mini-timeline below the thumbnails displays thin bars to represent each clip. 
A bar’s width is proportional to a clip’s duration. Like the cut page, the mini-timeline 
shows all the clips in a timeline.

8 Press the Spacebar, and the playhead will begin to play through the timeline.

9 If you leave the timeline playing, you’ll notice that the orange highlight around the 
thumbnail will jump from clip to clip, so no matter where you are in the timeline, the 
clip you’re looking at will always be the one selected. 

10 Press the Spacebar again to stop playback.

TIP If a track is disabled in the edit page, it will be dimmed in the color page’s 
mini-timeline. 

Now that you have a basic understanding of the color page layout, you’re ready to make 
some adjustments. 
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Using the Primary Corrector 
The most popular controls for creating different looks and balancing your shots are found 
in the primary corrector. Because DaVinci Resolve includes many controls in the primary 
corrector, you’ll spend much of your time using this palette of tools while you’re on the color 
page. In this first exercise, you’ll make a few adjustments just to get a feel for the controls.

1 In the timeline, make sure thumbnail 01 is the selected clip. 

The primary corrector is divided into four regions: Lift, Gamma, Gain, and Offset. Each 
region is split into the color balance controls for adjusting the tint of the image and the 
master wheels for adjusting the tonality or brightness.

The Offset adjusts the overall picture. In this first clip, the rancher’s face and hat are a 
bit bright, and the darker shadows do not appear very dark. To make an entire image 
brighter or darker, you use the master wheel, located under the color wheel.
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2 Drag the Offset master wheel to the left until the image is not as bright, and the 
darkest shadows appear to be black. The red, green, and blue number fields above the 
master wheel should end up around 20.00. 

This improves the tonal range, but the clip also has a very orange tint to it.

TIP When you encounter the terms tonal values or tonal range, we are talking 
about brightness values as if the image were black and white, with no color.

3 Drag the color indicator at the center of the Offset color wheel toward blue/green until 
the Rancher’s hat and skin appear less red. 

Adjustments made in the color balance controls are subtle. In most cases, you are just 
moving the indicator a few pixels away from the color you want to reduce. 



141Understanding Video Scopes

4 To turn the correction you have applied on and off to see the before and after, click the 
Bypass button in the upper-right corner of the viewer to turn the grade off.

5 Click the Bypass button again to turn it back on. 

TIP Always remember to turn the Bypass back on because it turns off the 
grading for all the clips in the timeline.

While these adjustments have been made by what you can see in the viewer, 
DaVinci Resolve includes tools that can show exactly what is happening in the image 
and therefore give you a better understanding of where corrections may be needed. 
This is where the video scopes come in.

Understanding Video Scopes
The correction you just did was performed by looking at your viewer and deciding which 
changes were needed. However, this can be quite difficult to do by eye—for example, a 
color cast may only be in the brighter areas of the image and not in the entire image. But 
how can you determine this? Video scopes can give you information about the clip you’re 
looking at to help make accurate decisions when grading. 

There are several scopes at your disposal: Waveform, Parade, Vectorscope, Histogram, and 
CIE chart to check a clip’s luminance, exposure, hue, saturation, and color space. 

You will use the Parade scope to help balance a shot.

1 In the timeline, make sure thumbnail 02 is the selected clip.

2 In the lower-right window, click the Scopes button on the far right of the toolbar.
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3 Click the disclosure arrow to open the Video Scope dropdown menu. 

You can switch between the five different scopes using the menu, depending on what 
you want to monitor. 

4 Choose Parade.

5 You may just want to make your scopes a little brighter in the interface so they can be 
seen more clearly.

6 Click the Settings button.

7 From the Settings menu, drag the Parade slider to the right to make the scopes a little 
brighter so you can see them comfortably in the interface.
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8 Click the Settings button again to close the menu.

The Parade scope graphs each color channel individually. The graph is read from 
bottom to top with absolute black at line 0 and absolute white at line 1023. When 
balancing shots, the image in the parade, called the trace, should not ideally go below 
0 or above 1023. Otherwise, the image will clip—cut off parts of the image data—
and lose detail.

TIP You can switch back to the Keyframes Editor and hide the video scopes 
when the scopes aren’t needed to free up your graphics card’s processor and 
improve playback performance. 

Reading the Parade from left to right, each channel corresponds to the image 
displayed in the viewer. For instance, the left part of the red, green, and blue trace 
corresponds to the image’s left part. This layout makes it easy to look at the scope and 
know exactly which area you are evaluating.
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Color Correcting Using Lift, 
Gamma, and Gain
1 Make sure you have clip number 02 selected.

2 The clip looks a little dark. Using the Offset master wheel, drag it to the right to raise 
the clip so it looks a little brighter. The value should be around 35.00

Now looking at this clip, it appears a little flat with little contrast in the shot. The areas of 
the clip that should be near white look gray—for example, our subject’s hat. This is 
reflected in the parade. The top of the trace, rather than being close to the top of the 
parade, sits well below it. This means the highlights in the image are not bright enough. 
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Instead of using the Offset controls, you will use the Lift Gamma and Gain controls 
to make the adjustments. The Gain control allows you to adjust the brighter parts of 
the image.

3 In the Gain region of the primary color wheels, drag the master wheel right so that the 
highlights start to look brighter.

4 Using the Parade scope, adjust the highlights so the top of the trace touches the 896 
line on the blue channel. The value in the Gain control should be around 1.27
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NOTE The Parade scope has one or two small peak areas that go beyond the 
main body of the trace. For now, you don’t have to worry too much about 
these since they can be corrected later. The important thing is to get the shot 
nicely balanced.

The highlights in the image now look better. However, if you take a closer look at the 
hat, it still isn’t quite white; it has a bluish tint to it. This is reflected in the parade as the 
top of the blue channel is higher than either the red or the green channel. This shows 
that there is more blue in the highlights, and therefore your whites look blue.

To create pure white using additive colors, you mix an equal amount of red, green, and 
blue. A white image would have the red, green, and blue traces completely level along 
the top of the Parade scope. Conversely, pure black would have the three color 
channels completely aligned at the bottom of the graph. 

That being the case, you’ll use the Parade scope to make color balancing easier. 

NOTE Sometimes the parade may look uneven due to the nature of a shot. 
For example, a sunset will have a much higher red channel compared to the 
green and blue, simply due to the time of day it was recorded.

5 Using the gain color wheel, click and drag the center point away from blue, toward 
yellow, so the top of the parade traces are approximately level. You can now see that 
the blue tint that was in the hat has been corrected.
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6 If at any point you make a mistake, you can simply reset the controls by clicking the 
Reset button in the upper-right corner of each region.

7 Make the highlights a little brighter again by getting the top of the parade to touch 
the 896 line.

The highlights are now starting to look nice and bright with no color cast on them. 
However, the shadows still look too gray, rather than black.

8 Under the Lift region, drag the master wheel left until the green trace touches the 0 
line. The luminance, red, green, and blue values above the master wheel should end 
up around -0.02

Immediately the shot’s contrast has improved, and the shadows no longer look gray. 
There is a very slight cast in the shadows, and the green trace sits ever so slightly 
lower than the red and blue. Without the scopes, this might have been difficult 
to pick up.
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9 Click and drag the Lift color wheel center point slightly toward the area between green 
and yellow to get the bottom of the scopes to line up.

10 Once the traces are level, adjust the brightness a little further using the master wheel 
so the traces touch the 0 line.

11 Click the Bypass button in the upper-right corner of the viewer or press Shift-D on the 
keyboard to show the clip without the correction. Click the Bypass button again to turn 
it back off to show the adjustments you have made.

Using these controls, you have now accurately adjusted the clip’s contrast by 
controlling where the black and white points sit by using the Lift and Gain controls. 
You have also adjusted the color in the highlights and shadows to remove any tint that 
may have been present in those areas, rather than using the Offset control that would 
adjust the color for all areas of brightness in the clip. 

NOTE DaVinci Resolve’s viewers are previews that are not intended to be color-
critical displays. For projects that are intended for online delivery or social media, 
the viewer output may be suitable. For television broadcast or digital cinema, you 
can use a Blackmagic Design UltraStudio or DeckLink card to connect 
to a broadcast or digital cinema calibrated display. 
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Now let’s look at Gamma. 

The master wheel under the Gamma color balance control adjusts the brightness 
while maintaining the black and white points that you set previously. In general, once 
you set your black and white points, if you feel the image is too dark or too bright, you 
can try to correct it using the Gamma master wheel. 

We will darken this image a bit.

12 Drag the Gamma’s master wheel to the left to darken the wall to the left of the subject. 
The luminance, red, green, and blue values above the master wheel should end up 
around -0.05. When dragging this control to the left, the image becomes darker.

Gamma is sometimes referred to as midtones because it adjusts the middle tonal 
range of an image.

Now you may want to warm the skin tone of the subject. As the face is neither 
particularly bright nor particularly dark, it would be reasonably safe to assume that its 
range is somewhere in the midtones and therefore can be adjusted by using the 
Gamma color wheel.

13 Click and drag the center of the Gamma color wheel toward orange just so the skin tones 
start to look a little warmer and the color values read: red -0.04, green -0.05, and blue -0.07.
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As you can see, the Gamma control is more subjective. As the colorist, you can decide 
if the shot should be brighter or darker, warmer or cooler. 

The Lift, Gamma, and Gain controls are not narrow adjustments that change only the 
dark, midrange, or bright areas. In fact, their ranges overlap by a considerable 
amount. This overlap helps you make more natural, smoother-looking adjustments, 
but it also means that you’ll need to move among the three color balance controls to 
achieve best results because adjusting one control visibly impacts the others. 

14 Go back and select clip number 01 in the timeline.

15 Right-click anywhere in the node window in the top right of the screen and, from the 
contextual menu, choose Reset All Grades And Nodes.

16 On your own and using the techniques you have just learned, try to balance the first 
shot correctly rather than just using the Offset control.

17 Adjust the Gain so the highlights are brighter, remove the orange tint in the highlights, 
lower the shadows so they look darker, and use the Gamma to make the shot a little 
darker so it has more contrast.

TIP Remember not to go too far beyond the top and bottom levels in the 
parade, or you will start to lose detail in those areas.
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Making Automatic Adjustments
Now that you have a good understanding of how the Lift, Gamma, and Gain controls work, 
you can balance, or normalize, your shots before you start down the path of creating looks 
or isolating certain colors or areas. Normalizing shots is often the first part of the grading 
process that can remove inaccuracies that may have occurred while filming. Doing this will 
unify the shots so applying creative grades later will be easier.

However, what happens if you are unsure of what needs correcting, especially if you are 
just starting out with color grading? Or maybe due to time limitations, you just want to 
correct shots quickly. DaVinci Resolve provides a range of quick automatic tools to help 
you correct shots.

1 Select clip 03 in the timeline. You can see that the tonal range is quite narrow, and the 
same blue cast appears in the highlights

2 Click the Auto Balance button (the A within a circle) in the upper-left corner of the left 
palette window, and the clip’s tonal range and color will balance automatically.

NOTE An Auto Balance may not work on every clip in your timeline because it 
depends on how the material was shot. For example, with a clip shot in low 
light, the Auto Balance may try to make the image much brighter, which you 
might not necessarily want. 



152 Lesson 3  Performing Primary Color Corrections 

As you can see, the Auto Balance has given you a good starting point. However, the 
highlights are a bit too high and we’re losing some detail in the shot, especially around 
the subject’s hair braid.

3 Using the master wheel in the Gain region, drag the wheel left to bring the highlights 
down so that the top of the parade can be seen and the hair has it’s detail back. The 
values should be around 0.91 

4 The shot still looks a little bright, but the shadows look OK, so click the Gamma master 
wheel and drag left to drop the brightness in the shot a little more. The values should 
be around -0.05

5 In the Gamma color wheel, click and drag the center point toward orange to give the 
subject a little more warmth. The grade looks the same as the one you did before, but 
it has taken fewer steps to get there, thanks to the Auto Grade function.
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6 Select clip 04 in the timeline.

This clip looks quite dark but also has a heavy color cast on it, which suggests that the 
camera may not have been properly white balanced.

NOTE Cameras use white balance to neutralize color casts that may appear 
when shooting in certain surroundings. If the white balance isn’t set correctly, 
the clips tend to have a noticeable tint on them. 

DaVinci Resolve provides an option that will allow you to automatically white 
balance a shot.

7 Click the White Balance tool in the upper-left corner of the left palette. You will see that 
the mouse pointer changes to an Eyedropper tool.
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TIP If you accidentally click the White Balance tool, simply press the Esc key 
on the keyboard to go back to the default mouse pointer.

8 Bring the pointer over the viewer and place it over an area that should be white—in 
this case, over the top-right section of the hat—and click to select. 

9 The clip will immediately lose its yellow cast as you have identified an area that should 
be white, and the software has automatically corrected for this.

10 Adjust the master wheel in the Gain control to raise the highlights in the shot.

11 The shot still looks a little dark, so using the Gamma control, raise the midtones until 
you are happy with the result. If you need an approximate value, the midtone controls 
should sit around 0.03
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Again, using an automatic tool has given you a good starting point that you can add to, 
to get a nice even color balance. The final auto grading function will allow you to 
automatically set a black point and a white point in a shot. 

12 Select clip 05 in the timeline.

13 In the upper-left corner above the Lift color wheel, click the black point picker.

Using this control, you will locate and select the darkest point in the image. It should 
be in an area that you think represents absolute black in the shot. 

14 Move the mouse pointer over the viewer. 

An RGB tooltip appears next to the point, giving you a brightness value for the pixel 
you’re hovering over. The values range from 0 (black) to 255 (white). When selecting a 
black point, you want the red, green, and blue values to be as near to 0 as possible 
without all displaying 0. If all the values display 0, there’s a chance that there is no 
brightness information present.

Click the darkest area on the left around the scarf where the RGB tooltip reads 
approximately R:015 G:014 B: 015. 
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TIP If you need to zoom in to the viewer, position the mouse pointer over the 
viewer, and scroll the middle mouse wheel. 

Clicking the shadow area identifies it as your darkest black point and adjusts other 
pixels accordingly. It also corrects any tint in the black so that no single color channel 
dominates in the shadow regions. 

Now you’ll do the same for the white point. In the viewer, you’ll locate a bright point in 
the image and select it. The point should not be the absolute brightest point, but rather 
an area you think should be soft white. In other words, you do not want to pick the sun in 
every outdoor shot but rather the white t-shirt someone is wearing or a white car.

This shot includes a small white area just behind the subject, but you can only see a 
small part of it.

15 Press the Spacebar and play the shot until the subject turns her head and then stop 
playback. You now have a bigger area to select.
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16 At the upper left above the Gain color wheel, click the white point picker. 

17 Place the picker over the bright area and select it.

18 Click the Bypass button or press Shift-D to see the original image. Click the button 
again or press Shift-D to turn the grade back on.

Using the auto select black point and white point tools has allowed you to adjust the 
tonal range of the image quickly and easily by allowing you to decide what should be 
black and what should be white in the image.

19 Adjust the Gain master wheel and bring the top of the parade back into the shot just to 
make sure nothing in the image is clipped.

You can see on this clip that some further adjustments may be needed, but rather 
than doing them on one node, you’ll make further changes on additional nodes. 
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Understanding Nodes 
The color page uses nodes for multiple color corrections. Instead of stacking color 
corrections and effects as layers, you can add as many color correctors and filter effects as 
you like using nodes. You can view the nodes as a color correction flowchart for each 
individual clip. The clip, or the input, starts at the left, flows through each node, and ends 
on the right side of the screen with the corrected image output. Unlike the Fusion page 
nodes, each node in the color page is a full DaVinci Resolve color corrector and not an 
individual effect that performs only one type of image processing. Think of nodes as 
building blocks that allow you to construct your finished grade.

The adjustments you made in the preceding exercises were performed using the first 
node, which is provided for you automatically in the Node Editor. As you create more 
sophisticated corrections, you can add more nodes that target different parts of the image 
or add effects. 

1 With clip 05 still selected, you’ll add another node to the node tree. Right-click over 
node 01 in the top-right Node Editor window.
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2 From the contextual menu, choose Add Node > Add Serial. A second node will appear 
in the node window.

3 You can tell which node you’re working on because an orange outline will highlight the 
active node.

Using Nodes to 
Separate Corrections
Sometimes, as you balance shots you may decide adjustments are best performed by 
separating initial tonal corrections from other adjustments such as pushing contrast into a 
shot. This is building on the idea that the first node is the initial balance, and further 
adjustments can be made once a shot is balanced correctly.

For this shot, you may want more contrast so that the shadows and highlights are 
separated further, but without changing the peak black and white points that you just 
selected. For this, you can use the Contrast tool.
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1 On the node you just created, go into the left palette and place the mouse pointer 
over the Contrast parameter and click and drag the number field right to push more 
contrast into the shot. Adjust it so that the value reads 1.4 or close to it.

2 The shot looks a little dark, so place the mouse pointer over the Pivot parameter next 
to the Contrast and click and drag the number field left to a value of about 0.2.

TIP To reset any of the parameters, simply double-click the tool label in the 
interface and the parameter will reset.

The Contrast tool allows you to push the contrast in your shot without going beyond 
the set white and black points that you made with the initial correction. The pivot 
essentially changes the point from where the contrast adjustment is made to allow you 
to make the image brighter or darker.

3 The contrast adjustment looks good, but maybe the highlights are just a touch too 
bright. Using the Gain master wheel, drop the highlights just a touch to around 0.91.

4 Rather than Bypass the grade, you now just want to see the before and after of the 
contrast adjustment. Click the number of the node in the bottom-left corner to turn off 
the node. You will see it turn gray when off.

Now you will see the shot with just the original balance node on.
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5 Click the number again or press Command-D/Ctrl-D on the keyboard to turn the 
selected node back on.

The advantage of having a second node is that the contrast adjustment is separate 
from the initial balance, so if you were not happy with the grade you could simply reset 
node 02 and keep the balance on node 01. If everything was performed on a single 
node, the time spent getting the balance right would be lost as well. 

6 For this shot you want a more subtle look, so you’ll do a slightly different contrast 
look. Right-click the mouse over node 02 and choose Reset Node Grade from the 
contextual menu.

7 Make sure node 02 is selected and this time click and drag the number field right and 
dial in the contrast until it reaches around 1.1.

8 Click and drag the Pivot left until it reaches around 0.3. This gives you a more subtle 
contrast adjustment.

TIP In addition to dragging the number fields, the values themselves can be 
typed in. Simply double-click the parameter value and type in a new one.

Finally, we want to introduce a different color into the shot. Again, we want to do this 
on a separate node, so we don’t need to alter the other changes we’ve already made.
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9 Right-click node 02 and choose Add Node > Add Serial from the contextual menu or 
press Option/Alt-S on the keyboard to add a serial node. A third node will appear.

The shot needs a little more warmth in it. The shot already has some red and magenta 
colors in it, so it might be a good idea to add a little more.

10 Make sure node 03 is selected; it will have the orange border on the node.

11 In the primary color adjustments, position the mouse pointer over the tint parameter 
and click and drag the parameter right to add more magenta to the shot. The value 
should be around 50.

12 Click the number or press Command-D/Ctrl-D on the keyboard to turn the selected 
node off and on to see the adjustment you made and how it combines with the other 
grades you’ve made.

You can now start to understand how useful nodes are, since they allow you to build your 
grades a step at a time without affecting the changes you made previously.



163Labeling Nodes

TIP If you want to know about nodes in more detail, the book The Colorist Guide 
to DaVinci Resolve 18 by Daria Fissoun goes into why you use nodes and the 
different types of nodes available.

Labeling Nodes
The more adjustments you make on a clip, the more nodes you are likely to need. After a 
while, you could have a complex-looking node tree, so it’s a good idea to start labeling 
nodes to give you an indication of what adjustments may have been done on each node.

1 Still on clip 05, right-click node 01 and choose Node Label from the contextual menu.

2 Label the node BALANCE and press Return (Enter) on the keyboard to exit the 
text entry.

3 Repeat the process, labelling node 02 CONTRAST and node 03 TINT.
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Now you have a good idea of which grade is on which node, so you can make an 
adjustment on the correct node at any time—for example, changing the overall color 
to a cooler look can be done on the TINT node.

Using DaVinci Resolve 
Color Management
So far, we’ve had it fairly easy in our color-grading process. We worked with a few controls 
and made the HD clips look better. In your projects, if all you ever deal with is HD clips and 
output them as HD masters, then you can essentially continue with the process we started 
in this lesson.

However, filmmaking is technical and at times complicated. Few aspects of the process 
illustrate this as well as cameras and their various file formats. Each camera manufacturer 
tries to give you the best-looking image possible by customizing the color palette (Gamut) 
and tonal range (Gamma). You’ll often hear these types of clips referred to as log clips due 
to their logarithmic contrast profiles. The result of recording log clips is that they don’t look 
great on your HD monitor. When using different log clips from different cameras in a single 
project, you need to manage various gamuts and gamma ranges more efficiently to 
achieve consistency in your final output. That’s where DaVinci Resolve’s color management 
(RCM) helps.

1 Above the viewer, click the dropdown arrow next to the timeline name to reveal all the 
project’s timelines.

2 Choose the Color Managed timeline.

This project contains the HD clips we had in the previous timeline and adds new 
Wyoming scenery clips. The new scenery clips have an HDR gamut and gamma, having 
been shot with a digital cinema camera. 
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NOTE These clips were originally captured with a Blackmagic Pocket 4K 
digital cinema camera but have been modified for downloading and 
teaching purposes.

3 In the timeline, click the second thumbnail.

Like many clips from digital cinema cameras, these scenic log clips are not intended 
to look perfect on an HDTV. Although they have a wide tonal range and a wide color 
gamut, they look flat and under saturated. Your HD monitor (or computer monitor) is 
expecting HD clips, so it has no idea how these digital cinema camera clips should 
look. Resolve color management (RCM) is the easiest and most accurate way to unify 
different clips from different cameras, so they all match your desired output.

4 Click the Project Settings icon in the bottom-right corner of the screen.



166 Lesson 3  Performing Primary Color Corrections 

5 Select the Color Management category from the window that pops up.

6 In the Color Science dropdown menu, choose DaVinci YRGB Color Managed.

Enabling color management presents a new dropdown menu below the Color Science 
menu. By default, Automatic color management is turned on. This preset menu 
contains two settings, either SDR or HDR, which can be chosen from the Color 
processing mode menu. SDR is the choice for standard dynamic range, HD (high 
definition) source media, and output. The media in our timeline is a mix of log HDR 
(high dynamic range) source media and HD media. 

TIP The automatic color management shows only a few options for 
processing and output. If you cannot find the setting you require, uncheck 
the Automatic color management option to see the full range of processing 
modes and color outputs.



167Using DaVinci Resolve Color Management

7 In the Resolve Color Management Preset dropdown menu, choose HDR.

Although this preset is still targeting HD output, it is the best choice when using a mix 
of log and HD clips because it preserves the super bright highlights contained in HDR 
source media.

The output color space should be set for your final output delivery. Because our 
project will be output to HD, we’ll leave this menu set to SDR Rec709. This is the 
standard setting for HD video.

8 Click Save to close the settings but keep an eye on the viewer.

TIP You can change the output color space at any time when you are 
delivering to different display devices. This is one of the main benefits of 
using a color-managed workflow.
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When using DaVinci Resolve color management, some source clip formats like RAW 
files, as well as some QuickTime and MXF wrapped files include information about the 
color gamut and gamma. If these metadata tags are present in the files, RCM can 
automatically read it and automatically apply the correct settings for the source clips. 
This is the case with the clips we have now. They are all tagged and color managed, 
so now they look brighter and more colorful on our HD monitor or computer screen.

However, you will likely have some content that does not include the metadata tags, 
so let’s walk through how you might manually set the Input Color Space for source 
clips that are not set automatically.

TIP Adding the Input Color Space as a media pool column will display the 
currently assigned color profile for each clip, whether it is assigned by you 
manually or automatically by metadata.

Typically, you want to change the Input Color Space value to match the device that 
recorded the imported clips. By default, a REC.709 Gamma 2.4 setting is applied to 
clips without metadata. This is probably suitable for your HD recorded clips, but you 
will come across other formats.

When you have clips without metadata tags, you can manually set those clips 
individually from the timeline or in groups from a bin. 
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9 Click the first clip in the timeline. Because this is a graphic, DaVinci Resolve is not sure 
how to interpret this file, so we need to tell the software how to read it correctly.

Graphics are usually created using the sRGB color space. You can set the Input Color 
Space for any clip directly from the color page timeline.

10 Right-click the thumbnail in the timeline and choose Input Color Space > sRGB.

Note that you have not color corrected these clips, although they may appear better. If the 
clips were shot overexposed, they will appear overexposed. If they were shot with the 
incorrect white balance, they will display incorrect white balance. All you have done is 
correct the different gamma curves and color gamuts, so they are uniformly set to suit 
your HD display device and file output. From here, you can use the techniques you learned 
earlier to correct contrast, white balance etc. in the color managed workspace.

NOTE You may notice the grades from your Primary color correction timeline now 
look different. These were graded without color management, so when placed in 
color management the grades may differ slightly. Turning off the color 
management will make these grades look correct again. 

Adjusting Individual Color Channels
A lot of the power in DaVinci Resolve comes from the flexibility of its toolset, which 
provides many ways to do the same thing. To learn more about the primary corrector 
toolset, you’ll explore another method for creating a balanced correction on a new shot.
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1 Still in the Color Managed timeline with color management turned on, select clip 02.

The clip requires a tonal and color balance, but instead of using the color wheels and 
master wheels, we’ll use the individual number fields for luminance, red, green, and 
blue below the Lift, Gamma, and Gain to make fine-tuned adjustments.

These controls allow you to make color and luminance adjustments similar to the 
master and color wheels but provide explicit red, green, and blue controls and 
separate luminance adjustments in the Lift, Gamma, and Gain regions. That being the 
case, you may find them more effective tools for balancing specific color channels in 
different regions of a shot. For tonal adjustments, the Y, or luminance bar, allows you 
to adjust luminance without changing saturation. 

The image has low highlights as well as slightly raised shadows that can be confirmed 
in the scopes. Let’s start by setting our black point.

2 In the Lift region, drag the Lift Y number field to the left until the bottom of the green 
and blue traces in the parade touch the 0 line, with the value at around -0.01.

You can see the red channel is a little clipped off the bottom, so let’s rectify that.
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3 Drag the Red number field to the right to level off the bottom of the parade. This 
needs only a slight adjustment until the bottom of the traces are level.

The darker areas of the image now look better, so we can go ahead and adjust the 
brighter parts.

4 In the Gain region, drag the Y parameter right until the top of the traces sit just above 
the 896 line and the value is around 1.35. 

The shot certainly looks brighter now; however, it looks a little too warm, and again 
looking at the parade you can tell this by the fact that the traces are not level 
at the top.
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5 In the Gain blue number field, drag the parameter to the right until the tops of the 
parade traces line up and the shot looks cooler.

We could go a step further by adjusting the midtones. Remember that midtones are 
more subjective and are quite difficult to measure on a scope, so this can be can be 
your judgment call on what you want to do on the shot.

6 If you feel you want the shot to be brighter, giving the shot a more early-morning, 
colder feel, raise the Y parameter in the Gamma region so the shot gets brighter 
without clipping.

7 If you want to give the shot a more afternoon feel with darker, longer shadows, adjust 
the parameter the other way. 

Afternoon lookMorning look

8 Choose Bypass or press Shift-D to see the original image and then press Shift-D again 
to see your grade.
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Using Curves for Primary 
Color Corrections 
In this exercise, you’ll look at the last method of creating a balanced shot. Using the custom 
curves, you’ll have the greatest degree of flexibility for making tonal and color 
adjustments, but this also requires a bit more finessing. 

1 Select clip 04. 

Looking at the image, you might not be able to tell that there isn’t a lot of contrast, but 
looking at the scope, you can see how the trace is all bunched up in the middle of the 
graph. This is a common trace appearance for low-contrast images. 
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You will approach this shot in the same way you did the previous shots: correcting 
black point, white point, and color. 

NOTE On computers with lower screen resolution, you might have to click 
the Curves button to display the curves palette. 

The custom curve graph is a plot graph in which you can perform incredibly flexible 
adjustments on specific tonal ranges of images. The X axis represents the image’s 
tonal values going from the darkest shadows on the left to the brightest highlights on 
the right. Along the Y axis are the output, or offset, values with darker adjustments 
placed lower in the graph and brighter adjustments placed higher. 

TIP In the color page, each clip has its own undo/redo history. Choosing 
Edit > Undo will undo different steps depending on which clip is currently 
selected. 

The trees’ shadows should be fairly dark but arguably not completely black, so we will 
set the black point in the custom curve accordingly. 

2 Position the mouse pointer over the control point located in the lower-left corner of 
the custom curve graph. 

This point is the black point control. Like the Lift master wheel in the primary corrector, 
adjusting this point raises or lowers the black point in a clip. 
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3 Drag the point to the right until the trace in the parade is midway between the 0 and 
128 lines. 

Moving the black point to the right darkens the darkest parts of the image. 

4 Position the mouse pointer over the control point located in the custom curve graph’s 
upper-right corner. 

This point is the white point control. Like the Gain master wheel, adjusting this point 
raises or lowers the white point in a clip.

The highlights in this shot are fairly dull and could use some brightening. 

5 Drag the point to the left until you have brighter snow, and the tops of the trace are 
just reaching the 896 line. 

Dragging the control point to the left brightens the brightest parts of the image. 

You can further increase contrast by darkening the darker midtones and brightening 
the brighter midtones. Stretching the distance between the two ranges will increase 
the contrast. This is one of the main areas where the curves interface gives a lot 
of flexibility.

You can precisely control the contrast by adding two control points to the curve line: 
one point in the lower shadows area and one in the upper highlights. 

6 Click the curve line directly where it meets the Histogram curve, about one-third of the 
way up from the bottom.
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This adds a point to manipulate the shadows. The large hump in the histogram shows 
you where most of the pixels are in the lower shadow range of this image.

7 Add a point about a third of the way down from the top of the curve line where the 
curve line meets the red Histogram

This adds a point to manipulate the highlights like the snow on the ground. 

TIP Right-clicking with the mouse on a curve point will automatically delete 
the point.

8 Drag down the lower control point until the image’s shadows look sufficiently dark but 
not crushed. 

9 Drag up the upper control point until the snow is brighter but you do not lose the 
foreground grass. 

10 Choose View > Bypass All Grades or press Shift-D to see the original image, and then 
press Shift-D again to view your corrected clip. 
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Moving both points into this S-shaped curve is a typical form of adding contrast using a 
curve control. It offers more flexibility than the Contrast control or even adjusting the Lift 
and Gain master wheels. Using the custom curves, you can define how much shadows are 
modified and how much highlights are modified, independently.

Using Curves in Separate Nodes 
As you have already explored, nodes can be used when you decide adjustments are best 
performed separately. To adjust the next clip, you’ll use the curves on two separate nodes 
to correct a tonal problem and then a more complex color cast issue.

1 Click the clip 11 thumbnail to move to that shot in the timeline. 

Like the primary corrector’s number fields, you can adjust luminance separately from 
the RGB channels using the curves. We will start with tonal adjustments, but unlike the 
last exercise, we will keep color saturation separate.
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2 On the right side of the custom curves, click the Y button to isolate the 
luminance channel. 

The tractor’s shadows are fairly bright, so we will set the black point in the custom 
curve accordingly. 

3 In the lower-left corner of the custom curve graph, drag the black to the right until the 
shadows are more black than gray, and the scope has the trace just barely above 0. 

Like the Y number field in the Lift primaries corrector, adjusting this point raises or 
lowers the black point in a clip without modifying the shadow’s saturation. 

4 In the upper-right corner of the custom curve graph, drag the white point to the left 
until the clouds are a bit brighter without losing detail. The trace in the Parade scope 
should end up just below the 1023 line. 
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Like the Y number field in the Gain primaries corrector, adjusting this point raises 
or lowers the white point in a clip without modifying the highlight’s saturation in 
the highlights. 

Lowering the black point and raising the highlights has increased the contrast in this 
shot. We can increase contrast a bit more by separating the lower midtones from the 
higher midtones. 

5 Add a point along the curve line, about a third of the way up from the bottom. Then 
add another about a third of the way from the top.

6 Create an S-curve using the two new control points you added until you have added 
more contrast into this shot but not blown out the clouds or crushed the dark areas 
in the tractor shadows. 

7 Choose View > Bypass All Grades or press Shift-D to see the original image, and then 
press Shift-D again to compare your corrected clip to the original. 

Now you can work on color balance by adjusting the curve for the individual channels. 
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Looking at the Parade scope, you can see that the shadows in the red channel trace 
appear slightly lower than the blue and green channels. This indicates that there is a 
blue/green tint in the shadows.

At the top of the scope, the red and green traces appear higher than the blue trace. 
This indicates there is a red/green tint in the highlights. 

Instead of combining the color adjustments with the tonal adjustments, we can 
separate them into two nodes. 

8 In the Node graph, right-click node 01, and in the menu, choose Add Node > 
Add Serial. 

9 Right-click over node 01, choose Node Label, and then type TONAL. 

10 Right-click over node 02, choose Node Label, and then type COLOR BALANCE.

11 Make sure node 02 is selected

12 In the curve controls area, click the B button to activate the blue curve. 
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13 Drag the blue channel’s black control point to the right just a hair until the tractor’s 
shadows have less of a red tint. The bottom of the blue trace in the Parade scope will 
drop to align with the red trace. 

14 Drag the blue channel’s white control point to the left until the blue trace in the Parade 
scope aligns at the top of the graph with the red trace. 

This image still has a green tint in the shadows that need to be removed. 

15 Click the G button in the custom curves and drag the black point to the right until the 
shadows have no color tint, and the bottom of the green trace in the scope aligns with 
the red and blue traces. 
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Sometimes balancing the white point, black point, and color casts for shadows and 
highlights is not enough. Often, you will come across color casts in midtones as well. 
The curves are distinctly capable at correcting color casts in midtones because you 
can add control points anywhere along the line to pinpoint specific tonal regions that 
need correcting. You can even pinpoint the area you need to adjust by selecting it in 
the viewer. 

16 In the viewer, click the grass area on the left side of the image. 

The grass in this shot has a green cast to it that needs to be corrected. Although you 
are not specifically isolating the grass in the shot by clicking in the viewer, you are 
placing the control point precisely along the curve line where the color for that 
grass is located.

Adding a point here adds a point to all the curve lines, not just the green. However, 
you can drag just the green point to adjust the green channel in the darker midtones 
where most of the grass color is located. 

17 Drag the green control point down very slightly until the image no longer has a 
significant green tint in the grass.

Dragging the point lower in the graph decreases the green in the midtones by adding 
more red/magenta. 
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18 Click 02 in the lower-left corner of the node or press Command-D (macOS) or Ctrl-D 
(Windows), to see the image without the hue curves adjustment. Press Command-D 
(macOS) or Ctrl-D (Windows) again to view the corrected clip. 

Before color balance (left) and after color balance (right).

As you can see, using the primary controls allows you to balance the color in your shots 
and start to give them a feel. You will use these controls a lot when you grade, so it is a 
good practice to get to know them. If you wish, you can open one of the Age of Airplanes 
timelines and apply what you have learned here to balance those shots.

Lesson Review 
1 In the color page, what does the 1023 line on the Parade scope represent? 

2 True or false? The Auto Balance only adjusts the luminance of a shot.

3 How can you turn off an individual node? 

4 True or false? Resolve Color Management is an easy and accurate way of unifying clips 
from different cameras before the grading process starts

5 What does double-clicking a parameter, such as Contrast, do? 



184 Lesson 3  Performing Primary Color Corrections 

Answers 
1 The 1023 line on the Parade scope represents pure white. Anything above the 

1023 line is clipped and loses detail. 

2 False. Auto Balance will adjust both the luminance and the color in the shot.

3 To turn off an individual node, you can either click the node number or press 
Command-D/Ctrl-D on the keyboard. 

4 True. Resolve Color Management will put clips into a deliverable color profile, making it 
much easier to match them.

5 Double-clicking a parameter will reset it.
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Primary color adjustments let you work 
on the entire image, whereas 
secondary adjustments let you isolate 
and work on specific parts of an image. 

For example, you might want to 
change the color of a car from blue to 
red without affecting the rest of the 
shot, add warmth and saturation to an 
actor’s skin, or lower the shine on 
someone’s forehead. DaVinci Resolve 
features many powerful tools to make 
these adjustments. 

In this lesson, you will use Power 
Windows, HSL curves, the Color 
Warper, and the Qualifier to isolate 
elements based on their color and 
shape. You will then use the tracker to 
follow a moving face and eyes, so your 
color correction follows them through 
the shot. 

Lesson 4

Making Secondary 
Color Adjustments

Time
This lesson takes approximately 
60 minutes to complete.
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Masking Areas with Windows
The first part of making a secondary color correction is to isolate the adjustment on a 
node. This allows you to make very specific adjustments without modifying the primary 
grade you have already completed. 

Using multiple nodes, each containing separate adjustments, you can exercise more precise 
control over the order of those adjustments and more easily track and modify them. 

To begin this lesson, we will open a new timeline that has some of the balancing already 
done for us.

1 Open DaVinci Resolve 18, if it’s not already open, and then open the Wyoming Cattle 
Ranch project you’ve been working on. 

2 Go to the color page, and above the viewer, click the dropdown arrow to select the 
Secondaries Timeline. 

3 Select thumbnail 18 in the timeline. 
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This is a panoramic Wyoming late afternoon scene, but it lacks the drama of an ending 
shot. By working on the sky separate from the ground, we can enhance this beautiful 
shot to bring out more colors. 

Since this shot already has a balanced node, we’ll add a second node to focus our 
corrections on the sky.

4 In the Node Editor, right-click over node 01 and choose Add Node > Add Serial to add a 
second node.

5 Right-click over node 02 and choose Node Label and then name this node SKY.

6 In the toolbar center palettes, click the Windows icon.

Power windows, or windows for short, are probably the most heavily used features 
when trying to isolate an area for correction. They allow you to specify which area of 
the image you want to alter using a drawn shape. The shape can be standard ellipses, 
rectangles, polygons, or arbitrary Bézier shapes that you draw with a pen tool. 

7 In the list of windows, click the Rectangle button to activate it. 

A rectangular window shape appears in the viewer. You can resize and reposition it, 
so it is only over the sky in our picture.

8 Drag within the center of the rectangle to move it over the sky. 

9 Using the white control points on either side of the rectangle, drag to the edges of the 
frame until the rectangle covers the entire width of the picture
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TIP Use the middle mouse wheel to zoom out in the viewer so that you can 
expand the rectangle outside the frame boundary. 

10 Using the white control point on the top of the rectangle, drag up until the rectangle is 
outside the frame boundary.

The bottom of the rectangle needs to be positioned with more care, and you can 
fine-tune your adjustments throughout the lesson as you see fit. For now, we’ll 
position the bottom edge so that it aligns with the sun on the mountains.

11 Using the white control point on the bottom of the rectangle, drag down until the 
rectangle is aligned with the sun on the mountains.

The center handle inside the rectangle is used for rotation, but there are also 
transform controls for the window in the center palette. Sometimes, using the controls 
in the center palette is easier than dragging in the viewer.

12 On the right side of the windows palette, drag the Rotate number field slightly to the 
left so that the bottom of the window in the viewer is better aligned with the bottom of 
the mountain range.

TIP If you need to expand the rectangle after rotating it, use the Size number 
field to expand all sides of the rectangle.
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Now that you have your window in place, any color adjustment you make with node 02 
selected will only be made within the area covered by the window.

13 In the primary controls, lower the Gamma master wheel to bring out more detail in 
the clouds.

14 Drag the Gamma’s color balance indicator toward yellow/orange to add more color to 
the sunset. 

The outline of the window can obscure the edges of the correction, so it can be helpful 
to hide them from time to time.

15 In the viewer’s lower-left corner, click the onscreen Overlay button and choose Off 
from the dropdown menu that appears. 

The bottom edge does appear too sharp, although the shadows on the mountain hide 
some of it. You can soften the edges of the rectangle to blend the color correction 
better with the original picture.

16 Click the onscreen Overlay button and choose Power Window from the 
dropdown menu. 
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17 On the right side of the windows palette, drag the Soft 4 number field slightly to the 
right to expand the soft edge along the rectangle’s bottom.

18 In the toolbar center palettes, click the Curves icon as another way to hide the 
window outline.

19 To compare the change you made on node 02, press Command-D (macOS) or Ctrl-D 
(Windows) to disable the node’s adjustments, and then press the keyboard shortcut 
again to enable it. 

Before window correction (top) and after window correction (bottom).

Windows are the perfect solution when you have a clearly defined area you want to work 
within. This simple color adjustment has made a big impact by using a window to limit it to 
the picture’s top half.
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Reversing Selections 
with Outside Nodes 
Often, you will want to switch your attention to the area outside of your window. For 
example, now that the sky looks dramatic in this shot, you might want to adjust the grass 
area. For this purpose, you can use an outside node, which takes the mask created by the 
window and inverts the selection. 

1 With node 02 selected in the Node Editor, right-click it and choose Add Node > Add 
Outside or press Option-O (macOS) or Alt-O (Windows). 

A third node is now present in the Node Editor. As with previous nodes you’ve created, 
it will connect with the preceding node via the green RGB input/output circles. However, 
this time you’ll see a new connection: the key input/output blue triangles. The key is the 
portion of the image that you isolated using the window tool. When you create an 
outside node, it receives the key from the previous node and automatically inverts it. 

2 With node 03 selected, right-click and choose Node Label, and then name the 
node GRASS. 

To more clearly visualize the area you are adjusting, you can briefly enable the viewer’s 
Highlight mode.

3 In the viewer’s upper-left corner, click the Highlight button. 
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The Highlight button shows the area you will be changing and shows gray pixels over 
the area that will be protected from your adjustments.

4 Using the primary controls, lower the gamma on the ground to make the sky appear 
even more vibrant.

5 Drag the color indicator to add a bit of blue to the snow on the ground. 

6 Click the Highlight button again to disable the Highlight mode. 

The ability to reuse key data is a beneficial component of node-based workflows. It 
speeds up the grading process by requiring you to create a single mask and reuse 
it multiple times. 

Using Windows to Adjust Lighting
In addition to being able to isolate certain regions to grade, you can use windows to 
change the light in a shot, and without your audience noticing, pull their attention to 
something that you as the colorist want them to focus on.

1 Select clip 05 in the timeline

You can see that there is quite a lot of detail in the shot. In addition to the interviewee, 
we have all the riding equipment next to him, and the audience’s eyes may be drawn 
toward that as well as our subject. You can also see that the shadows appear on the 
left of our subject, denoting that the light is coming in from the right side of the frame.

So at this stage you’ll create more definitive lighting in the shot so the audience will 
focus more on the subject.
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2 Add a second node by right-clicking on node 01 and choosing Add Serial or press 
Option-S (macOS) or Alt-S (Windows) on the keyboard and label it SHADOW.

3 In the toolbar center palettes, click the Windows icon and select the Curve 
tool from the Window options. The mouse pointer will look like a pen, and 
the tool will allow you to draw the window shape that you want.

You need to zoom out of the viewer slightly to make sure the top and bottom 
edges of the window are not in shot in this case. 
 
 
 
 

4 Place the mouse pointer over the viewer window and, using the mouse 
scroll wheel, scroll out to reveal the edge of the image or click the 
Percentage button in the upper-right corner and choose a value lower than 
the current one.

NOTE The percentage value of an image fitted to the viewer will 
differ from system to system depending on the resolution of the 
screen you’re using.

5 You can also press Command-minus (macOS) or Ctrl-minus (Windows) to zoom out of 
the image. Each time minus (-) is pressed, the image will zoom out further.

6 Click to add the first point in line with the left sleeve edge of the jacket, but make sure 
it’s off the bottom of the frame.
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TIP Don’t worry too much about the points when you are drawing a window; 
the position can be changed later, and points can also be added and deleted 
from a shape.

7 Add a second point above the top edge of the viewer, approximately in line with the 
subject’s nose, and a diagonal line will be drawn across the frame.

8 Add another point at the same level that lines up with the edge of the viewer.

9 Add a fourth point so another diagonal line appears that touches the edge of the 
jacket collar.
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10 Position the mouse pointer over the first point that you created and click the point. 
The shape will be closed.

11 To get the viewer to fill the viewer space again, click the percentage button 
in the upper-left corner of the viewer and choose Fit.

At this stage, if you want to adjust any of the points, they can simply be 
selected and dragged to a new position if needed. Middle mouse clicking 
on a point will delete it. You can click anywhere on the shape path to 
add a point.

You now want to darken the area outside the subject. However, currently if 
any changes are made, they will be made inside the window. You could use 
an outside node as in the previous lesson, but it may be easier just to invert 
the window.
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12 In the Power Windows menu, click the Invert button on the curve window you have 
just used. This will invert the mask, meaning that any changes will now happen outside 
of the window.

13 In the viewer’s lower-left corner, click the onscreen Overlay button and choose Off 
from the dropdown menu that appears. 

14 In the left window, drag the Offset master wheel left until the values read 0.00. You will 
see areas outside the window go much darker.

This doesn’t quite look realistic but softening the edges will allow you to add some 
convincing-looking shadows to the shot.

15 In the Power Window settings, drag the Soft 1 parameter right until it reads 30.00 or 
until you think the shadow looks realistic.

16 To compare the change you made on node 02, press Command-D (macOS) or Ctrl-D 
(Windows) to disable the node’s adjustments, and then press the keyboard shortcut 
again to enable it. 

You now have a shot where the subject appears to have more light on them and less 
on the background. If you toggle the grade on and off, you will notice that your eyes 
are drawn more toward the subject’s face when the window is on.
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Making Secondary Adjustments 
with HSL Curves
Windows come in handy when you have well defined simple areas that you want to adjust. 
However, when the area is less defined, the shape is too complicated, or a particular color 
is what you are trying to select, HSL (Hue, Saturation, Luminance) curves may be a more 
appropriate tool to use. 

1 On the color page, select clip 02. 

This clip has a nice balance to it, but the blue sky seems washed out. What you want to 
do is make the blue sky more vivid, making this a more striking shot. 

2 Select the Color Balance node (node 01) in the Node Editor, right-click it, and choose 
Add Node > Add Serial or press Option-S (macOS) or Alt-S (Windows).

3 Right-click over node 02 and label it SKY SATURATION. 

The easiest technique to use when you have a simple secondary color adjustment is 
to use the HSL curves. HSL curves are located in the custom curves palette. 

4 In the toolbar, click the curves palette.
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5 In the upper-right corner of the curves palette, click the third button from the left 
which is the Hue vs Sat curve 

The buttons in the upper-right corner of the window give you access to different 
curves. Each curve displays the property that will be selected versus how that 
property will be adjusted. In this case, you will use Hue vs Sat, which will select a hue 
from the image and adjust that hue’s saturation, pushing more of the selected color 
into the image. 

So, in this case the color of the sky is correct; you just want more of it.

6 In the viewer, click the sky somewhere in the middle of the image.

Clicking in the viewer adds three points to the line in the graph. The middle point is the 
precise hue shade you selected in the viewer. The outer two points limit the range of 
blue hue that will be adjusted. 

7 Drag the middle point in the graph up to start making the sky a more vivid blue. 
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Since there is a wide range of blue hues, you want to make sure you get all the hues of 
the sky in the curve selection. You can use the outer two control points in the HSL 
graph to expand the hue range, including more shades of blue.

8 Drag the outer two control points to include more of the blue hue on either side of the 
selection. Position the point on the left just before the cyan section and on the right 
just before the magenta section.

9 To see the change in saturation, press Command-D (macOS) or Ctrl-D (Windows) to 
disable the HLS curve adjustment, and then press the keyboard shortcut again to 
enable it. 

Before the saturation shift (left) and after the saturation shift (right).

The sky looks better now but it’s still a little too bright; you just need to make it slightly 
darker for a really dramatic look.

10 Select the Sky saturation node (node 02) in the Node Editor, right-click it, and choose 
Add Node > Add Serial or press Option-S (macOS) or Alt-S (Windows).

11 Label the node SKY BRIGHTNESS.

12 In the curves window, click the fourth button from the left which is the Hue vs Lum curve.

The Hue vs Lum curve will allow you to adjust the brightness of a specific color—in this 
case, the blue of the sky.
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13 In the viewer, click the sky in the upper-left corner where the color appears the 
most saturated.

14 The three points will appear on the curve. Drag the middle point down by 
approximately three grid blocks so the sky appears darker.

TIP If you want to move a point up and down in the curves and make sure its 
position doesn’t move left or right, you can click and drag on the Lum Gain 
parameter, which will only move the point vertically.

What you may start to see in the sky is some noise, almost like the picture is breaking 
up. This is due to the fact that our selection isn’t adjusting enough of the blue hues in 
the sky, leaving some pixels darker than others. You need to get more of the blue hues 
in to get rid of the noise.

15 Drag the left point away from the center point until it almost reaches green and drag 
the right point until it reaches magenta. Your sky will now look smoother without 
any noise.



201Making Quick Adjustments with the Color Warper

16 Disable nodes 02 and 03 to see the sky before the changes.

Before the sky adjustment (left) and after the sky adjustment (right).

Making Quick Adjustments 
with the Color Warper
The computer mathematics behind the HSL curves create a very smooth and natural 
result; however, they only allow the adjustment of one color parameter at a time. In the 
previous lesson, one curve allowed you to adjust the saturation of a color and then a 
separate curve allowed the adjustment of the brightness.

The Color Warper allows the adjustment of two parameters at the same time using a grid 
of adjustable points—for example, you can change not only the saturation of a color but 
the color itself by adjusting the hue at the same time. This makes the process of 
manipulating color a quick and intuitive process when using the Color Warper.

1 Select clip 03 in the timeline. A second node has already been added for you, 
labelled GRASS.
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The grass and elements that should look a little greener in this shot look too brown 
and washed out, so you’ll rectify this by changing the hue from brown to green and 
add more saturation at the same time.

2 Make sure the second node is selected.

3 In the toolbar center palettes, click the Color Warper icon.

The Color Warper will show in the middle window and by default is split into 6 separate 
sections. Each section divider includes several points that can be dragged to change 
the color and saturation in the image.

4 Position the mouse pointer over the viewer, and it will default to the Qualifier tool. 
Select the grass in the bottom-left corner of the frame.

5 Select the grass in the viewer, and you will notice that it selects a control point in the 
Color Warper.
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6 With the Qualifier still over the grass in the viewer, click and drag left until the grass 
looks greener and more saturated and the Warper looks like the image below.

By dragging the selection further away from the center of the warper, more 
saturation will be added to the selected area. By dragging the selection into a 
different hue, the warper changes the color of the selection. Both of these 
adjustments are done simultaneously.

You now want to make a slightly more precise selection for the sky.

7 Add a third node by right-clicking on node 02 and choosing Add Serial or press 
Option-S (macOS) or Alt-S (Windows) on the keyboard.

8 Label the third node SKY.

9 Make sure the Color Warper window is still visible.

10 Select the sky in the upper-left corner of the viewer, and the orange control point 
will appear.
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11 This time, click on the control point in the Warper itself and drag the point toward blue 
until it meets the next grid line. The sky will start to become a deeper, more saturated 
shade of blue.

The issue with this adjustment is that not only has the sky gone blue, but so have the 
clouds and areas on the ground. It doesn’t look natural, and you want a more refined 
look than this.

12 Right-click the selected control point to reset it or click the reset button in the upper-
left corner of the Color Warper window.

You want the warper to be more precise, and the way to do that is to add more control 
points, which refines the area of selection.



205Making Quick Adjustments with the Color Warper

13 In the bottom-left corner of the Color Warper window, click the resolution control. 
Choose the 16 option. The warper now splits into more sections with a greater number 
of control points.

14 Select the sky in the upper-left corner of the viewer again, and the orange anchor 
point will appear on the warper.

15 Drag the control point along the path it sits on toward the blue/green section of 
the warper.

Now the sky has the deep blue look you wanted but the clouds and ground beneath 
are not having any blue hue pushed into them, giving you a more natural-
looking grade.
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Both the HSL curves and Color Warper can create very natural results that are much 
trickier to get using other methods. However, the controls are limited to one adjustment in 
the case of HSL curves and two adjustments in the case of the Color Warper. However, 
what happens when you want something even more precise: a tool that can use three 
adjustments together to identify an area of an image. Let’s look at a more advanced 
method of selection but also one that takes a bit more time to master.

Selecting Areas with the Qualifier 
The Qualifier palette is another method of isolating a color for secondary color corrections. 
Compared to the HSL curves or Color Warper, the Qualifier is a more sophisticated palette 
that includes several ways to select that color using hue, luminance, and saturation. This 
detailed level of control enables you to get a clean isolation, or matte, of objects even when 
other elements in the shot are of a similar color. 

TIP Qualifiers are used only as a method of creating a matte. They are not 
color-grading tools themselves, and you only start to see their effects when you 
begin adjustments in the color-grading palettes. 

1 Select thumbnail 12 in the timeline. 

This shot has a green tractor-loader in it, which is taking a lot of attention away from 
the scenery, so it might be a good idea to make it a little less vivid and even change 
the color of it so it blends into the background a little more. Using the Qualifier tool, 
you can isolate this color and then adjust it as you see fit.
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2 In the Node Editor, right-click over node 02 and choose Add Node > Add Serial. 

3 Right-click over node 03 and label the node LOADER. 

4 In the central palettes, click the Qualifier icon. 

The Qualifier is extremely useful for isolating specific colors since the controls narrow 
down the selection using hue, saturation, and luminance. You begin using the Qualifier 
much like you would a chroma keyer. Using an Eyedropper, you click over an area of 
interest. The area you select is what you want to be adjusted.

There are several different types of qualifiers. In this case, you’ll use the 3D Qualifier 
so you can simply drag on your selection.

5 In the upper-right corner of the Qualifier window, click the fourth button, which is the 
3D Qualifier tool.

6 In the viewer, click and drag from just above the hole on the front arm to just above 
the hinge on the front arm. When you draw, the image transforms to black and white. 
The white area will be your selection, or key, and the black area will be excluded from 
the selection.
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TIP At this stage, you’re not looking for a perfect selection; you just need to 
ensure you have a large portion of the area you’re trying to adjust included in 
your qualifier.

Once you’ve finished dragging the selection, the viewer will return to normal but will 
show a blue line that shows the selection that you drew in the viewer.

Your next step is to refine and clean up your selection. To do so, you first must change 
the viewer’s output to show your selection. 

7 In the upper-left corner of the viewer, click the Highlight Wand icon or press Shift-H. 
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You are now seeing the pixels you selected against gray pixels that are not selected. 
The goal is to make as much of the image gray while the tractor-loader remains its 
natural color.

The selection has isolated the loader from the rest of the shot, however the selection 
itself is quite noisy.

8 Press the Spacebar on the keyboard, and the clip will play back with the Highlight 
selection turned on. You can see the noise in the selection.

You want to smooth this noise out as much as possible so that the selection goes 
unnoticed to an audience. 

NOTE The quality of the selection when using the Qualifier tool can be 
dependent on your footage as well as the tool itself. When using heavily 
compressed files such as the H.264 codec, the Qualifier doesn’t have much 
color information to work with, leading to uneven selections. Using higher-
end files such as Blackmagic RAW will get you more refined selections 
because there is much more color information to work with and 
therefore select.
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9 In the Matte Finesse tools on the right side of the Qualifier window, click and drag right 
on the Clean Black parameter until it reaches approximately 2.0. This cleans up the area 
that was black in your selection, so unwanted elements are excluded from the Qualifier.

10 Click and drag the Clean White parameter right until it reaches approximately 15. This 
will clean up the key area, fill in any potential holes that may be in the key, and smooth 
out the selection.

11 Click and drag right on the Blur Radius to around 20 to soften the overall selection and 
make the edges smoother. 

TIP Don’t go too far with the blur radius, or your qualified area can begin to 
bleed back into the non-selected area.
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The selection is looking smoother, but there is still a little noise in the actual color 
itself, so let’s see if the color can be evened out.

12 In the Qualifier controls, click and drag the Denoise parameter up to approximately 5.0 
so the key itself looks less noisy.

You should now have a reasonable selection of the loader. Even though there’s still 
some noise in your selection, you can start to make changes and see if the noise is 
noticeable in the shot.

13 In the upper-left corner of the viewer, click the Highlight Wand icon or press Shift-H to 
turn the Highlight off.
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14 Drag the Hue parameter in the bottom-right corner of the left window just below the 
Offset control region, and the loader will start to change color. Drag it to 
approximately 15.00 to give it a blue color.

15 The loader is now a little less distracting than the green, but it’s still a little too bright.

16 In the Offset region, drag the master wheel left to around 18.00 to drop the 
brightness of the qualified area.

Now the blue color itself just needs dialing down to make it look a slightly duller blue 
and therefore not detract from the scenery at all.

17 In the left window, click and drag the Saturation parameter left to dial the amount of 
blue hue down so it looks duller. Set the parameter to around 40.

Using the Qualifier, you have used the hue, saturation, and luminance information in 
the image to isolate a very specific area. Using the Qualifier in this way allows you to 
change the color of objects or dial specific hues back into a certain area or simply 
make selections brighter or darker. The Qualifier is very precise in what you select 
in an image.
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Combining Qualifiers 
and Power Windows 
You can refine an area of the image you want to modify even more precisely by using the 
Qualifier and Power Windows together. Often, an image will have several instances of a 
hue that you’re trying to manipulate. Instead of focusing your efforts on cleaning up the 
selection in the Qualifier palette (and likely compromising the quality of the key), 
sometimes the best option is to use a Power Window to limit which part of the frame the 
Qualifier operates on.

1 Select clip 13 in the timeline.

The clip has already been balanced; however, the interviewee has quite a harsh light 
on the right side of her face, so you want to even that out by using a Qualifier and 
Power Window.

The clip already has the nodes added to complete the grade.

2 Select node 02 QUALIFIER in the node window.

3 In the middle window, click the 3D Qualifier button.

4 In the viewer, click and drag a selection from approximately the middle of the bright 
area on the cheek down toward the edge of the face until you have the highlighted 
area of the face selected. Don’t worry too much at this stage if the hat and other areas 
are selected as well.
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The path you drew for the Qualifier can still be seen in the viewer, and this can get 
quite distracting if your path is long or if it goes over elements you are trying to adjust, 
so it’s a good idea to turn it off.

5 In the 3D Qualifier window, click the Show Paths option to hide the onscreen selection.

6 In the upper-left corner of the viewer, click the Highlight Wand icon or press Shift-H.

The Qualifier area may be a little difficult to see in the current view, so you can change 
it to see the qualified area in more detail.

7 In the upper-right corner of the viewer, select the Highlight Black/White button that 
will show the key you have pulled in black and white, much like the 3D 
Qualifier preview.

As you can see, the key has some noise on it, so it needs refining.

8 Click and drag right on the Clean White parameter until the selection around the face 
is less noisy, at approximately 67, or where you feel the selection looks cleaner.

9 Soften the selection by clicking and dragging right on the Blur Radius until it reads 
approximately 70. You should now have a nice, smooth selection.

Although you now have a nice clean selection on the face, there are still elements 
included in the selection, such as the brim of the hat and elements of the hair braid. 
You could try to adjust the Qualifier to remove these selections, but it’s quicker and 
easier to eliminate these areas with a Power Window.

10 In the middle window, click the Power Window button.

11 Click the circular window option, and the window will appear in the viewer.

As you can now see, the window is working with the Qualifier to remove selected areas 
outside the Power Window. The window itself needs some adjusting to make sure only 
the area of the face is qualified.
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12 Click and drag to the left the middle control point on the right side of the window. 
Narrow the window until it appears to touch the subject’s eyebrow.

13  Click and drag the anchor point handle within the window and rotate the window 
right. This can also be done by clicking and dragging the Rotate parameter to the right 
in the Transform tools for the Power Window.

14 Make sure the rotation is around 15°.

15 Click anywhere inside the window in the viewer and drag it left to get rid of the last bit 
of hair that needs removing.
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16 Click and drag the middle control point at the top or bottom of the window to extend it 
to make sure that all the area of the face you have qualified sits within the window.

17 Turn off the Highlight preview by clicking the Highlight Wand icon in the viewer or 
press Shift-H.

Combining the Qualifier with a window has allowed you to quickly make a clean selection 
based on the element’s hue while just as quickly excluding interfering elements from your 
selection. By using both tools, you didn’t have to draw an overly precise Power Window or 
endlessly tweak the Qualifier. Combining the two tools has saved time and resulted in the 
cleanest key. 

Using the Tracker 
Now that you have one frame with an isolated face, you need to ensure it remains that way 
throughout the shot. One way to ensure that the window follows her face as it moves is to 
use DaVinci Resolve’s tracker. The color page features an incredible 3D perspective tracker 
that not only follows objects but can also determine if that object changes rotation or 
perspective. As a result, you can track the most challenging objects, so that a window will 
follow it precisely. 

1 In the toolbar, click the Tracker button. 
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2 Make sure the playhead in the Tracker panel is at the start of the clip. 

The tracker can track various aspects of objects within a clip. You can enable and 
disable the transform types using the checkboxes at the top of the panel as needed. 
With this track, you can keep the parameters as they are.

3 Begin tracking by clicking the track Forward button. The tracker causes the window to 
follow her face as she moves.

4 Once the track is completed, click the Onscreen Overlay button in the viewer’s lower 
left and choose Off from the dropdown menu to hide the window outline in the viewer.

TIP You can press Shift-` (grave accent) to hide the onscreen overlays.

Now you have an accurate selection and track, so all you need is the correction to even 
out the light on the face.

5 Click and drag left on the Offset master wheel until the brightness of your qualified 
area looks close to the rest of the face. The parameter should be around 15.00.

6 Still in the Offset controls, drag the color indicator at the center of the color wheel toward 
the orange hue. This only needs to be a slight adjustment until the color looks even.

7 Disable node 02 by clicking the number on the node or by pressing Command-D 
(macOS) or Ctrl-D (Windows). 

You can see the lightening now appears more even across the face, and because of 
your precise qualification and a tracked power window, you cannot tell that there is an 
adjustment until you turn it off.

The unqualified shot (left) and the shot with the Qualifier (right).
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There is one more adjustment required for this shot. Since the eyes are typically the 
focal point for most shots of people, we can further enhance this shot by simulating an 
eye light, using a window and tracking.

8 Click the Onscreen Overlay button in the viewer’s lower left and choose Window from 
the dropdown menu to show the window outline. 

9 Make sure you are on the first frame of the shot.

10 Select node 03 EYES.

11 In the central palettes, click the Windows icon. 

We’ll use a circle window again to focus on her eyes. 

12 In the windows palette, click the circle window. 

13 In the viewer, drag the circle over her eyes so the center is on the bridge of her nose. 

14 Use the white top, bottom, and side handles to create a smaller, more oval shape 
covering her eyes. Use the anchor point handle to align the window with the angle 
of the eyes.

15 Use the Soft 1 control in the window palette to increase the softness to around 5.

16 Select the tracker palette.

17 Click the track Forward button. 

Now we’ll use this window to enhance her eyes by increasing the Gamma’s master 
wheel slightly. 

18 In the primary controls, drag the Gamma’s master wheel to the right to around 0.05 to 
add a subtle eye light. 
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19 In the adjustments above the primary controls, increase the Mid/Detail slightly to add 
what is often referred to as local contrast or clarity to the eyes. Drag the parameter 
until it reaches around 50.00

20 Click the Onscreen Overlay button in the viewer’s lower left and choose Off from the 
dropdown menu or press Shift-` to hide the window outline in the viewer. 

21 Press Command-D (macOS) or Ctrl-D (Windows) to disable the Eyes node, and then 
press the keyboard command again to enable it and compare the adjustment.

Before eye light (left) and after eye light (right).

The tracker is a commonly used tool, most often when tracking windows for secondary 
color corrections. As simple as it is to use, it is a very advanced palette that can handle 
many tasks. 

Applying Resolve FX 
in the Color Page
Just like the cut, edit, and fusion pages, the color page includes many high-quality Resolve 
FX, such as blurs, glows, film grain, and lens flares. They can be applied to the entire image, 
or on the color page you can combine them with windows to isolate the effect to one area 
of the frame. You’ll start by applying an effect to the whole image.

1 Select clip 11 in the timeline. 

2 In the Node Editor, right-click over node 02 and choose Add Node > Add Serial. 
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3 In the upper-right corner of the interface, click the Effects button to show the Resolve 
FX you can use in the Color Page.

For this shot, you want to bring a little more focus to the tractor and the mountains 
and focus a little less on the foreground and the sky. 

4 Scroll down the effects palette until you reach the Resolve FX Stylize group. Under this 
section, you’ll find the Vignette effect.

TIP Some Resolve FX are available only in DaVinci Resolve Studio. However, 
you can apply them in the free version with a watermark to test their 
functionality.
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5 Drag and drop the Vignette effect onto node 03.

TIP If you can’t see node 03 because of the Effects tab, click and drag with 
the middle mouse button anywhere in the node window to reframe the 
node tree.

You will now see the Vignette effect added to the node and applied to the shot. The 
Open FX panel switches to the Settings tab to allow you to control the effect that is 
on the node.

6 To give you a better idea of the shape of the vignette, drag the Softness left to 0 in the 
Settings tab.

7 Adjust the size of the vignette by clicking and dragging the Size parameter to the right 
so the dark area covers less of the frame. The value should be around 0.75
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8 Adjust the width of the vignette by clicking and dragging right on the Anamorphism 
parameter to around 2.2.

Now that your vignette is sized correctly, the softness can be adjusted so that the 
boarders appear a little less obvious.

9 Click and drag the Softness parameter to the right to increase the softness so the 
vignette becomes much more subtle. The value should be around 0.4 or wherever you 
feel the vignette looks suitable.

TIP You can apply one Resolve FX per node. To remove a Resolve FX from a 
node, right-click the node and choose Remove OFX Plug-In.

You can also add an effect to part of the image by using them in conjunction with 
Power Windows as you did with the Qualifier.

10 Select clip 08 in the timeline.

This clip already has some depth of field to it, since the person in the foreground is 
more in focus than the person further away. You want to give this shot an appearance 
of a greater depth of field.
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11 From the Open FX panel, under the Resolve FX Blur section, drag the Gaussian Blur 
effect onto node 02.

12 In the toolbar center palettes, click the Windows icon and select the circle window.

The window might not appear in the viewer because the Overlay view has defaulted to 
being the FX overlay.

13 Click the Overlay button in the bottom-left corner of the viewer and change to the 
Power Window overlay.

14 In the circular window parameters, invert the selection so the area outside the window 
becomes blurred.
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15 Use the white top, bottom, and side handles to create a large window that covers the 
rancher in the foreground. You may need to zoom out of the viewer to get full 
coverage. Use the anchor point handle to rotate the window slightly so it blurs as 
much of the background as possible.

16 Adjust the softening of the window by clicking and dragging the pink control points in 
the interface or by adjusting the Soft 1 parameter in the window Softness settings.

Understanding how to use tools such as the qualifiers, windows, effects, and the tracker 
palette enables you to perform secondary color grading with substantial control over your 
image’s final look. However, it is only when you combine these tools that their true 
potential is unlocked. 
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Lesson Review 
1 What happens when you click the Highlight button in the upper-left corner of the 

color page viewer? 

2 True or false? The Color Warper can be split into a different number of sections to 
allow for more precise control.

3 In the color page, what does an outside node do? 

4 Which tool allows you to create a custom window shape?

5 On the color page, where is the Gaussian Blur effect located?
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Answers 
1 Clicking the Highlight button in the color page viewer displays pixels that are selected 

by a Qualifier or Power Window. These selected areas are displayed with their normal 
colors and will be affected by any color adjustment. Non-selected areas are displayed 
as gray pixels and will not be affected by color adjustments.

2 True. The Color Warper can be split into 6, 8, 12, 16, or 24 different sections.

3 The outside node inherits the alpha channel from the node before it and inverts 
the selection.

4 The Curve tool in the Window menu allows you to plot points in the viewer to create 
any custom shape.

5 On the color page, all Resolve FX and third-party effects are located in the 
Open FX panel.
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Identifying Ungraded Clips
When grading your timeline, one of the most important things is to ensure that all the clips 
are graded. An ungraded clip can be obvious, especially in a scene that has a specific look 
applied, meaning it will be noticed by the audience. It is quite possible that a timeline can 
run into hundreds of shots, depending on the project, and you might have shots drop into 
the project after you have started grading. Therefore, keeping track of every single shot 
can be difficult.

The color page includes tools that can help you identify shots that are not graded.

To begin this lesson, we will open a new timeline that already includes some grades.

1 Open DaVinci Resolve 18, if it’s not already open, and then open the Wyoming Cattle 
Ranch project you’ve been working on. 

2 Go to the color page, and above the viewer, click the dropdown arrow to select the 
Grade Management Timeline. 

3 You can identify clips that have a grade applied already by the multicolored outline 
around the clip number.

Imagine that you have a very long timeline. It would be immensely time consuming to 
scroll through each thumbnail to make sure the clip has a grade applied; you need a 
more obvious way of identifying ungraded shots. In this case, we will use the Clips 
filter to assist with this.

4 In the top-right corner of the interface, click the dropdown arrow of the Clips button.

A menu will appear, showing you all the clip filtering options.
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TIP The Clips filter can identify shots in several different ways. For example, 
you can use metadata such as Keywords that you used earlier in this guide, 
whether or not a clip has a Resolve FX applied or whether clips have different 
frame rates. There are numerous options.

5 In the menu, choose Ungraded Clips.

You will notice fewer thumbnails in the interface. You are now looking at all the clips 
within the timeline that do not have any grades applied.

TIP If your thumbnails have disappeared, it may be due to clicking the Clips 
button rather than the menu arrow. If this is the case, click the button again, 
and then click the menu arrow.

Even though this identifies the clips, working in this view may be less than ideal if you 
wanted to preview the entire timeline or match ungraded shots to graded shots. In this 
case, you can color the clips to identify ungraded files in the complete timeline. 

6 In the thumbnail view, select clip 02 in the timeline. We can ignore the graphic since it 
needs no correction.
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7 Hold down the Shift key on the keyboard and select clip 12. A red border should 
appear around the selected thumbnails.

8 With the mouse pointer over any one of the selected thumbnails, right-click and 
choose Clip Color > Orange. Each thumbnail will now have an orange dot in the 
top-left corner, but the clips in the timeline have also changed color.

9 Click the dropdown arrow again in the Clips button, and from the menu choose 
All Clips.

You will now have the full timeline back with all the ungraded clips colored orange so 
that it’s now easy to see which clips are graded and which are ungraded.

Copying Grades
If a shot has been used on multiple occasions in the same timeline—for example, an edited 
interview will have numerous sections of one clip of either the interviewer or interviewee—
you don’t want to spend time grading each clip from scratch since the grade would be 
nearly the same. Likewise, if you have multiple shots from a similar environment, the 
grades for the shots will likely be very similar. 

With this being the case, you can easily copy and paste grades between clips.

1 Select clip 06 in the timeline. You will notice that it has multiple nodes of grading.
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2 From the Edit menu, choose Copy or press Command-C (macOS) or Ctrl-C (Windows) 
to copy the grade.

3 Select clip 07 and choose Edit > Paste or press Command-V (macOS) or Ctrl-V 
(Windows) to paste the grade.

All the nodes will be copied onto the new clip. Because the clips were shot at the same 
time using the same camera, the copied grade transfers across and looks very close to 
the previous clip. However, the highlights look a little too bright. When copying and 
pasting grades, often the transfer might not be exact and therefore just a little fine 
tuning may be needed.

4 Select node 01 BALANCE and in the Gain region, click and drag the master wheel left 
to bring the highlights down slightly to see more detail in the snowy areas. The 
parameter should be around 1.18.

5 Press the Up Arrow key on the keyboard, and the playhead will jump to the previous 
shot. Press the Down Arrow key on the keyboard to jump back the clip you’ve just 
adjusted. You can see that the colors are now very close.

TIP With shots from the same scene, you are not looking at matching the 
clips exactly, since the composition of the shots may be very different. You 
want the audience to believe that they are in the same environment and 
therefore when cutting between clips there are no obvious 
differences in color.

There is a quicker way of copying and pasting grades between shots.

6 Select clip 04 in the timeline.

7 Place the mouse over clip 06 and click with the middle mouse button and the complete 
grade will be copied to clip 04.

In this case, you don’t need the SKY node because there is no blue sky in the shot.

8 Select node 03 SKY and press Backspace on the keyboard to delete the node.



232 Lesson 5 Grade Management

When you copy grades between clips, as in this case, you may not want all the nodes to 
come across. You can copy the settings of a single node and paste them onto another.

9 With clip 04 still selected, make sure node 01 BALANCE is selected.

10 Press Command-C (macOS) or Ctrl-C (Windows) to copy the node

11 Select clip 03, and in the node window, click node 01 even if it is selected.

12 Press Command-V (macOS) or Ctrl-V (Windows) to copy the settings of the BALANCE 
node onto node 01.

You now have several clips that have grades applied but are still colored orange, which 
identifies them as being ungraded, so this needs changing.

13 Select clip 03, hold down the Command key (macOS) or Ctrl key (Windows) and select 
clip 04 and clip 07. The red highlight should appear around the clips.

14 Right-click over any of the selected clips and choose Clip Color > Clear Color.
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Working with Stills
Instead of simply copying and pasting grades, you may want to save your grades into the 
gallery as a still so you can recall the grade at any point. Using stills has some advantages 
over copying and pasting grades. Firstly, stills can be imported and exported from a 
project so you can have an independent folder of your grades that you can use at any time 
in any project. A key feature of using stills is the ability to compare clips with saved graded 
stills so you can easily match two shots together.

Applying Stills
1 Select clip 11, which is the tractor shot with a tonal and color balance already applied.

You can save the grade on this shot by saving a still into the gallery.

2 Right-click in the viewer, and from the menu, choose Grab Still.



234 Lesson 5 Grade Management

The reference still image is saved into the gallery. The still contains all the nodes 
needed to rebuild the grade for any shot it is applied to.

It is good practice to label the stills so when you return to them you have an idea as to 
what they are.

3 Right-click the still in the gallery and select Change Label.

4 Rename the still RANCH MORNING.

5 Select clip 12 in the timeline.

Looking at the light in this clip would suggest it was shot at a similar time of day but in 
a different location on the ranch, so the grade contained in the still could be useful for 
this shot.

Before applying the grade, you can preview it on any clip in the timeline using the still 
in the gallery.

6 To preview the still, with clip 12 selected, move the mouse pointer over the still and 
move it back and forth.

The viewer will show you the current selected clip in the timeline using the grade of 
the still you are hovering over. If you decide the grade is suitable, you can apply it.

TIP If you want to turn the preview off, you can go into the options menu in 
the gallery by clicking the three dots in the top-right corner of the window 
and uncheck the Live Preview option.
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7 Right-click the RANCH MORNING still in the gallery and choose Apply Grade.

The grade contained in the still is applied to the clip. If only getting consistency across 
multiple clips was this straightforward! Even though this was shot at the same time of 
day in similar surroundings, the light in the shot is different, so while applying the still 
gives us a good starting point, there is a little adjustment needed. You need to 
compare the two clips to get a more accurate match.

Matching Shots Using Stills
1 Double-click the RANCH MORNING still to create a split screen.

After double-clicking a still, by default a vertical split appears in the viewer, showing 
the timeline clip (clip 12) on the left and the selected gallery still on the right.
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2 Click and drag the vertical line in the viewer right to reveal more of the timeline clip. By 
dragging left and right, you’ll notice that the timeline clip is slightly darker and lacks a 
little contrast when compared to the still.

3 Drag the vertical line slightly left until you have a good position to see the sky on both 
the left and right of the split line

4 Add a Serial node by right-clicking node 02 and choosing Add Node > Add Serial or by 
pressing Option-S (macOS) or Alt-S (Windows). Label the node SHOT MATCH.

5 Choose Workspace > Viewer Mode > Enhance Viewer or press Option-F (macOS) or 
Alt-F (Windows) to expand the viewer.

This gives you a better view when you don’t need to access the Node Editor or Gallery.

6 Using the Gain’s master wheel, drag to the right until the bright areas of the clouds 
appear similar. The parameter should be around 1.04.
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7 Using the Gamma’s master wheel, drag to the right until the sky brightness is very 
close on the split screen. The parameter should be around 0.02

The sky is quite pronounced in both shots, so getting them close to each other will 
give a consistent look over the two shots. Remember that we don’t need to match the 
shots exactly.

8 In the top-right corner of the viewer, click the Vertical Wipe button.

9 In the viewer, drag the wipe down until it sits just above the dark area of ground by 
the fence.

10 Looking at the foreground in our shot, it appears to have slightly less contrast than the 
still. You want to make the shadows darker without affecting the highlights too much.
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11 Adjust the contrast by dragging right on the contrast parameter until it reads 
around 1.10.

12 Click the Vertical Wipe button in the top-right corner of the viewer and drag the split 
until the sky meets again.

The clips look quite close now. You can see from the split screen that the sky in the 
shot is still a slightly more pronounced blue, and the foreground looks a little red.

13 Click and drag the Saturation parameter left to around 39.00 to drop some of the color 
out of the shot.

14 To disable the image wipe, click the Image Wipe button in the top-left corner of 
the viewer.

15 Press the Up Arrow key on the keyboard to jump to the previous shot and then press 
the Down Arrow key to jump back to the shot we have just matched.

If you toggle between the two clips, you can see that they have a similar look: both the 
sky and foreground have an even look to them. 

16 Choose Workspace > Viewer Mode > Enhance Viewer or press Option-F (macOS) or 
Alt-F (Windows) to exit the expanded viewer.

Shot matching is made easier when using the gallery and reference stills to help you 
analyze the makeup of your shot and what corrections need to be made. You should 
also use the scopes to minimize any visual quirks because your visual perception 
naturally tends to force you to match shots. The combination of reference stills and 
scopes will make the shot matching more accurate, providing continuity in 
your project.
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Importing and Exporting Grades
One of the big advantages of using stills is the ability to import and export them out of the 
project. You could have a folder of stills on a hard drive that could be applied to any 
project, and because the still saves each step of the grade it can be applied to any clip and 
adjusted accordingly. 

Post-production houses often use multiple galleries in episodic television work so they can 
get the color continuity correct across different scenes and different episodes. Using the 
stills gives the colorist a good starting point rather than having to start the grade from 
scratch each time. Colorists also may have multiple stills for the same shot so they can 
decide on a creative look.

1 Right-click in the gallery and choose Import.

2 Go into the Lesson 05 folder in the training materials and select the STILLS folder.
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3 Select the .dpx file, called AFTERNOON.

4 Click the Import button, and the stills will be imported into the gallery.

5 Make sure clip 18 in the timeline is selected.

6 Right-click the Afternoon still and choose Apply Grade.

As before, all the steps of the grade, including the Power Windows and outside nodes 
have been applied to the clip. However, you want to create a totally different look for 
this shot, so you can use the nodes already there to create a much colder feel.

7 Select node 02, and in the top-right corner of the Primary Color Wheels window, click 
the Reset All button. This will reset the color on the node but not the Power Window.

You now want this clip to have a murky gray sky and colder looking foreground.

8 Drag the Contrast parameter left until it reads around 0.500 or until you think the sky 
looks suitably flat.

9 Drag the Lift master wheel left to darken the shadows around -0.15 and drag the Gain 
master wheel left until the sky does not look as bright, around 0.55.
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10 Click and drag the Saturation parameter left to around 25.00 to make sure there is 
little color saturation in the sky.

11 Select node 03.

Even though the foreground has a blue tint to it, giving it a cold appearance, it is still 
not the look you are after.

12 In the Gamma color wheel, drag the control point toward yellow. If the image starts to 
look a little green, drag the control point up slightly toward orange until the blue tint 
has been neutralized. Drag the Gamma master wheel left to drop the 
brightness slightly.

13 Click the Bypass button or press Shift-D to turn off the grade. As you can see, the 
grade gives the shot a different feel.

Before After

This cool misty look can now be saved as a still to be used later.

14 Right-click the viewer and choose Grab Still, and the still will appear in the Gallery.
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15 Right-click the still and choose Change Label. Label the still COLD.

16 Right-click again on the still and ensure that the option “Use labels on still export” 
is checked.

TIP In the Project Settings > General Options, you’ll find an option to label 
your stills automatically. There are several parameters that can be used to 
automatically label a still. 

17 Keep the menu open, choose Export, and save the still back to the STILLS folder in the 
Lesson 05 folder.

As you can see from this process, using stills can be time saving. Even though the look 
you imported was very different from the one saved, it was a quicker process to adjust 
the clip to the creative look by using the nodes that were contained within the 
original still.

Using Stills Across Multiple Projects
If you have multiple projects in the Project Library, and want to share the grades across 
them, you don’t need to export and import the stills each time. The stills can be relocated, 
so unlike the Stills gallery, which is project-based, you can place the files in the PowerGrade 
folder so they can be read by every project in the library.
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1 Click on the Still Albums button in the top-left corner of the gallery window.

2 In the Gallery, locate the PowerGrade 1 folder in the Still Albums.

3 Drag the COLD still into the PowerGrade 1 folder, and it will disappear from the 
Stills 1 folder.

4 Select the PowerGrade 1 folder, and the still will appear.

At this point, you can open any other project in your project library, and the 
PowerGrade 1 folder will be available and will contain the COLD still.

Working with LUTs
A Lookup table, or LUT, is essentially a conversion chart that converts color values. It takes 
the input color (the red, green, and blue values) and converts those values using the chart, 
and it produces the conversion onscreen. There are two different types of LUT: a 1D LUT 
and a 3D LUT. A 1D LUT works very simply by changing the red, green, and blue channel 
input values to another value for output. A 3D LUT is more complex, since it gives each 
color channel an RGB value. The math is more complex; however, the 3D LUT can hold 
more information.

At first glance, a LUT appears very similar to a still, since it can be applied to a clip and 
change the look of the color and contrast in the shot. Unlike a still, though, a LUT does not 
show the stages of a grade; it is essentially a locked box that cannot be broken down but 
merely applied. 
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NOTE Because a LUT is a table of information, it cannot contain any complex 
information that goes beyond RGB values. That means secondary grading tools 
such as Power Windows are not included in a LUT because it cannot understand 
the window information it is being sent.

However, LUTs have many uses, and unlike stills they can work outside of the 
DaVinci Resolve software. For example, if a camera is shooting in a Log profile, it may be 
difficult to judge what the shot looks like in a deliverable color space. So, a LUT can be 
added to an output monitor to give the production crew an idea of what the shot will look 
like on a cinema or television screen, while the camera still records the Log profile with all 
its contrast and color information still intact.

You can even create a custom LUT, save it, and upload it onto a Blackmagic Design camera, 
where you can shoot the scene while seeing an approximation of how the final footage 
will look. 

Applying a LUT
Lookup tables allow you to quickly recalibrate how your color pixel data is displayed, 
essentially providing another form of color management and/or color correction. 
Conveniently, DaVinci Resolve comes equipped with many different LUTs for converting 
one color space to another, and you can easily apply these LUTs from the color page. 

1 Select clip 10 in the timeline. 

2 In the top-left corner of the interface, click the LUTs button to reveal the LUTs browser.

The clip you’re looking at is not using the color management, and therefore you’re 
looking at an HDR image on an SDR display, so you’ll use a LUT to convert the color 
space to make it correct for the display.

The LUTs browser is divided into different cameras and color space categories. When 
you’re working with a specific camera and need to convert it to look appropriate for 
your display, you can apply one of the LUTs from your camera’s category. We are using 
HDR clips, so we will choose from the HDR LUT category.
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3 In the LUT browser, select the HDR ST2084 category. 

This category is used for high dynamic range (HDR) content and will allow us to remap 
these clips for our display. You can preview any LUT by moving your mouse pointer 
back and forth over any LUT thumbnail in the browser. 

4 Click and drag the slider in the top-right corner of the LUT browser to make the 
thumbnails slightly bigger.

5 In the browser, locate the HDR 1000 nits to Gamma 2.4 LUT and move your mouse 
pointer back and forth over the thumbnail to preview the LUT in the viewer. 
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6 Right-click the LUT thumbnail and choose Apply LUT to Current Node.

The LUT is applied to node 01, but just like using color management, LUTs do not know 
where to set your shadows and highlights. The LUT doesn’t know if your white balance 
is correct. You still need to balance the shot after applying a LUT.

7 Click and drag the Lift master wheel left until the parade touches the 0 line. Click and 
drag the Gain master wheel left until the top of the parade drops into the shot.

8 Label the node BALANCE.

A node with a LUT on it is just like any other node. You can make changes to that node 
or add nodes after it to make changes. 

Loading LUTs 
DaVinci Resolve comes with a variety of LUTs that you can start using right away. However, 
one of the strengths of DaVinci Resolve and its LUT workflow is the ability to create custom 
LUTs and share them with other colorists or production crew members. 

You can either choose to install a LUT into the default LUT folder or simply choose a LUT 
folder to load in the System Preferences.

1 In the top left of the interface, go to the menu DaVinci Resolve > Preferences.

2 Within the System Preferences, choose the General option.
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3 In the LUT Locations section, click the Add button in the bottom-left corner.

4 Go into the Lesson 05 folder in the training materials and select the LUTS folder.

This folder contains another folder called R18 TRAINING, which contains two LUTS. It is 
set up this way so the R18 TRAINING folder will appear in your LUT browser.

5 With the LUTS folder selected, choose Open, and the LUT folder will be added to the 
LUT Locations.

NOTE The file path may be different from the one shown here, as it depends 
on where you have saved your lesson files.

6 Click Save in the bottom-right corner of the System Preferences window.

7 Go back into the LUT browser if you are not there already.

You will notice that the new LUT folder does not appear in the browser, because it 
must be refreshed to see the new LUTs.
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8 Right-click anywhere in the LUT folder and choose the Refresh option.

The R18 TRAINING folder now appears in the LUT browser.

9 Select the R18 TRAINING folder, and you will now see the two LUTs contained inside.

TIP Be cautious when downloading LUTs from third-party sources. Their 
implementation could result in your content looking very different from the 
originally intended adjustments. Since post-production companies can 
generate LUTs precisely calibrated to their environments, they are popular for 
in-house use. However, using LUTs out of those controlled environments can 
cause results to vary widely.

10 Right-click node 01 and choose Add Node > Add Serial node or press Option-S 
(macOS) or Alt-S (Windows). 

11 Label the node BLEACHED.
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12 Double-click the BLEACH_LOOK LUT to add it to node 02. The shot will have a bleached 
bypass look applied.

Saving LUTs
The shot now has a stylized bleached bypass look to it. Now you want to slightly adjust the 
look of this shot to give it a little more contrast and a slight tint to then save it as a new LUT.

So that we are not working within the confines of the bleached look, we’ll add our 
adjustments before the second node.

TIP Remember that a LUT is math that converts RGB values. Sometimes those 
values can be limited by the conversion, so making adjustments before a LUT will 
allow you to work with colors and contrast that might not be available when 
correcting after the LUT.

1 With clip 10 still selected, right-click node 02 and choose Add Node > Add Serial Before 
or press Shift-S on the keyboard to add a Serial node before the currently selected one.
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At this stage, you don’t want the initial color space transform, because you will use 
these LUTs on a color-managed shot.

2 Click node 01 and delete it. 

The clip now looks incorrect, but we will fix that by getting the clip to look at the color 
management.

3 Right-click the clip 10 thumbnail and choose Bypass Color Management. Because this 
option is currently checked, it will become unchecked and will use color management 
so that the shot looks correct in the viewer.

4 On the new node 01, click and drag the Contrast parameter right to around 1.2 to 
increase the contrast in the shot.

5 In the Gain master wheel, click and drag right to around 1.15 to make the sky brighter.

6 In the Gamma color wheel, drag the control point toward blue to give the shot a subtle 
blue tint.

7 Dial down the saturation to around 25.00.

You have now created a new look that needs to be saved as a LUT.
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8 Right-click the clip 10 thumbnail and choose Generate LUT > 33 Point Cube.

LUTs can be saved using 17, 33, and 65 points. The more points, the more accurate 
the LUT. 33-point LUTs have been the standard for a while and are widely supported in 
cameras, displays, and applications. 65-point LUTs contain more precision but are also 
less compatible with other devices.

9 Save the LUT as COOL BLUE and save it in the R18 TRAINING FOLDER. The LUT will 
automatically appear in the LUT browser.

TIP By default, the LUT will take the name of the clip it was generated from. If 
you want to change this, you can simply rename the LUT in the Finder/
Explorer window on your system. Refreshing the LUT in DaVinci Resolve will 
update the name.

Using LUTs in this way can be very useful for sharing grades. The LUT has no 
adjustable parameters and is just applied; therefore, no mistakes can be made. If a still 
is sent, there is more room for error because a node can be missed or accidentally 
deleted, changing the look. Also, if you don’t want to show how your grade was built, 
saving it as a LUT removes all the node information.

Making Creative Decisions
You now know how to create stills and LUTs to save different grades. One of the most 
exciting elements of color grading is making the creative decisions as to what the look and 
feel of your project or certain scenes will be. If you have created several different looks 
either by saving them as stills or LUTs, you may want to compare these looks side by side 
to see what look a shot or scene may lend itself to.
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1 With clip 10 still selected, right-click in the Node window and choose Reset All Grades 
and Nodes.

2 In the top-left corner of the viewer, click the Split Screen button. A white outline will 
appear around the viewer.

3 In the top-right corner of the viewer, click the dropdown menu labelled Current Group 
and choose Selected LUTs.

The viewer at this stage will not change, as the LUTs need to be selected. 
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4 In the R18 TRAINING folder in the LUT browser, hold down the Command key (macOS) 
or Ctrl key (Windows) and select the BLEACH LOOK, COOL_BLUE and SEPIA_
CONTRAST LUTs. 

The viewer will split into four panes, showing the original clip and three other versions 
of the clip with the selected LUT applied. From here, you can decide which LUT suits 
the clip the best and add it by double-clicking it in the LUT gallery.

With an understanding of the color page, you can now quickly assemble a variety of looks 
using your color-grading skills. You could also employ the use of LUTs or export your own to 
share with fellow collaborators. By saving stills of your grades as you progress, you will be 
able to quickly balance similar shots and create looks that you can reuse in different projects. 

Lesson Review 
1 True or false? The only way to copy a clip is by using the copy and paste functions 

within the edit menu? 

2 How would you match a shot in the timeline with a still stored in the gallery?

3 Where would you store a still to allow it to show up in multiple projects? 

4 What are the two different types of LUTs?

5 True or false? A LUT can hold complex information, such as Power Windows?
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Answers 
1 False. Grades can also be copied by clicking the middle mouse button over a graded 

clip to copy it to a selected one.

2 Using the Image Wipe will split the viewer with one half showing the timeline clip and 
the other showing the still, so the shots can be easily matched together.

3 You would store a still in a PowerGrade folder that will allow you to access the grade 
across multiple projects.

4 LUTs are either 1D or 3D.

5 False. Because a LUT is a mathematical conversion, it cannot understand more 
complex elements such as masking.
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In this lesson, you will delve deeper into the DaVinci Resolve Project Settings to learn how 
to ensure that your project is set up correctly. Then, you’ll learn how to leverage the power 
of metadata to sort through footage quickly and efficiently. Finally, you’ll be taken on a 
guided tour of the various preferences and keyboard shortcuts you can customize to 
your specific needs.

Project Settings
In this lesson, you will learn how to set up your own project and explore the 
DaVinci Resolve Preferences using the Living in the Age of Airplanes media.

The starting point for all new projects is to first create the project in the current project 
library. Once you have checked the project settings, you can start importing clips and 
organize them prior to editing.

1 Open DaVinci Resolve.

TIP If DaVinci Resolve is already open, you can choose File > Project Manager 
or press Shift-1 to open the Project Manager.

Project Libraries
A project library (called project databases in previous versions of Resolve) is a 
collection of individual projects. Project libraries can reside on your local system, 
on a network location that your computer can access, or remotely on the 
Blackmagic Cloud, and you can switch between these locations using the Local, 
Network, and Cloud options at the top of the Project Manager. DaVinci Resolve 18 
can connect to multiple project libraries in each of these locations but can only 
work with the projects within one project library at a time.

You will learn more about creating, managing, and backing up project libraries 
in Lesson 9.
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2 Ensure that the Project Library is set to Local and, at the bottom of the Project 
Manager, click the New Project button. 

3 In the Create New Project dialog that appears, enter the project name 
My New Project and click Create. 

The new project is created and DaVinci Resolve opens on the cut page.

4 Choose Workspace > Reset UI Layout to return all the pages in Resolve to the 
default layouts.

TIP If you want to save a customized layout, you can choose Workspace > 
Layout Presets > Save Layout as Preset.

Whenever you create a new project, DaVinci Resolve uses default values for project 
settings such as the timeline frame rate and resolution. You can change these in the 
Project Settings window.
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5 Choose File > Project Settings to open the Project Settings window. 

The settings window for this project opens, displaying the Master Settings category. 
Here, you can see that the default setting for the timeline format for this project is a 
resolution of 1920 x 1080 HD and a frame rate of 24 frames per second (fps).

These settings will be used for timelines created using the Project Settings option. If 
you uncheck the Use Project Settings option when initially creating the timeline, you 
can override the project settings and use custom resolutions, frame rates, and other 
options for that specific timeline. You can also change these settings later if you need 
to, either at a global level for timelines that are using the project settings, or at an 
individual timeline level. 

NOTE You will not be able to change the timeline frame rate in the project 
settings if you already have any timelines in that project, although you will still 
be able to change the frame rate of an individual timeline unless it contains 
any clips. So, it’s worth getting this right from the start!

The Living in the Age of Airplanes footage has all been provided at the same resolution 
and frame rate: 1280 x 720 HD and 23.976 fps. It makes sense in this instance to have 
the project settings set the same.
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6 In the Timeline resolution dropdown menu, choose 1280 x 720 HD 720P.

TIP If none of the preset resolutions match your requirements, you can 
always choose the Custom Timeline resolution and type in the horizontal and 
vertical pixel resolutions manually.

7 In the Timeline frame rate menu, choose 23.976 frames per second. 

NOTE When you change the Timeline frame rate, you will notice that the 
Playback frame rate and the Video Monitoring Format changes to match. This 
is normally how you would want these settings to be; however, in very rare 
instances you can adjust these separately.
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Note that you don’t need to set your project settings based on the resolution and the 
frame rate of the footage you’re working with. Instead, the timeline settings should be 
based on the resolution and frame rate that you need to deliver. So, if you need to 
deliver a format other than 1920 x 1080 and 24 fps, the timeline format in the project 
settings should be the first place you visit when starting a new project.

Working with Mixed Resolutions and Frame Rates
In an ideal world, all the footage you import into your project will have the same 
resolution and frame rates, although this will rarely be the case. However, 
DaVinci Resolve handles this mismatch well, automatically scaling clips with various 
frame sizes to the timeline resolution. Mismatched frame rates can be a bit more 
problematic, as they are for any nonlinear editor (NLE), but Resolve handles this with 
aplomb too. If need be, you can use the Speed Change settings in the Inspector to 
change the frame rate at which a clip is playing back in the timeline. The bottom line 
is, make sure your timeline format in the project settings is set appropriate to your 
output requirements and let Resolve handle much of the rest.

There are a few more settings to explore.

8 Scroll down to the Optimized Media and Render Cache settings in the Master Settings.
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Here, you can set the options for the Render Cache, including the video format the 
cache is created in, the time before Resolve begins caching timeline clips (if 
appropriate), as well as whether transitions, composites, and Fusion effects (including 
titles) are automatically cached in User mode.

The Working Folders section just below allows you to set custom locations for the 
project’s various cache files and gallery stills (which will override the default location 
set in the Media Storage panel of the System Preferences—see below).

The Frame Interpolation settings at the bottom of the Master Settings are where you 
will find the project default for retimed clips, allowing you to set the retiming process 
you want applied as a default: nearest, frame blend, or Optical Flow.

NOTE Another setting worth considering is whether to enable DaVinci YRGB 
Color Management. While it is not necessary for this project, since all the 
footage is REC 709, enabling Resolve Color Management during the edit can 
be useful to see a “normalized” image rather than the flat LOG file.

9 Click Save to save any changes you have made to the project settings and close the 
Project Settings window.

TIP You can save any changes you make to the project settings as the default 
for all new projects by clicking the options menu in the top-right corner of the 
Project Settings window (displayed as three dots) and choosing Set Current 
Settings as Default Preset.

With the project settings properly set, it’s now time to import, review, and organize the 
source footage.

Importing Clips on the Media Page
Although you can import footage into the project’s media pool very easily using a simple 
drag-and-drop process, arguably the most efficient place to do this is through the media 
storage browser on the media page. The media storage browser allows you to navigate to 
any part of your system directly from within DaVinci Resolve. It also makes it easy to add 
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the clips to the media pool quickly by using drag and drop or several more flexible 
importing options. 

Media Storage Viewer

Metadata PanelMedia Pool

The media storage browser shows all the connected drives and the files stored on those 
drives. The media pool contains all the media for your current project, organized in bins. 
You can import files from the drives in the library browser into the media pool for each 
project. The Metadata panel allows you to view, add, or edit clip metadata.

The media page gives you the most flexibility and functionality when it comes to importing 
media from your hard drives. It’s also a great place to perform other tasks such as media 
management, clip organization, syncing audio and video clips, and troubleshooting clips 
that unexpectedly appear offline since it has a streamlined interface that isn’t encumbered 
by timelines, audio mixers, or color controls.

1 Click the Media button to switch to the media page. 

2 In the media storage locations sidebar, click the icon for the hard drive that contains 
the R18 Beginner Guide Lessons folder. 

3 In the media storage panel, navigate to the R18 Beginner Guide Lessons folder. 
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4 Double-click the Media folder and then double-click the VIDEO CLIPS folder to open it.

The right panel of the library displays the thumbnails for each of the clips located in 
this folder, allowing you to live preview the footage in the viewer.

5 In the top-left corner of the media storage, click the Back arrow to navigate back to the 
previous folder.

6 Double-click the AUDIO CLIPS folder to open it.

Inside this folder are three more folders.

7 Double-click the Sound Effects folder to open it.
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As you no doubt expected, this folder contains several audio clips.

8 Click the Back button twice to navigate back to the MEDIA folder.

When you have multiple files organized on your hard drive like this, you may want to 
preserve that folder structure as a series of bins in the media pool.

9 Choose Edit > Select All or press Command-A (macOS) or Ctrl-A (Windows) to select 
both the AUDIO CLIPS and VIDEO CLIPS folders.

10 Right-click either of the selected folders to reveal the shortcut menu with various 
import options.

The top three options are commonly used for importing clips:

 — Add Folder into Media Pool will add the clips in the selected folder(s), but only at 
the first directory level. Clips in subsequent folders will not be imported.

 — Add Folder and SubFolders into Media Pool will add the media files contained in 
the folders, at any subfolder level. This option is useful if you’re importing camera 
media that might be stored in a complex folder hierarchy. This is also the default 
function if dragging a folder from the media storage browser directly to the 
media pool.

 — Add Folder and SubFolders into Media Pool (Create Bins) will import the clips 
and maintain the folder structure as a series of bins.
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11 Click the option Add Folder and SubFolders into the Media Pool (Create Bins).

Choosing this menu item creates a series of bins with the same names as the folders.

Whenever you import media, whether it’s here in the media page or in any other page, 
DaVinci Resolve creates a link to the original clips on your hard drive. At no point does this 
process copy, move, convert, or in any way alter the source media. However, as you’ve 
experienced in Lesson 1, this link can be broken if the source media is then subsequently 
moved on the system. In that case, you should use the Relink Media option to re-establish 
the link as you did in Lesson 1. This is why it is important to make sure you place the 
footage on your largest and fastest hard drive prior to importing.

Making New Bins 
Although it’s easy creating bins from folders containing clips on your hard drive, organizing 
everything this way prior to importing is not really practical or desirable. The Finder (macOS) 
or File Explorer (Windows) isn’t really the best tool for reviewing and organizing media files 
such as video and audio clips, so you will often want to refine the organization of the clips in 
the media pool once you’ve had a chance to review the content of the clips. You can do this 
easily and simply by creating new bins and/or moving clips from one bin to another.

1 In the media pool, select the Master bin. 

2 Choose File > New Bin or press Command-Shift-N (macOS) or Ctrl-Shift-N (Windows). 

A new bin with the default name Bin 6 (because this is now the sixth bin to be created 
in this project) is created and added to the media pool.
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3 Highlight the bin name and type CREDITS to rename the bin. 

4 Select the VIDEO CLIPS bin and drag the CREDITS.mov thumbnail onto the CREDITS 
bin in the bin list sidebar. When the Ending Credits bin name highlights, release the 
mouse button. 

5 Select the CREDITS bin to verify that this is the new home for the CREDITS.mov clip.

TIP You can open multiple bins at the same time by right-clicking a bin name 
in the bin list sidebar and choosing Open As New Window. Alternatively, you 
can split the media pool into two views by clicking the 1x2 or 2x1 layouts. This 
makes it easier to move clips between bins quickly.

You’ve now successfully moved clips from one bin to another. By sorting media into bins by 
type, such as a particular shoot date, or by asset type, such as graphics, you will navigate 
your projects with confidence during editing.

NOTE Moving clips in the media pool between different bins does not affect the 
location of the original source media on your hard drive. As a result, you can 
create as many bins as you need in a project, organizing the clips independently 
from their folders on your media drive.
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Viewing Clip Metadata
In addition to audio and video content, clips also include information called metadata that 
describes the content of the clips. Metadata can identify the format, frame rate, 
and resolution, among other data. Some metadata is added automatically to a clip by the 
camera and audio recorders. You can also add custom metadata, such as keywords, 
that you can use to help organize your projects more efficiently. 

You can view a limited amount of metadata in the File tab in the Inspector.

1 Select the VIDEO CLIPS bin and click the first clip 01 A380 TAKEOFF.mov.

2 Open the Inspector by clicking the Inspector button, and then click the File tab.

The File tab in the Inspector displays some metadata without being overwhelming, 
including the name of the file, the duration, and various other useful information, 
including the codec of the video clip, along with its frame size and frame rate.

Using this information can help you determine the properties of a clip.

3 Look at the information for this clip to verify it has a resolution of 1280 x 720 and a 
frame rate of 23.976 fps.

NOTE The audio information for this clip is blank because the media file for 
this clip does not contain audio.

Below the clip summary are several other metadata fields, many of which are blank.
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4 In the Inspector, click the Good Take checkbox to mark this as a good take.

5 In the media pool, live preview the rest of the video clips and mark your favorite clips 
as Good Takes too.

TIP You can select multiple clips by Command-clicking (macOS) or Ctrl-clicking 
(Windows) them and then clicking the Good Take option in the Inspector.

You now have a series of clips marked as Good Takes. You will use this in a later step to 
easily find these clips.

Adding Custom Metadata 
Standard metadata that is captured or created automatically on set during production is 
certainly helpful when organizing clips, but adding your own metadata is also important. 
The project you’re using for this lesson has only a few clips from one small scene, so it’s not 
too hard to stay organized. However, when you’re working on larger projects with 
hundreds, or even thousands, of clips, learning how best to utilize the metadata available 
to you can save countless hours searching and sorting through clips. 

1 In the VIDEO CLIPS bin, select the two clips INTERVIEW 01.mov and 
INTERVIEW 02.mov. 

2 In the Metadata panel in the bottom-right corner of the interface, click the Sort menu 
and choose Shot and Scene.
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3 In the Keywords field of the Metadata Editor, type Int.

A list of standard keywords and previously entered keywords that start with “int” 
is displayed. It’s helpful to select keywords from the list if they are available, rather 
than running the risk of misspelling. 

4 From the list of options available, choose “Interview” to add that keyword.

5 At the bottom of the Metadata panel, click Save to apply the keyword to both clips. 

NOTE You don’t have to save the changes you make in the Metadata panel if 
you have only one clip selected because the change is applied automatically. 
If you have multiple clips selected, however, you will need to save to confirm 
the changes. If you forget this step, though, Resolve will warn that you haven’t 
applied the changes you’ve made, giving you the option to discard or apply 
the changes.

You have tagged these clips with some important information about their contents. Now 
it’s time to start putting this metadata to work. 

Working with Automatic Smart Bins 
The whole point of being able to view, access, and edit the metadata of your media files is 
that you can use this information to further refine the organization of the clips in the media 
pool, over and above simple bins. Smart bins are one way you can easily leverage the 
power of metadata for your own use.
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Smart bins keep a constant watch on your metadata to group clips based on a series of 
rules. These rules can be applied using a series of automatic smart bins, or you can create 
your own smart bins using rules that you define. For example, you can create a smart bin 
that automatically finds all the audio clips in your project or all the clips captured using a 
specific camera. Best of all, a smart bin’s contents will continually update as new footage is 
added to your project or the metadata for existing clips is updated. That means you don’t 
have to manually organize footage when using metadata and smart bins. Smart bins are 
automatically created for any keyword you tag to a clip. They are displayed at the bottom 
of the bin list. 

1 In the Smart Bins list, below the media pool bin list, click the Keywords group.

Once selected, a disclosure arrow appears next to the group and the interview clips 
appear in the media pool.

TIP If you need more room to view the smart bins, drag the dividing line 
between the Smarts Bins category upward.

2 Click the disclosure arrow to open the Keywords smart bin group.

The list of available keyword smart bins appears. You are currently seeing only a single 
smart bin called Interview because this is the only keyword you have applied.

3 In the regular bin list, select the VIDEO CLIPS bin.

4 Select the first clip 01 A380 TAKEOFF.mov and Shift-click the clip 10 AERIAL SFO.mov.

5 In the Metadata panel, click the Keywords metadata field, type B-Roll, add the 
keyword from the list, and click Save.
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A new smart bin appears in the Keywords group with the appropriate name for 
the keyword you have just applied and containing those clips you added the B-Roll 
keyword to.

You can add multiple keywords to the same clip(s).

6 Click the VIDEO CLIPS bin again, and this time select the clips 
11 BAY AREA TIMELAPSE.mov and 12 NIGHT TIMELAPSE.mov.

These clips are both timelapse shots, but they could also be classed as B-Roll clips.

7 In the Keywords field in the Metadata panel, type B-Roll to add the B-Roll keyword as 
before, and then start typing Timelapse to add this as a second keyword.
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Because “Timelapse” is not a keyword that Resolve recognizes, no options will appear, 
but you can still add this as a custom keyword for this project.

8 Continue typing Timelapse and press Return (Enter) to add the keyword, and then 
click Save.

NOTE When you add a custom keyword to a clip or clips, it is added to the 
dictionary of keywords that Resolve holds for the current project. If you want 
to add the same keyword to another clip later, then Resolve will present any 
custom keywords as options. You can manage this keyword dictionary either 
at a user or project level, including adding your own keywords and exporting 
and importing custom keyword dictionaries by selecting Workspace > 
Keyword Dictionary.

A new smart bin called “Timelapse” appears at the bottom of the media pool and 
displays all the clips tagged with that keyword.
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9 Select the B-Roll smart bin.

You will also see that the timelapse clips have been automatically added to the B-Roll 
keyword smart bin too, so now if you’re looking for any timelapse shots, you can 
access them in either the VIDEO CLIPS bin or the B-Roll or Timelapse smart bins! All 
three routes lead to the same clips.

If you change your mind about what keywords are applied to a clip, it’s just as simple 
to remove them.

10 From the B-Roll smart bin, select the clips 11 BAY AREA TIMELAPSE.mov and 
12 NIGHT TIMELAPSE.mov.

11 In the Keywords field in the Metadata panel, select the B-Roll keyword so it turns red.
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12 Press Delete (Backspace) to remove the selected keyword and click Save.

The clips are instantly removed from the B-Roll smart bin because they no longer 
contain that specific keyword.

TIP Keyword smart bins are just one type of automatic smart bin that you 
can use in DaVinci Resolve; it’s just that the Keywords bins are displayed by 
default. Other automatic smart bins can be displayed for Shot and Scene 
information, both of which you can add metadata for in either the Metadata 
panel or the File tab of the Inspector, as well as a smart bin just for timelines. 
DaVinci Resolve Studio users can also make use of the People Detection 
function that can analyze clips for people, whom you can then name to create 
their own smart bin! To display these additional automatic smart bins, choose 
DaVinci Resolve > Preferences > User > Editing and check the options under 
Automatic Smart Bins. 

Creating Custom Smart Bins 
Using the automatic smart bins only scratches the surface of what smart bins can do. In 
addition to using the automatic Keywords smart bin, you can also create your own smart 
bins using a simple set of and/or rules. In the next steps, you will create a smart bin to 
automatically collect the clips you previously marked as Good Takes. 

1 Choose File > New Smart Bin.
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TIP You can also right-click the smart bin list and choose Add Smart Bin.

The Create Smart Bin window appears. Using this, you set up the rules that determine 
which clips are automatically added to this custom smart bin. The criteria options are 
many, enabling you to create smart bins that group clips based on a wide range of 
auto-generated and manually entered metadata. 

2 In the Name field, enter Good Takes as the name for this smart bin.

3 Leave the Match menu set to “All of the following rules.”

4 In the rule itself, leave the first metadata criteria set to “Media Pool Properties.”

5 Change the metadata type dropdown menu from “File Name” to “Good Take.”

TIP To navigate quickly through the list of options, begin typing the name of 
the metadata field. You can then select it with your mouse to jump directly to 
it from the list.

6 Leave the third and final metadata criteria dropdown menu set to “is true” and 
click Create. 

You now have a smart bin that includes all the clips that you previously marked as 
Good Takes. 
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7 Select any clip in the Good Takes smart bin and uncheck Good Take in the Inspector to 
instantly remove it from the smart bin. 

NOTE The content of a smart bin is always governed by the rules, so you 
cannot simply drag clips to and from a smart bin. To add or remove clips from 
a smart bin, you must either adjust the rules so the clip(s) meet or fall outside 
the smart bin’s rules, or adjust the clip so it meets or does not meet the rules.

You can organize smart bins into folders to make them easier to find.

8 Right-click the Good Takes smart bin and choose Add Folder.

9 Select Folder 1 and rename it to Custom Smart Bins.

10 Drag the Good Takes bin into the Custom Smart Bins folder.
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TIP To edit the rules for a custom smart bin, right-click the smart bin and 
choose Edit. Automatic smart bins cannot be edited.

Hopefully, you can now appreciate the organizational power of the smart bins in 
DaVinci Resolve.

Project organization is a process that doesn’t simply happen once at the start of the 
project. Rather, although most projects start off with a basic level of organization, it is 
ultimately something that continually evolves for as long as you are working on a 
project as you become increasingly familiar with the media you’re working with. 
Therefore, many of the steps you have just completed (making new bins, viewing and 
adding metadata, and creating smart bins) can also be achieved at one level or 
another in any page that has access to the media pool, Metadata panel and Inspector.

Creating Complex Rules for Smart Bins
The only limit to what smart bins can achieve is your imagination. Smart bins can 
be used to find clips based on any criteria of metadata you can think of, with 
multiple rules able to be combined in different ways. To add another rule, simply 
click the + (plus) symbol to the right of an existing rule.

In the previous steps, you created a smart bin with just one rule: whether you had 
marked a clip as a Good Take. However, you can add another rule to this and 
choose how those rules relate to each other, such as clips marked as Good Take, 
but only if they have a certain keyword applied, such as B-Roll for instance.

The match menu allows you to choose whether All the rules listed are applied, 
where clips in this smart bin will be marked as Good Takes and have the B-Roll 
keyword applied, or Any, where the clips will be marked as Good Takes or have the 
B-Roll keyword applied. How many other applications can you think of for using 
smart bins?
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Preferences
So far in this lesson you have learned how to correctly set up a project, explored different 
ways of importing clips and how to organize media to make it easier to work with. Now it’s 
time to learn a little more about how you can customize DaVinci Resolve through 
its preferences. 

DaVinci Resolve includes two sets of preferences that you can configure: System 
Preferences are a group of settings that control how Resolve uses your computer 
hardware, and User Preferences affect how Resolve works for you, the user.

NOTE Different user accounts on the computer have their own set of 
DaVinci Resolve preferences that are stored separately from each other. This 
means that multiple users who each have their own login on the same computer 
can maintain separate workspace layouts and preference states. When the user 
logs out and another user logs in and opens Resolve, their specific preferences 
are recalled. 

Like the Project Settings window, the preferences contain a large and bewildering number 
of options. However, there are only a few important preferences you should be aware of.

1 Choose DaVinci Resolve > Preferences to open the Preferences window. 
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The two types of preferences—System and User—are listed at the top of the 
Preferences window and, like the Project Settings window, categories are listed along 
the left side. By default, the Preferences window opens to the Media Storage category 
in the System Preferences, unless the project hasn’t been closed since the preferences 
window was last opened.

The Media Storage preference allows you to manage various media storage locations 
that DaVinci Resolve can access. These can be used to access files easily in the Media 
Storage browser in the media page for importing, but the first location in this list is 
also used to store gallery stills you create in the color page (see Lesson 5) and cache 
files generated in the edit page (see Lesson 2). This location is more commonly 
referred to as a scratch disk. By default, this location is always set to the current user’s 
Movies folder because this location should automatically exist on every computer.

NOTE It’s almost always advisable to set the first media storage location to 
the largest, fastest hard drive available to your computer. However, for the 
purposes of following this book, it is not necessary to change the 
current location.

If you wish to change or add a media storage location, click the Add button and select 
the hard drive or folder you wish to add as a media storage location. To remove an 
unwanted media storage location, simply select it in the list and click Remove.

2 Ensure that “Automatically display attached storage locations” is selected.

This option is important since it will allow hard drives and other storage media you 
connect to your computer to be instantly available in the media page so you can 
import any files stored on them directly into Resolve and begin working as quickly 
as possible.

NOTE If you’re working on macOS and have downloaded DaVinci Resolve or 
DaVinci Resolve Studio from the Mac App Store, you will need to select this 
option and give permission for Resolve to access your hard drive. Unless you 
do this, Resolve will be unable to import any footage.
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3 Click the Video and Audio I/O group.

NOTE I/O refers to Input/Output.

If you have a Blackmagic Design capture or playback device attached to your 
computer, such as a DeckLink PCI Express card or UltraStudio device, you will be able 
to specify this as a capture and/or monitor device here. 
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Specifying such a supported device as a monitor device will allow you to play the current 
timeline out to an external video monitor. If you do not have a supported device 
attached to your system, the Capture and Monitor device options will not be selectable.

4 Click the Control Panels group.

As with the Video and Audio I/O settings, this is where you can specify which type of 
control panel you want to use for color grading. 
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In addition to the Blackmagic Design panels, DaVinci Resolve also supports a range of 
panels from other manufacturers.

5 Click the Internet Accounts group.

This is where you can sign in to supported video sharing and social media services. 
You saw these settings previously when you completed Lesson 1. Signing in to any of 
these services will allow DaVinci Resolve to upload an exported file to that service on 
your behalf.

6 At the top of the Preferences window, click the User tab. 

The first group of User Preferences that is selected is the UI Settings. These allow you 
to customize the user interface of DaVinci Resolve. For example, here you can change 
the language that the user interface uses. 
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7 Click the Project Save and Load group.

You might have been wondering why this book makes no mention of saving your work 
as you go along, especially if you’ve ever been in a situation where the software you 
are working in has crashed, causing you to lose work and valuable time.

Well, thankfully, this isn’t something you ever have to worry about when working in 
Resolve because everything you do is automatically saved as soon as you do it! The 
explanation for this is a feature called Live Save, which is found in the Project Save and 
Load group of the User Preferences, and which is enabled by default. 

With Live Save enabled, once you create a new project in the Project Manager, 
DaVinci Resolve begins saving all the changes you make as soon as you make them. If 
there is ever a problem, such as the software crashing or the power to your computer 
being interrupted (assuming it’s not a laptop with a charged battery, of course), simply 
restart Resolve and reopen the project. You will not have lost any work as long as Live 
Save is enabled.

8 Ensure Live Save is enabled (it should be by default).
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NOTE If you want to be able to create incremental backups of a project 
automatically, for example every 10 minutes or so, simply enable the Project 
Backups option. Once enabled, you can specify how often Resolve creates a 
backup of the entire project for the previous hour, and then for how long 
hourly backups are saved, and then daily backups. Finally, a separate field 
allows you to specify the location where these backups are saved on your 
computer. To access available backups for a project that has this feature 
enabled, simply right-click the project in the Project Manager window and 
choose Project Backups. Here you can choose to delete any unwanted 
backups, or “wind back time” and load a previously saved backup of the 
project. When loading a backup project, you will be prompted to name the 
project because Resolve will not overwrite the current version of the project. 
Instead, a new, independent project is added to the Project Manager.

9 Click the Editing group for the User Preferences.

This group of settings allows you to customize many of the editing features you were 
using in the first three lessons.

The New Timeline Settings allows you to specify the starting timecode and number of 
video and audio tracks in a new timeline, and the Automatic Smart Bins category 
allows you to choose which automatic smart bins you want to be active in the 
media pool.
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10 Scroll down to see more Editing preferences.

The General Settings allow you to adjust the standard transition and still-image 
durations, in either seconds or frames, along with other specific options you can 
choose to enable, such as having the timeline viewer overlay retain the last editing 
action, rather than always defaulting to Overwrite.

TIP If you’re working on macOS, you also have the option to enable 
DaVinci Resolve to automatically create keywords from Finder tags when 
importing media.

Once you’ve finished exploring the System and User Preferences, you need to save the 
preferences or else any changes you have made will be lost.

11 Click Save to close the Preferences window. 
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NOTE Changing some options in the preferences will not take effect until you 
restart DaVinci Resolve. A dialog will appear informing you if that is the case. 

Resetting and Saving Preferences
Using the Options (three dots) menu in the top-right corner of the Preferences 
window, you can choose to reset the system or user preferences back to 
their defaults.

For the user preferences, you can also save the current set of preferences as a 
preset, which can then be exported as a self-contained file with the 
.userprefs extension. 

If required, this file can then be imported to another DaVinci Resolve system, 
where you can use the same options menu to load it as a new preset, making it 
easy to transfer user preferences between different systems. 

Exploring Keyboard Shortcuts
You can also customize the different keyboard shortcuts used throughout DaVinci Resolve. 
The default keyboard shortcuts are extensive and cover a wide range of functions. 
However, they might feel unnatural to you, or there might be a function that doesn’t have a 
keyboard shortcut assigned by default that you find yourself using on a regular basis.



287Exploring Keyboard Shortcuts

1 Choose DaVinci Resolve > Keyboard Customization or press Option-Command-K 
(macOS) or Alt-Ctrl-K (Windows).

The Keyboard Customization window opens, where you can choose which set of 
keyboard shortcuts you want to use, discover which keyboard shortcuts are available, 
or create your own custom keyboard shortcuts.

Firstly, DaVinci Resolve provides a set of presets that emulate the various keyboard 
shortcuts used by other non-linear editing (NLE) systems.

2 Click the dropdown menu in the top-right corner of the Keyboard Customization 
window to reveal the options.

If you’re familiar with any one of the listed NLEs, then you can load the appropriate 
preset. However, note that this is not a 100% remapping of the shortcuts. Because 
each system operates in a slightly different way, some functions available in one or 
more of these other systems may not be available in DaVinci Resolve. Therefore, it is 
impossible to map the shortcut to the non-existent function; or DaVinci Resolve may 
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include functions not available in these other systems, and the shortcuts assigned by 
default in the DaVinci Resolve preset may be overridden in the other settings. It is 
always worth exploring and learning the default keyboard shortcuts since they have 
often been thought out carefully for you to get the best out of the software.

Nevertheless, there are times when you will want, and even need, to customize the 
shortcuts.

The upper part of the Keyboard Customization window provides you with an 
interactive keyboard for exploring keyboard shortcuts. 

Keys that do not have an assigned function are displayed in a dark shade; those that 
do have an assigned function are a slightly lighter shade. The keys displaying a 
number at the bottom right represent keys that have functionality in more 
than one page.

You can begin exploring the functions by selecting the keys on the keyboard.

3 Click the D key using the onscreen keyboard.
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TIP You can hold down keys on your physical keyboard for a more interactive 
experience.

As you can see, the Keyboard Customization window responds to the selection you are 
making and, in the Active area in the bottom half of the window, displays the function 
assigned to this keyboard shortcut, next to the panel in which you can use it. In this 
case, the D key will toggle the Enable Clip function in the edit page timeline and in the 
Fairlight timeline.

You can also explore the keyboard shortcuts that utilize the different modifier keys for 
your system.

4 Click the D key again on the onscreen keyboard to deselect it and then click the 
Shift button.

The Shift buttons for your keyboard layout are highlighted and the mapping shifts to 
reflect the shortcuts that are available while holding the Shift key.

5 Click the D button again to reveal the function activated by this Shift-D key combination.
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As you are already aware, Shift-D bypasses the grades on all clips and works across 
the application. 

6 Click the D and Shift buttons again to deselect them.

Searching Keyboard shortcuts
Instead of discovering the command associated with a shortcut, it’s much more common 
to search for a command to discover what keyboard shortcut (if any) is assigned.

1 In the Commands area in the lower-right portion of the Keyboard Customization 
window, ensure that the All Commands group is selected.

TIP Instead of choosing All Commands, you can narrow your search a little 
more to certain menus or panels using the options in the left list of the 
Commands area. Scroll down through this list to see more options.

2 Click the Search field and type fast to do a search for commands that include “fast” in 
their description.

It seems Fast Review does not have a shortcut assigned under the default 
keyboard shortcuts.

3 Click the area in the Keystroke column for the Fast Review command.
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Once selected, you can now choose to assign a shortcut by pressing the appropriate 
keys on your keyboard.

4 Press Shift-Option-F (macOS) or Shift-Alt-F (Windows) to assign that key combination to 
the Fast Review command.

NOTE If you choose a keystroke combination that is already assigned to a 
command, Resolve will warn you and give you the choice of whether you want 
to continue to assign that keystroke. If you choose Assign, the keystroke will 
be removed from the original command and will be applied to the new 
command. Resetting the keystrokes for a command (see the Tip below) will 
also reassign the keystroke back to the original command.

TIP Each command can have multiple keyboard shortcuts assigned. If you 
wish to add more than one keyboard shortcut to the same command, click the 
+ (plus) icon to add another keystroke combination. You can also remove 
shortcuts from a command by clicking the x next to the keystrokes. To reset 
the keystrokes for a command back to their defaults for the current layout, 
click the reset arrow to the right of the keystrokes.

You have chosen a new keystroke combination for the Fast Review command; however, 
you will need to save it before you can use it.

5 Click Save.
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The Keyboard Mapping Preset window opens, asking you to save the changes to a 
new, customized preset.

NOTE DaVinci Resolve will not allow you to alter the default mapping presets, 
so if you wish to return to an unadulterated set of keyboard shortcuts, you 
can simply select the DaVinci Resolve preset.

6 In the Enter Preset Name field, type My Shortcuts and then click OK.

The new mapping preset is added to the dropdown list of presets, containing the 
customized keystrokes for Fast Review. 

NOTE To manage the mapping presets, click the options menu (three dots) in 
the top right of the Keyboard Customization window to reveal commands for 
exporting, importing, and deleting available presets.

7 To return to the default shortcuts, select the DaVinci Resolve preset.

You should now have a clear understanding of how to set up your projects correctly and 
customize the preferences to your requirements at both the system and user level.
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Lesson Review 
1 True or false? All media files must be organized into different folders on your hard 

drive before you import them into DaVinci Resolve.

2 What happens to your media files when they are imported into DaVinci Resolve?

a) The files are converted to high quality files for color grading.

b) The files are copied to the media storage location of your choice.

c) DaVinci Resolve creates a link to the media files but does nothing to the files 
themselves.

3 What type of information is used by Smart Bins?

a) Metadata

b) User Data

c) System Data

4 Where is the Live Save option located?

a) User Preferences

b) System Preferences

c) Project Settings

5 Which page provides the most flexibility for importing clips into the media pool?

a) Cut page

b) Edit page

c) Media page
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Answers 
1 False. Media files should be placed on a large, fast hard drive attached to your system 

but do not need to be organized beyond that. However, if they are organized into 
folders, you can replicate that folder structure as a series of bins when you import 
the clips.

2 C. DaVinci Resolve creates a link to the media files but does nothing to the files 
themselves.

3 A. Smart Bins utilize the metadata of clips.

4 A. Live Save is located in User Preferences, in the Project Save and Load group.

5 C. The media page provides the most flexibility for importing clips, but clips can be 
imported using the cut and edit pages too.



An Introduction 
to Audio Post and 
Sound Design 
Chances are you’ve heard the adages “Seeing is believing” and “A picture is worth a thousand 
words.” However, when it comes to motion pictures, both the visuals and soundtrack are 
equally important. In fact, a great soundtrack sells the onscreen illusion, manipulates 
emotions, transports the audience into the scene, and captivates their imagination. A lousy 
soundtrack, on the other hand, keeps the audience at a distance, distracts from the story, 
and draws attention to production flaws, performance issues, and plot holes. 

Audio post-production is much more than simply adjusting volume levels and mixing 
tracks. Transforming production sound into a powerful soundtrack requires time, technical 
skill, creative vision, and execution, as well as a full set of professional audio tools. The 
good news is that DaVinci Resolve includes the tools to create a professional soundtrack 
from start to finish. Before you dive into the following lesson, it’s a good idea to 
understand the audio post-production process and workflow. 

Keep in mind that many elements affect the workflow you’ll use: the type of project, 
budget, format, length, deliverables, and distribution methods often dictate the size of the 
post audio team, amount of time, and tools available to get the job done. This introduction 
focuses on the fundamental post-production audio processes necessary for both narrative 
and documentary style projects. Although the following pages explain the different jobs 
and stages in audio post-production, having the Fairlight page built into DaVinci Resolve 
means that you can perform the same steps on your projects with no additional 
crew or budget. 
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What Is Audio Post-Production? 
Let’s start with a few basic terms. Audio post-production refers to the process of making a 
soundtrack for moving images. Notice the use of “moving images,” which encompasses 
all projects great and small, from blockbuster theater movies to streaming videos and 
everything in between. A soundtrack is simply the audio that accompanies a finished project. 

How your audience experiences the finished project is greatly influenced by the 
soundtrack. In fact, a well-executed soundtrack may go unnoticed for hours by the 
audience while they are immersed in the show. On the other hand, it takes only a few 
seconds of an amateurish or sloppy soundtrack to lose the audience not only from the 
story but possibly from the theater or to a different channel. 

If you’ve ever recorded or watched a home movie, especially one shot at an exciting public 
place such as a beach or an amusement park, then you have firsthand experience with 
some of the inherent challenges in both recording and listening to natural production 
sound. All those excess environmental sounds and distractions create a need for audio 
post-production to transform raw sound into successful soundtracks with clear dialogue, 
realistic effects, and lush acoustic soundscapes wrapped in an emotionally powerful score. 

What Is the Audio 
Post-Production Workflow? 
Since the advent of sync’d sound in motion pictures, the first rule of audio post has been, 
“Never start working on audio until the picture is locked.” “Locked” suggests that there will 
be no more changes to the picture edit from this point forward. 

In reality, changes always happen. Why does this matter? Because soundtracks must 
maintain a frame-accurate relationship with the picture to stay in sync. If they are off by as 
little as one or two frames, the sight and sound will be noticeably out of sync—a situation 
that is distracting, unprofessional, and likely to lose your audience. 

In a traditional post-production workflow, changes to the locked picture have a cascading 
snowball effect on audio post. But when you’re working with DaVinci Resolve, which is the 
only professional editing software that includes a full digital audio workstation (DAW), 
no matter what editing changes are made, you can update your project immediately and 
efficiently. This gives you tremendous creative flexibility if you are working on your own 
because you can go back and forth between editing picture, audio work, and color 
correction as often as needed. 
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For larger productions, DaVinci Resolve solves the issue of updating, transferring files to 
other systems, and conforming projects between editorial and audio post because editing 
and audio post-production are done in the same project without ever leaving the 
application. Best of all, audio post-production can start on the exact same timeline that the 
editor used so you have zero chance of losing frames or getting out of sync. Once audio 
post begins, the editor can use a duplicate timeline to make any new changes. Then the 
audio editor can easily merge the changes between timelines with DaVinci Resolve’s 
powerful timeline comparison tool. 

DaVinci Resolve provides the audio tools needed for the highest quality audio post-
production and is ideal for small projects yet powerful enough for big Hollywood studios 
and broadcast productions to use as well. Whether you’re working on your own or with 
a large post-production team, you can easily migrate projects to a large facility for 
experienced audio sound designers and engineers to mix and master the soundtrack. 

Now, let’s break down the different phases and jobs in a traditional audio post-production 
workflow. With DaVinci Resolve, you can perform all these steps as needed by yourself or 
with a team of audio professionals on your own projects. 

Spotting the Soundtrack 
A spotting session is when the supervising sound editor and the sound designer (often 
the same person) sit down with the director, editor, and composer to look for soundtrack 
elements that need to be added, fixed, or re-recorded. Notes from a spotting session are 
combined into a spotting list that details music cues, important sound effects, dialogue 
fixes, and additional audio notes. 

DaVinci Resolve has simplified these spotting sessions with the timeline markers that you 
can use in either the edit page or Fairlight page. The index in the edit and Fairlight pages 
serves as an interactive spotting list that not only includes information for each marker but 
also moves the playhead to the selected marker’s position in the timeline. 

Production Dialogue Editing 
Dialogue editing is the tedious, behind-the-scenes task of splitting dialogue into separate 
tracks, removing unwanted sounds, replacing individual words or phrases for clarity, and 
balancing separate clip audio levels for consistency. Why go to all that trouble? Because 
spoken words are as important to a soundtrack as the lead vocals in a hit song. Keep in 
mind that dialogue editors are responsible for all spoken words, including dialogue, 
narration, and voiceover. 
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Production dialogue editing starts with creating separate tracks for each character, and 
then moving all those dialogue clips into a specific track. This crucial step is necessary 
because each voice in a production is different and therefore must be processed 
individually with volume normalization, equalization, and effects specific to that voice. 

Next, the dialogue editor cleans up the tracks and removes any unwanted human sounds 
(like tongue clicks and lip smacks). If a distracting sound can be physically cut out, this is 
the time to do it. Plug-ins and effects can help eliminate unwanted clicks, pops, and noise 
automatically, but be aware that any processing you add to a clip can affect a voice as well. 

After the dialogue is cleaned up, the volume levels are balanced to be consistent on each 
dialogue track. If dialogue can’t be used because it is damaged, noisy, or unclear, it must 
be re-recorded or replaced with audio from other takes. The process of re-recording 
production dialogue is called automatic dialogue replacement (ADR), or looping. 

Dialogue editing can be time consuming and laborious. Once again, DaVinci Resolve 
includes easy navigation, precision editing tools, and shortcuts that can simplify and 
speed up the process. 

Sound Design and 
Sound Effects Editing 
Once the dialogue editing is finished, the creative process begins! The sound designer’s 
creative input to the soundtrack is like that of the director of photography (DP) for the 
picture. Sound designers are responsible for the overall acoustic experience for the 
audience. They also oversee the many individual tracks of sound and music that comprise 
the soundtrack. These audio tracks include dialogue, ambience, hard sound effects, 
and foley sounds (as defined below). 

Not only do sound designers determine the aural illusion and mood of the soundtrack, but 
they also create, record, and enhance sound elements that only exist in their imaginations. 
After all, many projects need sound effects that don’t exist in the real world. Where do you 
go to record dragons, aliens, or zombies? Those sounds must be created or designed from 
scratch using a combination of real sounds, simulated sounds, and a lot of processing 
and effects. 
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While the sound designer determines the depth and detail of the sound effects tracks, 
the sound effects editor places each sound effect in corresponding tracks. Sound effects 
fall into four main categories: 

 — Natural sound, also known as Nat sound or production sound, is anything other than 
dialogue recorded by a microphone on location during the shoot. 

 — Ambience, or ambient sound, is the realistic conglomerate of sounds that establish 
a location, such as waves crashing rhythmically and seabirds chattering for remote 
seaside ambience. 

 — Hard sound effects are so named because they need to be physically sync’d to 
picture and are necessary for the story or scene. Hard sound effects are typically 
elements like door slams, car horns, and face slaps 

 — Foley sound consists of any character-driven sound effects caused by characters 
interacting with their onscreen environments. Foley sounds are named after Jack 
Foley, a legendary sound editor at Universal Studios, who originally developed the 
technique of recording reenactments on a stage. Foley sound replaces the original 
production audio for everything from fistfights to footsteps and clothing movement. 

Audio editing tools in DaVinci Resolve’s Fairlight page are designed specifically for the 
precision editing and placement required when editing sound effects. And DaVinci Resolve’s 
clip speed changes are perfect for advanced sound design and pitch effects. 

Music Editing 
Music editing involves placing different music elements into the soundtrack to enhance the 
mood or story. All soundtrack music falls into one of two categories: music occurring within 
the scene that the characters can hear, called source music, or diegetic music; and non-
diegetic music that is added in post for the benefit of the audience—e.g., the 
background score. 

Diegetic music needs special attention to make sure that the volume levels, placement, 
effects, and presence fit the context of the scene. 

Non-diegetic music added in post-production for emotional effect or impact includes the 
score, stingers, and stabs. Stingers are singular notes or chords that build tension and 
suspense. Stabs are quick bursts of music that work like an exclamation point to draw 
attention to something or someone in the story or narration. 
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Enhancing and Sweetening Tracks 
Once the dialogue tracks are edited and the sound effects and music added, it’s time to 
make subtle improvements to the sound of each track so that they work in context with 
the other tracks in the mix. The tools used to improve the sound in a track are similar in 
many ways to the tools that colorists use to improve individual shots within a scene. 
Because you are learning to use DaVinci Resolve, and color correction is an integral part 
of the post-production process, it seems fitting to show the similarities between adjusting 
audio and color. 

For all intents and purposes, this process could be called “audio correction.” You 
manipulate four fundamental elements to enhance or “sweeten” audio tracks, so they work 
together as intended in the final mix: volume level, dynamics, pan, and equalization. 
DaVinci Resolve controls all four of these elements on every track without the need for 
additional plug-ins or patching. 

 — Volume controls are used to adjust the loudness of a track on a decibel scale and are 
similar to luminance (brightness) because both volume and luminance have strict 
broadcast standards and are usually the first thing the audience notices in each scene. 
Volume levels can be adjusted on each clip, track, and the main output, just as 
luminance (black and white levels) can be adjusted on individual clips, scenes, and 
output. In DaVinci Resolve, you can change the volume level of a clip in the timeline or 
Inspector. Track volume is controlled by faders in the mixer. You can also change the 
volume levels over time using automation. 

 — Dynamics controls adjust the dynamic range, which is the difference between the 
loudest peaks and quietest moments in a track. A track’s dynamic range is very similar 
to video contrast within a shot. A track with a high dynamic range has very loud and 
quiet elements within the track, such as a character whispering and then screaming in 
the same scene. A low dynamic range would be rather flat, such as a commercial 
voiceover in which the volume level of the talent is very even from start to finish. If you 
have ever worked with a Waveform or Parade scope in the color page, controlling a 
track’s dynamics is very similar to adjusting the white and black levels of a clip. Just 
think of white as the loudest you can get (-3 dB) and black as the quietest. 

 — The Fairlight page mixer includes the four most common dynamics controls in one 
easy-to-use panel. The compressor is used to narrow the dynamic range by lowering 
the loudest peaks and bringing them closer to the lowest peaks. The expander, in 
contrast, expands the dynamic range to increase the difference between the loudest 
and quietest peaks. The limiter and gate both work as acoustic “brick walls” to limit 
sound from exceeding a target level (limiter) and to prevent sounds lower than a set 
threshold from being heard (gate). 
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 — Pan controls place the sound of a track within a panoramic stereo field. These 
controls are used to compose the acoustic experience just as a cinematographer 
composes the visuals of a shot. Tracks can be precisely located anywhere from left to 
right to sound as if they come from an offscreen source, or somewhere within the 
frame. DaVinci Resolve includes advanced pan controls in both the edit page and 
Fairlight page with both 2D (stereo) and 3D sound placement for surround 
sound systems. 

 — Equalization (EQ) controls manipulate specific frequencies to enhance the overall 
sound, and are just like working with color, saturation, and hue in color correction. For 
example, the human voice is based on a fundamental frequency shared by millions, 
while the additional frequencies add tonal qualities to “color” the voice and make it 
unique and recognizable. The primary function of equalization is to lower frequencies 
that detract from the voice and boost the positive frequencies to improve the overall 
sound. The Fairlight page mixer includes a six-band parametric equalizer on each track, 
which is the perfect tool for enhancing and “sweetening” audio tracks. 

Mixing and Mastering 
The last step of audio post is mixing the tracks and mastering the output. If all the other 
steps were completed prior to the mix, the process is straightforward. The goal of mixing 
and mastering is to balance the levels coming from each track, so they sound good as a 
whole. This is accomplished by making subtle changes to the track levels or combining 
similar tracks into submixes to make them easier to control with one fader. The final master 
needs to sound great and meet delivery standards for loudness. Fortunately, the Fairlight 
page includes everything you need to mix tracks and loudness meters to make sure the 
levels are right on target. 

Now that you understand some of the technical steps and creative tools that are essential 
in an audio post-production workflow, you can dive in to the next lesson and start putting 
them to use on your own projects!
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By now, you’ve probably heard that 
sound is half of the video experience. 
In the words of George Lucas, 
“Filmmakers should focus on making 
sure the soundtracks are really the 
best they can possibly be. Because in 
terms of an investment, sound is 
where you get the most bang for 
your buck.” 

The Fairlight page in DaVinci Resolve 
is designed specifically for audio to 
accompany pictures, realizing 
cinematic-quality sound for your 
productions. Most importantly, since it 
is built right into your editing, grading, 
and visual effects application, you can 
freely refine the edit, visual effects, 
color, and sound mix, right up until the 
time of your final delivery. That 
integration is what makes 
DaVinci Resolve a game changer 
for filmmakers. 
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In this lesson, you’ll learn how the Fairlight page can enhance your audio work, whether 
that’s working at a higher level of detail than in the edit page or helping you sync sound 
effects to onscreen action easier than ever before. 

Setting Up the Project
To begin with, you will import a project that has already been prepared for you and relink 
the media.

1 Open DaVinci Resolve and in the Project Manager, click the Import button. 

2 In the dialog, navigate to R18 Beginner Guide Lessons / Lesson 07. Select the 
Fairlight.drp project file and click Open.
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The Fairlight project is added to the Project Manager.

3 Double-click to open the Fairlight project in the Project Manager.

4 If necessary, click the Edit page button or press Shift-4 to switch to the edit page.

The first thing you’ll need to do is relink the media for this project, as you did 
in Lesson 1.

NOTE Even though you relinked this same media for a previous project, 
because this project is still expecting the media to be in its original location, 
you will need to relink the media for this project separately.

5 Click the Relink Media button at the top of the media pool.
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6 In the Relink Media window, click Locate.

7 Navigate to R18 Beginner Guide Lessons and click Open to allow Resolve to search the 
folder and locate the media.
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This is a version of Living in the Age of Airplanes project you were last working on in 
Lesson 2, except there is an additional shot just before the credits. This timeline also 
has some audio fades and transitions applied to the sound effects clips on A3. The 
track volume has also been lowered using the mixer. Finally, you’ll notice that a 
keyframe change has been applied to the end of the music.

8 At the bottom of the DaVinci Resolve interface, click the Fairlight button. 

This is the one and only workflow step required to move from editing to audio post-
production in DaVinci Resolve! 
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Exploring the Fairlight Interface 
In Lesson 2, you completed steps that resulted in an acceptable mix of all the audio. 
However, the Fairlight page offers you a greater level of control over your audio since it is 
designed around working with audio and is optimized for multichannel audio recording, 
editing, mixing, and sweetening. As you can see, the default layout is streamlined to focus 
on the audio in the timeline. 

Meters Transport Controls Video Preview

Timeline Mixer

Meters panel for monitoring audio levels across separate tracks. Transport controls for controlling 
timeline playback. Built-in viewer shows the video from the edit page. Timeline that shows each 
audio track with individual channels. A full track-based mixer for adjusting levels, effects, EQ, and 
pan (and much more) of entire tracks.

Looking at the timeline, you’ll notice that all the audio fades, transitions, and keyframes are 
all still applied and viewable in the Fairlight page. This is because this is exactly the same 
timeline as you were viewing in the edit page, so any audio adjustments you made in the 
edit page are immediately viewable in the Fairlight page, and vice versa.
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TIP You’ll be pleased to know that much of the timeline controls from the edit 
page are the same when working in Fairlight.

1 If necessary, choose Workspace > Reset UI Layout.

2 Drag the left side of the mixer out to the left to reveal all the tracks.

Notice the adjustment to the track level of A3 that was previously made on the edit 
page. In addition to clip adjustments being viewable in the Fairlight page, so too are 
any adjustments you’ve made to the mixer. The only difference is that in the Fairlight 
page you have access to the full mixer, whereas in the edit page you only have access 
to certain controls in the mixer. Nevertheless, it is the same set of controls.

3 Press Shift-Z to fit all the timeline clips horizontally in the timeline window. 

NOTE The Fairlight page doesn’t have the equivalent of the edit page’s full 
extent and detail zoom buttons, but you can still use the same options for 
controlling timeline zoom and track height in the edit page: Option-mouse 
scroll (macOS) or Alt-mouse scroll (Windows) to zoom the timeline and 
Shift-mouse scroll (macOS and Windows) to zoom track height. To zoom the 
track height centered on a specific track, click the track’s header to highlight 
the track and use Shift-mouse scroll. This will also automatically select the clip 
on that track under the playhead.
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4 Move the playhead to the start of the timeline and play back to review the edit.

TIP The Fairlight page has no equivalent of the edit page’s jog wheel control, 
but you can still use the JKL keys to control playback direction and speed in 
the same way as in the edit page.

You’ll probably notice several things immediately. First, the meters for each track that 
show the level of the clip currently playing can be seen in several locations: in the track 
headers, along the top of the interface in the meters panel, and in the mixer on the 
right of the interface. Don’t worry though, since they are showing the same thing, for 
the moment at least you don’t need the mixer.

5 Click the Mixer button above the viewer to hide the mixer.
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6 Press Shift-Z to display the timeline across the full width of the interface.

The other thing you’ll have noticed is that you can see the video from the edit page, 
including effects, titles, and transitions on the right of the meters panel. This video 
preview always shows you the current video frame wherever the playhead is in the 
timeline and can be used as a reference to make sure everything stays in sync and the 
sound is timed correctly.

NOTE If you use a Blackmagic Design output device such as an UltraStudio or 
DeckLink card, then you will also see the preview on your external monitor.

In addition to using the viewer, it can be useful to see the video edits that were made, 
which can be useful when referencing edit points or other elements in the timeline, 
such as titles.
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7 Click the timeline view options menu.

8 Click the first option in the Track Display Options section to display the video tracks at 
the top of the timeline.

After that brief tour of the main points of the Fairlight page interface, it’s time to see 
how you can use Fairlight to enhance your soundtracks.
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Setting Track Formats and 
Clip Channels
Working with audio in the Fairlight page follows the same principles as when you were dealing 
with audio in the edit page in Lesson 2 in terms of setting levels and general workflow. As 
before, you will start with the dialogue clips. However, the Fairlight page exposes more 
information about those clips that you might have had an inkling about previously.

1 In the timeline header, click the Solo button for A1 – DIALOGUE and A2 – VO.

TIP You can click and drag across the mute and solo controls in the timeline 
to quickly mute or solo multiple tracks quickly.

2 Return your playhead to the start of the timeline and play through, watching the track 
meters and listening carefully.



314 Lesson 7 Mixing Audio in Fairlight

The voiceover clips are most notable as not being balanced correctly because you’re 
only hearing the narrator speak out of the left output channel. This is because these 
clips are mono, but the track they are sitting in is stereo. If you look at the clips in the 
timeline, you can clearly see the VO clips have only one audio channel, whereas the 
other audio clips are displaying two channels.

NOTE The edit page doesn’t typically expose the individual audio channels 
like this, so this is a good reason to at least check your audio clips on the 
Fairlight page, even if just briefly. If you wish to see the individual audio 
channels in the edit page, select the relevant clips, right-click them, and 
choose Display Individual Audio Channels.

All dialogue should be placed in a mono track, and it’s very easy to make this switch in 
DaVinci Resolve.

3 Right-click the track header for the A2 VO track and choose Change Track Type 
To > Mono.
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The clips now fill the full height of the track, and when you play these back you’ll see 
that the track meter is now one solid bar with the 1.0 indicator, instead of two thin bars 
with the 2.0 indicator. Moreover, the audio now plays out of both left and right 
speakers equally.

That’s fixed your narrator’s voiceover clips. However, there’s still something going on 
with the interview clips on the first track.

4 Play the first clip in the A1 DIALOGUE track again, looking at the track meter and 
listening carefully.

The audio meters show you that there are two channels in this stereo track, as you can 
clearly see from the clip. But they are playing out at different levels. Indeed, listen 
again to this interview clip, and you’ll hear that the left output channel is louder than 
the right, even though both are playing the same audio.

5 Place the playhead over the first clip, and then click the track header for the A1 
DIALOGUE track to select it.

6 Use Shift-mouse scroll to expand the track heights, centered on the selected track.
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7 Use Option-mouse scroll (macOS) or Alt-mouse scroll (Windows) to zoom horizontally 
on the clip so you can clearly see the waveforms on the two channels.

This clip has the interview audio recorded across the two channels, but you can see 
there’s clearly a difference in the levels between the two, most often because they 
were recorded from separate microphones. Indeed, the second of the two channels – 
labelled INTERVIEW 01.mov – R (for the right channel) – is much more consistent than 
the first channel INTERVIEW 01.mov – L.

However this interview was initially recorded, it’s your responsibility to choose the 
correct channel and make sure it’s in the right type of track.

8 Right-click the track header for the A1 DIALOGUE track and choose Change Track Type 
To > Mono as before.

That corrects the track, but now Resolve will use only the first of the stereo audio 
channels of the clip! You now need to reconfigure the audio channels so that you are 
exposing the correct one.
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9 In the timeline, right-click the first clip on the A1 DIALOGUE track and choose Clip 
Attributes.

The Clip Attributes window opens to reveal the current channel configuration for this 
clip, and you can clearly see that the two audio channels of this clip are configured 
as stereo.

NOTE Camera audio is invariably mono; however, cameras can often record 
multiple audio channels—up to 8 is not uncommon, with other audio 
recorders capable of recording many more! However, while each channel may 
be recording a separate microphone, it’s rare that dialogue like this is 
recorded as stereo. People never have more than one mouth!
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10 In the Format column, change the pop-up menu from Stereo to Mono.

11 In the Source Channel column, change the pop-up menu to Embedded Channel 2.

These settings will expose the correct audio channel in the mono track in the timeline.

12 Click OK.

The waveform updates to reflect the change in the exposed audio channel.

13 Use Option-mouse scroll (macOS) or Alt-mouse scroll (Windows) to display the rest of 
the clips on this track.

These other clips will also need to have the source channels changed. You can do them 
one at a time in the Fairlight page as you have just done, but it’s easier to do it as a 
group in the edit page.
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14 Press Shift-4 or click the Edit page button to switch back to the edit page.

15 Select the last four clips in the A1 DIALOGUE track.

16 Right-click any of these clips and choose Clip Attributes.

17 Again, change the Format to Mono and the Source Channel to Embedded Channel 2 
and click OK.
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18 Press Shift-7 or click the Fairlight Page button to return to Fairlight and see the 
updated waveforms.

Now that you’ve got the correct source channels exposed in the timeline, you can 
normalize the audio levels.

19 Adjust the vertical and horizontal timeline zoom so you can see the voiceover clips on 
the track below.

20 Select all the clips on the A1 DIALOGUE and A2 VO tracks, and then right-click any of 
the selected clips and choose Normalize Audio Levels.
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21 Leave the Normalization Mode at Sample Peak Program and the Target Level at 
-9 dBFS but change the Set Level to Independent and click Normalize.

The clips are independently normalized so the peak of each one reaches -9 dBFS.

22 Play back the clips in the timeline, verifying that each is at the correct level (in the 
yellow area of the track’s audio meter) and adjusting any further if required.

TIP You can also use keyframes to refine the level further within each clip as 
you did before by Option-clicking (macOS) or Alt-clicking (Windows) the gain 
line for a clip. Alternatively, you can use the split clips function by selecting the 
clip, positioning the playhead where you want to make the edit and choosing 
Timeline > Split Clip. For more information on dialogue editing, see The 
Fairlight Audio Guide to DaVinci Resolve 18.
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Trimming Clips in Fairlight 
Another common task you have more control of in the Fairlight page is trimming audio 
clips. The smallest amount a video clip can be trimmed is the individual frame level. Audio, 
however, has a much greater level of detail. Audio for video production is typically recorded 
at 48 kHz (kilohertz) meaning that there are 48,000 samples of audio per second; this 
equates to around 2,000 samples per frame if your video is running at 24 frames per 
second. Fairlight allows you to trim at this sample level.

1 Play the end of the fourth clip to the beginning of the fifth clip in the A1 
DIALOGUE track.

The edit sounds a little awkward because you’re hearing the beginning of the next 
word on the end of the fourth clip and therefore missing it on the beginning of the 
fifth clip! These situations are not uncommon when editing audio clips since the frame 
boundary may fall awkwardly for the audio edit. But the precision of Fairlight means 
that they will be easy for you to deal with.

2 In the timeline, position the playhead over the end of the fourth interview clip on the 
A1 DIALOGUE track and use Option-mouse scroll (macOS) or Alt-mouse scroll 
(Windows) to zoom in on the waveform.

NOTE It’s very easy to zoom in much further than you can in the edit page. If 
you see the dots appear on the audio clip, you are so close that you can see 
the individual samples!
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3 Trim back the end of the clip until you hear a clean edit after Brian says “…movie…”

As you are trimming the clip, you can see the waveform available in the handles of the 
clip you are adjusting, so you can clearly use it as a guide when making your changes.

4 Repeat the process at the start of the fourth interview clip, adjusting the start of the 
clip until you have a clean in when Brian says “It was really important…”

TIP You can also add a tiny fade to help smooth the audio edit if required 
using the built-in fade handles for each clip.



324 Lesson 7 Mixing Audio in Fairlight

5 Play the end of the fifth clip on the A1 DIALOGUE track and trim back slightly to tidy up 
the audio edit at the end of this clip.

Before going any further, listen to all the other audio edits along the first two tracks in 
this timeline to see if there are any other edits that could benefit from the precise 
adjustments you can make in the Fairlight page.

Subframe Audio Adjustments
You don’t always have to rely on the precision of the sample-level editing function 
of the Fairlight page because the edit page allows you to work with audio at the 
subframe level; that is at a far higher level than the individual video frame but not 
quite to the level of individual samples. Nevertheless, this often allows you to trim 
audio to a high level of precision without leaving the edit page. It’s not quite as 
precise as the Fairlight page, but for many situations it’s more than adequate. The 
best way to ensure that you’re trimming at the subframe level in the edit page is to 
have snapping and linked selection disabled in the timeline and zoom in on the 
edit as much as you can. 

NOTE If you need to catch up before moving to the next step, choose File > 
Import > Timeline, navigate to R18 Beginner Guide Lessons / Lesson 07 / 
Timelines / Age of Airplanes Trailer - Fairlight Catchup 1.drt and click Open.
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Adding and Aligning Sound Effects 
In Lesson 2, you used the replace edit function on the edit page to quickly synchronize an 
audio effect to the picture of a plane flying overhead. In the next steps, you will add some 
sound effects to the final timelapse shot in this edit, synchronizing them to the light 
streaks made by the long exposure of the planes taking off.

1 Click the Media Pool button in the top left to open the media pool.

2 Click the Sound Effects bin and select the clip SFX 07 Slow Reverb Swoosh.aiff.
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The audio clip opens in the Fairlight source viewer above the media pool. This viewer 
functions similarly to the source viewer in the edit page, allowing you to preview audio 
clips and set In and Out points.

Notice that this clip has two audio channels. 

3 Right-click the clip and choose Clip Attributes, verify that the audio is configured as 
stereo, and then click OK.

Because this clip is a stereo audio clip, it should live in a stereo track in the timeline 
That way, you’ll hear the full stereo effect (if any is present). If it’s in a mono track, you’d 
only hear the first of the two embedded channels (unless you change the audio format 
and source channel in Clip Attributes, of course).

4 In the timeline, right-click the track header for the SFX track and choose Add 
Track > Stereo.
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A new track is added directly below the track you selected. This track number is 
labelled as A4 Audio 4; the previous A4 track has now been pushed down the track 
order to A5 MUSIC.

TIP You can always change the position of tracks in the timeline by right-
clicking the track header and choosing Move Track Up or Move Track Down.

5 Select the name of this track and type WHOOSH to rename it.

6 Disable the Solo buttons for the A1 DIALOGUE and A2 VO tracks and enable solo for 
the A4 WHOOSH track.

7 Move the playhead over the penultimate timeline clip, 13 NIGHT TIMELAPSE.mov, and 
using the video preview window, place it over the frame where the first light streak occurs.
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8 Use Option-mouse scroll (macOS) or Alt-mouse scroll (Windows) to zoom in so you can 
clearly see the clip in the timeline.

9 Drag the clip from the media pool preview area to the empty track, placing the start of 
the waveform near the playhead.
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10 Once the clip is in the timeline, close the media pool, and then press Shift-Z.

Verifying Sound and Picture Sync
The sound effect is in the timeline, but you’ll want to make sure that it’s correctly aligned 
with the onscreen action. Fairlight has a great way of helping you do this.

1 Click the timeline view options menu.

2 In the Scrollers section, click to enable the Video and Audio 1 scrollers.
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NOTE Fairlight can display two audio scrollers if needed, but for this exercise 
you only need one.

The scrollers appear below the timeline. The video scroller shows the individual video 
frames from the edit page timeline. Currently, the audio scroller is displaying the audio 
from the A1 - DIALOGUE track.

3 Click the Display menu for Audio Scroller 1 and select A4 – WHOOSH.

The Audio Scroller display updates to show the waveform under the playhead, allowing 
you to judge where the sound of the audio clip occurs in relation to the individual 
video frames.
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4 To adjust the alignment of the sound effect, select the clip in the timeline and choose 
Trim > Nudge > One Frame Left or Trim > Nudge > One Frame Right, or use , (comma) 
to nudge the clip one frame left (backward), or . (period) to nudge it one frame right 
(forward) so that the high point of the waveform aligns with the start of the frame.

NOTE For more precise control, you can choose Trim > Nudge > Subframe 
Left or Trim > Nudge > Subframe Right. Alternatively, disabling snapping in 
the timeline and zooming into the clip means that you’ll be able to drag it in 
small increments in the timeline.

The scrollers are very useful for aligning sounds to the onscreen action like this 
because they provide a clear display as to exactly how the two elements are lining up, 
without needing to constantly resize the timeline. Having aligned the first sound 
effect, you will now use another Fairlight technique to quickly align copies to the other 
two light streaks from this shot.

5 With the sound effect still selected in the timeline, choose Edit > Copy or press 
Command-C (macOS) or Ctrl-C (Windows), to copy the selected timeline clip.

When you copy a clip in Fairlight, the position of the playhead is all important because 
the clip you are copying uses the playhead as an anchor. This makes it easy to paste 
the clip back in at the exact frame you need it to be aligned to.
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6 Play the timeline and, using the video scroller and/or video preview as a guide, align 
the playhead over the frame that displays the next light streak.

7 Choose Edit > Paste or press Command-V (macOS) or Ctrl-V (Windows) to paste a copy 
of the clip.

8 Continue playing the timeline until you see the third light streak, using the video 
scroller and/or viewer to place the playhead on the exact frame.

9 Press Command-V (macOS) or Ctrl-V (Windows) to paste another copy of the sound 
effect in perfect sync.
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TIP You can use the scrollers to help position the playhead within the video 
frame if needed.

10 Click the Mixer button to reopen the mixer. Use the left edge of the mixer panel to 
make the mixer as large as possible. Press Shift-Z to resize the timeline for the 
smaller area.

11 Lower the track slider for the A4 WHOOSH track by about -14 dB.

12 Once you are happy that the whoosh sound effect has be timed correctly, select the 
timeline view options and click the video and audio 1 scrollers to turn them off in 
the timeline.

As you can see, working with the scrollers in the Fairlight timeline makes it so easy to 
align sound effects and other audio elements with the edited onscreen action.
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Using Fairlight FX 
In addition to having a huge choice of video effects, DaVinci Resolve also has its own 
library of audio effects. These high-quality plug-ins are very effective in helping to 
sweeten your audio mix.

NOTE If you have any AU or VST plug-ins installed on your system, 
DaVinci Resolve will find these automatically when you first launch it, so those 
plug-ins will also be available in your Effects Library in the appropriate category.

1 In the mixer, click the + (plus) in the Effects row of controls for track A4 WHOOSH and 
choose Reverb > Fairlight FX > Reverb.

TIP You can also simply drag the Reverb plug-in from the Fairlight FX group 
in the Effects Library to the track in the mixer. Alternatively, if you wish to add 
it to a single clip on a track, just drag it from the Effects Library to the 
clip directly.
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The plug-in is added to the track so that all the clips in that track will be affected by it, 
and the effect’s controls appear in a separate window.

2 From the preset pop-up menu in the top-left corner of the effect controls window, 
choose Cathedral and then close the effect controls window.
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NOTE You can always access the controls window for any effect by clicking 
the controls button for the effect in the mixer.

3 Listen to the clips on the A4 WHOOSH track again to hear the added resonance.

NOTE If you need to catch up before moving to the next step, choose File > 
Import > Timeline, navigate to R18 Beginner Guide Lessons / Lesson 06 / 
Timelines / Age of Airplanes - Fairlight Catchup 2.drt and click Open.

Mixing the Music
It’s time to add the last audio element back into this new mix for the Living in the Age of 
Airplanes trailer.

1 In the timeline, click the Solo button for the A4 WHOOSH track to unsolo it and listen 
to all the audio tracks together.

2 Return the playhead to the start of the timeline and begin playing back until the music 
is fully playing under the first voiceover clip.

The music track sounds a little too hot (loud), making the dialogue hard to discern.

3 As the timeline is playing back, click the gain line for the music clip on A5 and drag the 
level down in real time as the timeline is still playing to around -18 dB or until you are 
happy that the music doesn’t detract from the dialogue.

TIP Hold Shift as you move the gain line for finer control over the levels.
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With the music set at a good level for the dialogue, there’s just a couple of places 
where you want it to raise slightly to fill the gaps in the soundtracks where no one is 
speaking. You can use keyframes to accomplish this as you did on the edit page in 
Lesson 2. But of course, the Fairlight page has one more trick up its virtual sleeve!

4 From the top left of the interface, click the Index button.

The index opens, displaying a list of the tracks available in this timeline.

5 Click and drag across the eyeball buttons for Tracks A3 and A4—the SFX and 
WHOOSH tracks.
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Both of those tracks are now hidden from the timeline and the mixer. Because they are 
not muted, you will still hear them, but having a simpler timeline to look at means you 
can more easily see where the keyframes should be placed with respect to the two 
dialogue tracks.

6 In the timeline, place the playhead over the gap between the second and third clip on 
A1 DIALOGUE.

7 Use Option-mouse scroll (macOS) or Alt-mouse scroll (Windows) to zoom in on 
this area.

8 Hold down the Option key (macOS) or Alt key (Windows) and place the mouse pointer 
over the gain line for the music clip, just before Brian’s clip is about to end.

The mouse pointer turns into the Add Keyframe indicator.
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9 Click once to add a keyframe here, and then reposition your mouse pointer and 
Option-click (macOS) or Alt-click (Windows) the gain line again, just after Brian’s 
interview clip has ended, to add a second keyframe.

10 Repeat the process around the beginning of the next clip on A1, adding a keyframe 
just before the clip starts and a second keyframe just after Brian says “If…”

NOTE It doesn’t matter if these keyframes are not precisely located because 
you can always adjust them later.
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11 With the four keyframes added, position your mouse over the gain line between the 
second and third keyframe and increase the Gain to about -12 dB (an adjustment of +6 dB).

12 Repeat this process in any gaps between the clips on A1 and A2 where you feel the 
music could be brought back slightly.

13 In the Tracks Index, click and drag across the disabled visibility controls for tracks A3 
and A4 to show them in the timeline again, and then click the Index button at the top 
of the interface to close the Index. 

14 Press Shift-Z to see the whole timeline and, if necessary, use Shift-mouse scroll to 
adjust the timeline track heights so you can see all the tracks.
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15 Return the playhead to the start of the timeline and play back to listen to the mix!

NOTE To import a finished version of this timeline, choose File > Import > 
Timeline, navigate to R18 Beginner Guide Lessons / Lesson 06 / Timelines / 
Age of Airplanes Trailer - Fairlight Finished.drt and click Open.

Once you are happy with the mix, you can now return to the edit page, where you will 
instantly see all the audio changes you made in Fairlight!
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Well done! This lesson was designed to introduce you to the role the Fairlight page plays in 
the DaVinci Resolve post-production workflow and to highlight some of the advantages of 
employing the Fairlight toolset to your audio editing and mixing tasks. You can learn more 
about the incredible audio tools Fairlight offers, including how to set up an automated 
dialog replacement (ADR) session, in The Fairlight Audio Guide to DaVinci Resolve 18 
(https://www.blackmagicdesign.com/products/davinciresolve/training#books), available 
for download.

https://www.blackmagicdesign.com/products/davinciresolve/training#books
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Lesson Review 
1 What is the highest level of precision you can work with in the Fairlight page?

a) Frame level

b) Subframe level

c) Sample Level

2 True or false? All audio adjustments you make in the edit page are visible and 
adjustable in the Fairlight page.

3 Which option is used for changing a clip’s audio configuration from stereo to mono?

a) Clip Properties

b) Audio Mixer

c) Clip Attributes

4 How many audio scrollers can be displayed at the same time?

5 True or false? The Fairlight page does not allow you to add audio clips to the timeline.
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Answers 
1 c). Audio clips can be edited at the sample level, which offers the highest precision in 

the Fairlight page.

2 True. All audio changes you make in the edit page are visible and adjustable in the 
Fairlight page.

3 c). The Clip Attributes option is used to change a clip’s audio configuration.

4 Two audio scrollers can be displayed at the same time, as well as one video scroller.

5 False. Audio clips can be added to the timeline by dragging them from the media pool 
or from the preview window.



An Introduction 
to Visual Effects 
Compositing 
When mutants attack or aliens land spaceships on Earth, filmmakers turn to visual effects 
artists to make those shots reality. You can use visual effects to create images that cannot be 
realized with live-action production. Anything that’s too difficult, too dangerous, or even too 
expensive to capture with a camera, you can create with visual effects compositing.

DaVinci Resolve has the full Fusion visual effects and motion graphics toolset built in, which 
makes it possible for you to create feature film-quality effects without switching between 
software applications! 

While you can create simple visual effects in the edit page, you’ll find more advanced tools 
for building sophisticated, photorealistic effects in the Fusion page. It features a flow 
graph-style interface, known as a node tree, designed specifically for visual effects and 
motion graphics work. 

As you read through the following lesson, you’ll begin to understand the many tasks you 
might choose to perform using Fusion’s complete 3D workspace and over 250 compositing 
and visual effects tools. Best of all, it’s now part of DaVinci Resolve, so you can switch from 
editing, color grading, and audio post-production to visual effects and motion graphics 
with a single click! 
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What Is Visual Effects Compositing? 
Compositing is the process of combining two or more images to make a unique, new image. 
But it’s not just about combining images. You can composite many different elements such 
as video clips, animations, text, mattes, particles, and graphics. Sometimes these elements 
are called layers because they are layered on top of each other to produce the new image. 

Many tasks fall under the umbrella of visual effects. Just as with color and audio post-
production, visual effects are a huge and exciting part of the creative filmmaking process. 
Depending on the type of work you do, you may need to learn some or all of the skills 
needed to create a finished visual effects shot. Smaller productions often require you to 
build shots from start to finish, whereas larger studios may have specialized artists 
dedicated to tasks such as rotoscoping, 3D, particles, lighting, and so on. 

Even when you are hired as an editor or a colorist, you will often be asked to produce 
smaller effects. Like all aspects of post-production, learning the tools and techniques 
requires practice. Understanding the technology behind the tools will improve your 
problem-solving skills and efficiency. 

As industry deadlines tend to grow shorter, editors and colorists who know how to finish 
shots quickly and efficiently are in the highest demand. Learning the basics of Fusion 
visual effects in DaVinci Resolve—along with color correction and audio post-production—
will make you a more valuable artist and open up more job opportunities. 

Getting Started with Visual Effects 
Visual effects were once a luxury reserved only for big-budget feature films. With the 
power of Fusion built into DaVinci Resolve, you can add feature film-quality visual effects 
to any program without a massive budget. 

If you think visual effects are only about creating aliens, spaceships, and explosions, 
you are missing out on the many smaller effects that can improve any project. In fact, most 
visual effects consist of corrective effects, clean-up work, or inserting subtle hidden effects 
such as sky and window replacements. These effects don’t take long to do and can 
improve everything from poorly framed B-Roll to dull gray skies. 

Adding Elements 
Weather is unpredictable, and when the story calls for snow, you need snow! That’s why 
creating elements such as snow, rain, fog, and even lightning are essential skills of the 
visual effects artist. You can use the particle system in Fusion to create realistic weather 
elements that move, fall, and drift naturally. 
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Sometimes it’s just too dangerous to do things on a real set. For example, smoke, flying 
debris, and fire are always dangerous when actors and an entire crew are involved. In 
many cases, these elements can be shot separately, and you can composite them in later 
as a safer yet realistic-looking alternative. 

Animals and Kids 
The unpredictable nature of working with animals and children can slow each shooting day 
to a crawl. Being able to divide and conquer a shot by splitting it up and shooting animals 
separately from main action can ensure that you get the shot completed without schedule 
overruns. Through seamless compositing, you can combine each section of a frame to 
create a realistic split-screen composite that looks like one take. 

Sky Replacement 
A perfect sunset or a bright blue sky with puffy clouds are great backdrops for any scene, 
but weather is out of your control. When everyone is on set, the equipment is rented, and 
the clock is ticking, you’ve got to get the shot even when the weather isn’t cooperating. 
That’s where the (extremely common) art of sky replacement comes in. Fusion’s keyers, 
rotoscoping tools, tracking, and 3D compositing can remove ugly gray skies or salvage 
overexposed skies. Add in some Fast Noise or volumetric effects and that clear blue sky 
can include beautiful dramatic clouds that weren’t there during the shoot. 
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With the 3D controls in Fusion, you also can simulate the light direction, atmospheric haze, 
and realistic parallax camera movement—all elements that can make the difference 
between a believable sky replacement and a cheap, artificial fake. 

Performance/Cosmetic Fixes 
Correcting or improving an actor’s not-quite-perfect performance can avoid the need for 
expensive reshoots. This common compositing task is rarely noticed by an audience and 
can be simple to do, depending on the required fix. For instance, a detail often missed 
during shooting (but painfully obvious in the screening room) is when an actor portraying 
a dead body involuntarily moves his eyes. Compositing closed eyes from one frame over an 
entire shot is a skill that can save the shot and be repurposed for many similar fixes. The 
removal of scars, tattoos, or uneven tan lines all use similar techniques and can be 
performed using Fusion’s planar tracker, paint tools, and rotoscoping. 

Changing Locations 

Production budgets always limit where and when you can shoot a scene, but simple 
environmental enhancements can disguise those limits and change the feel of an entire 
scene. Such effects can consist of replacing windows in a moving car because you couldn’t 
close Times Square to shoot your scene, or “moving” the ground-floor apartment location 
you could afford to a penthouse view. These are common tasks for the visual effects artist 
and can be very quick fixes for editors and colorists to perform. 

Wire Removal 
Visual effects are also used to add realism to already dangerous stunts. Getting 
performers to fly across the screen either from explosive force or supernatural powers 
often requires safety harnesses and wire rigs. You can hide those rigs and wires using 
Fusion’s simple clone tools and tracking, a task that editors and colorists can take on in a 
pinch when the visual effects artists are busy with larger composites. Plus, the wire 
removal skills you use in Fusion techniques can also apply to removing lighting stands, 
telephone wires, and unsightly antennas. 
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Set Extensions 
You can take environment enhancements to the next level to create entire set extensions 
that visually transport your audience to a specific location (while keeping your production 
safe at home on a sound stage.) Instead of shipping the whole cast and crew to the 
Himalayan foothills, you can replace the background of your shots with temples and 
mountains and snow. For period pieces or science fiction, such effects can save enormous 
amounts of time and money because you don’t have to build massive sets. You just 
construct set fragments around your actors and place green screens in the surroundings. 
Using the Fusion page during post-production, you can track the camera movement and 
replace the greenscreen with 3D extensions to your set. 

Motion Graphics 

Motion graphics, or motion design, is all about animating graphic elements. It’s the 
marriage of visual effects, animation, and graphic design with the goal of presenting 
onscreen information. Because information in some form is the objective, text often plays 
a primary role in almost every motion design project. The Fusion page includes both 2D 
and 3D typography tools along with creative paint, Bézier-shape drawing tools, and 
incredibly deep spline animation controls. They enable you to create engaging animated 
designs that communicate, educate, and entertain. 
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Learning to See 
If you want to create high-quality visual effects, you need to be very conscious of how the 
world appears around you. Visual effects must look and feel real, or your audience will stop 
believing. The skill to observe the surrounding world in painstaking detail is just as 
important as mastering the technical and artistic side of visual effects. 

To become a skillful visual effects artist, you must start noticing how light, perspective, and 
depth appear in the real world, and then bring those observations into your composites. 

If all the elements that make up a composite are meant to be in the same location, 
then you must make sure that light hits them all from the same direction. Simulating 
relative sizes, parallax motion, and depth to a real-world level of detail is essential to the 
realism of an effects shot. 

As you begin creating visual effects, start small. The Fusion page is very deep and 
incredibly powerful. The beauty of having Fusion built into DaVinci Resolve is that you 
can jump into creating visual effects with one click; try something out to see if it will work, 
and then, depending on your skill and the time available, either pass it off to your visual 
effects artists or finish it yourself. 

Visual effects compositing is about a combination of tools rather than any single filter 
effect. It takes time, patience, and experience to do well, but it’s an incredibly exciting 
activity that you can learn through experimentation and practice. Eventually, you’ll create 
the most thrilling cinematic moments imaginable. 

As Walt Disney said, “It’s kind of fun to do the impossible.”



The Fusion page brings professional-
level visual effects and motion 
graphics tools into the timeline of your 
edit. Whether you are a video editor, 
colorist, or finishing artist, Fusion 
offers node-based compositing to any 
project. And, since the Fusion page is 
integrated within DaVinci Resolve, 
there is no need to render out shots 
and manage projects in multiple 
applications. As you will soon discover, 
nodes are a faster way to work than 
traditional layer-based software when 
producing intricate shots. 

The Fusion interface is unique to other 
pages within DaVinci Resolve and while 
it may take some time to master, once 
you do you will be treated to an 
expansive toolkit and able to tackle 
any problem. 

Lesson 8

Creating Effects 
in Fusion 

Goals
The Fusion Interface  352

Adding the First Effect  355

Masking Effects  360

Adding Clips from  
the Media Pool  365

Adding An Effect 370

Reviewing Work in the Edit 371

Lesson Review  375

Time
This lesson takes approximately 
90 minutes to complete.



352 Lesson 8 Creating Effects in Fusion 

In this first exercise, you’ll get familiar with the unique layout of the Fusion page and 
explore the order of operations inside a node-based workflow. 

TIP Fusion works best with a three-button mouse. The “third button” is the scroll 
wheel. You can optionally complete this lesson without a three-button mouse.

The Fusion Interface 
In traditional post-production workflows, a video editor must first complete multiple cuts 
of a film to determine the timing of shots. When motion graphics or visual effects are 
required, work needs to be translated into other applications by rendering shots, 
importing assets, and creating multiple project files across several pieces of software. 
Utilizing the Fusion page within DaVinci Resolve, many of those intermediate steps are now 
completely unnecessary, which gives the creative team more time to focus on what is 
important: the quality of the artistry. In our first exercise, we’ll explore how the basic tools 
and operation of Fusion work within DaVinci Resolve. For this clip, we will add the film’s 
title, as well as a sepia-tone color correction.

1 Open DaVinci Resolve, right-click in the Project Manager, and choose Restore 
Project Archive.

2 Navigate to the R18 Beginner Guide Lessons folder and open the folder Lesson 8.

3 Select the folder called Hot_Milk.dra and choose Open.

4 Double-click the Hot_Milk project to open it.

5 Navigate to the edit page.

6 From the main menu bar, choose Workspace > Reset UI Layout.

7 Ensure that the timeline BMD_Fusion_01 is open, and then move the playhead to the 
beginning of the first clip in the timeline.

8 Click the Fusion page button or press Shift-5 on the keyboard.
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We are ready to begin working on effects within the Fusion page. Let’s cover the 
interface basics first, and then we’ll add some tools.

The toolbar has buttons for 
adding commonly used effects 
or tools to the Node Editor.

The left and right viewers 
can show different images or 
effects from your composite. 

The work area can show any 
combination of the Node Editor, 
Keyframes Editor, or Spline Editor.

In the Inspector, you can 
display and manipulate the 
parameter of any selected 

effect or tool in the Node Editor. 

Two viewers align at the top of the screen, an Inspector panel aligns at the right side of 
the interface, and lastly, the Node Editor fills the lower section. The Node Editor is 
perhaps the most significant section of the interface because all the tools and 
components used to build visual effects are implemented here. Fusion does not use a 
timeline with layers as the edit page does; the creative work is performed with nodes. 
And unlike layer-based compositing, there is no hunting for pre-composites (or nested 
timelines) when working with an organized node graph!
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9 With the mouse pointer located over an empty gray space in the Node Editor, hold 
down the middle mouse button and drag to pan the node tree into the center of 
the panel.

TIP If you do not have a middle-mouse button, you can hold Ctrl and Shift 
(Windows) or Command and Shift (macOS) while the left mouse button is 
clicking-and-dragging to pan the node graph flow.

Node-based workflows differ from the layer-based workflows you might be familiar 
with. Adjustments such as zooming in on an image or stabilizing a shaky clip are 
individually executed using dedicated tools known as nodes. Nodes connect to one 
another like a flowchart that represents a signal path. Every composition in Fusion for 
DaVinci Resolve starts with a node called MediaIn1 and ends with a MediaOut1. These 
nodes represent the video or image leaving and returning to the edit page.

Let’s review this shot.

10 Press Play on the transport controls or press the Spacebar. 

Notice how there is no timeline or playhead scrolling? Time navigation in the Fusion 
page is done entirely with the time ruler, which rests between the viewers and the 
node graph. The time ruler is measured in frames.

TIP The terms node and tool are used interchangeably to refer to an image-
processing operation. 

11 Stop the timeline (press the Spacebar).

12 Drag the playhead slowly through the render range from the first yellow line on the 
left to the second yellow line on the right. 

You may notice a small green line appear in the lower region of the time ruler. A green 
line represents that a frame of video has been cached into RAM to allow faster 
playback on the system. While not a requirement to work with Fusion, having more 
RAM available on your system will allow Fusion longer lengths of time to cache, 
resulting in smoother playback. 



355Adding the First Effect 

TIP You can assign more RAM or less RAM for Fusion RAM playback in the 
Preferences panel. The amount of RAM assigned to Fusion RAM playback is taken 
from the total amount assigned to the DaVinci Resolve application. 

Adding the First Effect 
This project is taken from a film trailer. One of the goals we need to achieve is to add a 
sepia-colored filter to this image to make it look a little bit gritty. You may be wondering 
why we are adding a color correction in the Fusion page when the color page is so close by. 
Don’t worry! We’ll explain this detail in just a moment. 

1 Select the MediaIn1 node in the Node graph.

2 Right-click the node and choose > Rename.

3 Name the node ACTOR.

MediaIn1 is not the most descriptive name for the content. Renaming assets such as 
video and images can assist with organization. 

TIP The keyboard shortcut for renaming a node is F2. 

The Fusion page utilizes two viewers. The viewers are used to monitor any node at 
any point in the flow. The flow describes the path the nodes take and the results of 
each tool. 

4 Press the number 1 on the keyboard on either the number pad or above the home 
row to view the Actor node in the left viewer.

5 Ensure the Actor node is still selected. A selected node will have an orange border 
surrounding the tool. Add a Color Corrector node by pressing the Color Corrector tool 
button. (It’s the first tool in the second group of the toolbar.)
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6 Select the node Color Corrector1 in the Node Graph. When a node is selected, the 
Inspector activates with editing functions tied to the tool. 

7 Click and drag the color wheel within the Inspector in the upper right direction 
toward orange.

Notice how the results of the color corrector are viewable on the right viewer but not 
on the left. This is because the Actor node is being sent to the left viewer before the 
color corrector. However, the MediaOut1 node—which appears after the color 
correction—is being sent to viewer 2.

The trailer will need some text. The Text+ node can be found in a similar portion of 
the toolbar.

8 Find the Text+ tool; it is third from the left on the toolbar. Do not click just yet! If you 
accidentally added the Text+ node, undo the action by selecting the menu bar > 
Edit > Undo.
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9 Click and drag the Text+ node onto an empty portion of the Node graph, to the upper 
right of the Color Corrector node. 

10 Load the Text1 node into the left viewer by selecting it with the mouse and pressing 1 
on the keyboard.

TIP Nodes can also be sent to viewers by clicking and dragging them into 
viewers directly using the mouse. 

11 In the Inspector, type CHAIN GANG inside the text panel.

Before combining these two images, adjust the height and line spacing. 

12 In the Inspector, adjust the Size slider to a value of 0.3

13 Lower the Line Spacing slider down to 0.6

Lastly, the color value of the font can be adjusted.

14 Click the white color swatch within the Inspector to reveal the color picker.
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The default value of 255 is too bright and will be difficult to read with such strong 
backlighting in the shot. To lower the brightness of the text, click and drag the 
luminance slider down to a value around Red: 200, Green: 200, and Blue: 200.

To combine the video of the actor and the Text+ title, we need to use a Merge node. 
Merge nodes are how any two assets inside of Fusion are combined. This could include 
video, stills, text, and more. In this composition, the Merge node needs to be 
connected between the Color Corrector node and MediaOut1.

15 Hover your mouse over the right side of the connection made between 
ColorCorrector01 and MediaOut1. The connection will turn blue on the right side. 
Click and drag to disconnect the Color Corrector from the MediaOut node.

16 Add the Merge node in the newly created gap. The Merge node is the first tool in the 
third toolbar group.

17 Connect the output of ColorCorrector1 (gray square) to the background input of 
Merge1 (yellow triangle). 

18 Connect the output of the Text node (gray square) to the foreground input of Merge1 
(green triangle).
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19 Connect the output of the Merge node (gray square) to the input of the MediaOut1 
node (yellow triangle).

Our first composite is nearly complete! In the current setup, only the Actor node is 
receiving the sepia tone correction. This is because the Color Corrector is placed 
before the Merge node. With a node-based workflow, it is quick to make changes to 
the flow of the nodes to experiment with different looks.

20 Create room in the flow by clicking and dragging the Text1 node up, and the 
MediaOut1 toward the right.

21 To reposition the sepia tone look, hold the Shift key on the keyboard, and click and 
drag the Color Corrector node to be placed between Text1 and Merge1. 

This results in the Actor node no longer being graded sepia and introduces a yellow 
tint to the text because the color correction is happening before these two elements 
are placed together.

22 To tint both the Actor node and the Text1 node, click and hold Shift again, and drag 
the Color Corrector node after the Merge node.

In the left image, the corrector is only on the video. In the middle image, the corrector is only 
on the text. In the right image, the corrector is applied to both.
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Working with nodes may seem very different at first, but you can appreciate how 
quickly (and visually) this color alteration was made. You might be asking yourself why 
we are using Fusion for this task. After all, a combination of the edit and color pages 
could produce the same results. And this is true! However, repatching nodes and 
auditioning different looks is more efficient on the Fusion page. By learning the 
fundamentals of node-based compositing, you will gain the skills required to build 
more complex work that can only be accomplished using these tools.

Masking Effects 
One of the most requested asks inside the edit suite is to remove—or add—elements into 
a shot seamlessly. Removing license plates, billboards, advertisements, and screens are 
just some of the requests that arise on practically any project. Fusion’s masking abilities, as 
well as dedicated tools to warp and transform assets, offer the perfect toolkit for cleaning 
up sets in post-production.

This documentary-style project follows a band on a night of gigs, and there are a couple of 
assets the director flagged to be removed during the edit. 

1 Move into the edit page (Shift-4) and navigate to the media pool.

2 In the Timelines bin, open BMD_Fusion_02.

3 Place the timeline playhead over the top of the first clip in the timeline.
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4 Enter the Fusion page (Shift-5).

Several of these posters must be covered up to protect against any potential legal 
copyright claims. Fusion’s masking tools can quickly and selectively add a blur to cover 
up some of the text. First, you’ll want to organize the node tree.

5 Send the MediaIn1 node to the left viewer by selecting the node and pressing 1 on 
the keyboard.

6 Rename the node MediaIn1 by right-clicking on the node and selecting Rename. Label 
the node Band.

Adding a Blur node will cover up the pieces of text in question. One of the faster 
methods to add nodes is to select the preceding node first, and then add the desired 
node. This way, no patching is required when adding a new tool into the flow.

7 Select the Band node.

8 Add a Blur node by clicking the Blur tool in the toolbar, it is the last tool in the 
second group.

Blur icon

9 Within the Inspector, with the Blur node selected, increase the Blur Size to a 
value of 12.
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The right viewer shows the result of adding a blur, while the left viewer is showing a 
clean feed. By viewing two regions of the flow simultaneously, masking the effect will 
be a bit easier as you can draw the mask shape on the unaltered viewer.

10 Click and drag the Polygon node into the node graph, above the Blur node. The 
Polygon tool is the third tool in the fourth group within the toolbar.

At this point, do not patch the Polygon to the blur.

11 Draw a shape around the U.S. GIRLS text in the lower left of the viewer. To draw a 
shape, ensure that the Polygon node is selected and click to add shape points inside 
the viewer. A broad square shape will be sufficient to cover the text. 

To complete the shape, after the last point is added, click on the first point to close 
the spline. 

You will need to zoom into the viewer to see where to add points in the mask. Place 
the mouse pointer over the top of the area you want to zoom in, and the zoom will be 
centered on that position. There are multiple ways to zoom in to a viewer inside of Fusion. 

 — Hold the Ctrl key (Windows) or Command key (macOS) on the keyboard while 
using the scroll on a mouse or trackpad. 

 — Press + or – on the keyboard
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 — Adjust the zoom level in the zoom panel, in the upper left of the viewer. By default, 
this value is set to Fit.

Once zoomed in on the U.S. Girls poster, pan around the image. To pan:

 — Click the middle mouse button, which is typically the scroll wheel, and drag 
the mouse.

 — Hold Ctrl-Shift (Windows) or Command-Shift (macOS) on the keyboard while 
clicking and dragging with the mouse.

Now that a shape has been drawn, it can be connected to the blur to isolate just 
that area. 

12 Connect the Polygon1 node to the Blur1 node by dragging the gray square output 
from the shape to the blue triangle input of the blur.

Now the poster is blurred, and the result can be seen in the right viewer. 

If you are unhappy with the mask shape, it can be fixed afterward by clicking and 
dragging the existing points inside either viewer. It may be difficult to evaluate the 
mask with the onscreen controls and wireframe visible. These can be 
temporarily hidden. 

13 In the right viewer, select the three-dot Options menu and disable Show Controls.

The edges of the mask are very apparent and need to be softened.

14 Select the Polygon node in the flow and adjust the Soft Edge in the Inspector to a 
value of 0.002.
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15 Reset the zoom levels for either viewer by pressing Ctrl-F (Windows) or Command-F 
(macOS) or by opening the zoom level panel in the upper left of either viewer and 
selecting Fit. 

The client has requested that another poster be blurred as well. In Fusion, multiple 
masks can be used in tandem on the same node, meaning that an additional blur node 
is not required.

16 Add a second Polygon node by clicking and dragging the tool from the toolbar.

17 Click on the second Polygon node to select it. Inside either viewer draw a shape 
around the word “Wa /ves.”

You may need to re-enable Show Viewer Controls from the Options menu within 
the viewer.

18 Attach the output of Polygon2 (gray square) to the mask input of Polygon1 
(blue triangle).

19 Select Polygon2 and in the Inspector and adjust the Soft Edge to 0.002.
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By tying several masks together, more can be accomplished with fewer nodes in the flow. 
Using fewer nodes to build your composites will result in better performance on a system.

Adding Clips from the Media Pool 
There is a reddish, pinkish poster to the left of the male band member that needs to be 
replaced altogether. A replacement poster exists within the project. Assets can be dropped 
into a Fusion composition right from the media pool.

1 Open the media pool found in the upper left of Fusion and navigate to the Images bin. 
Select Guitar.png and drag and drop the asset into the node panel. Close the media 
pool when done.

2 The guitar graphic is labeled as MediaIn1, which is not particularly helpful. Rename the 
node guitar.

A Merge node is required to add the guitar poster over the top of the video footage. In 
the previous section, we covered how to manually add a Merge node by using the 
toolbar and patching the inputs. There is a shortcut for adding merges by using 
the mouse.

3 Click and drag the guitar node output (gray square) to the output of the Blur node 
(gray square).
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This will add a Merge node, with the guitar placed in the foreground and the video in 
the background.

Simply placing the poster on top of the video will not be enough to blend the two 
elements. The wall, understandably, is not filmed in a completely neutral position. By 
using a node called Corner Positioner, the replacement poster can be quickly and 
accurately nudged in place to match the surface of the wall.

4 Select the guitar node in the node graph.

5 Open the Effects panel in the upper left of the interface.

6 Navigate to Tools > Warp > Corner Positioner.

7 Click the Corner Positioner node in the Tools palette and then close the panel.

You may need to reorganize your nodes at this point. Nodes can be moved freely 
within the node graph by clicking and dragging them either individually or with 
multiple nodes selected. To arrange the nodes to locked positions on the grid, right-
click anywhere inside the node graph and choose Line Up All Tools To Grid.

It’s important to note that the location of a node within the node graph does not affect 
the image in any way. If you were to drag the band node elsewhere on the graph, so 
long as the patching sequence remains the same, the image will be unaffected.
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With the corner positioner added, we can define the edges of the poster we want to 
replace. Since the new guitar poster has the same dimensions as the poster on the 
wall, they will snap into place. At this point, don’t worry about the dog-eared edge on 
the upper left of the poster.

8 Select the Corner Positioner node and adjust the control points. This can be done by 
clicking on any one of the four anchors in either viewer. 

Alternatively, anchor points can be adjusted within the Inspector. Do not use the 
Offset sliders within the Inspector; simply click and drag the numeric values in the X 
and Y fields within the panel. 

You may need to zoom out within the viewer to adjust the control points that appear 
outside of the frame.

Before (left) and after adjusting the corner positioner (right).

The poster has been set in place; however, it looks a little too bright and vibrant 
compared to the rest of the environment. In this instance, a color adjustment on just 
one element inside of the frame can be useful for blending assets. 

9 Add a Brightness/Contrast node, after the Corner Positioner node. This node can be 
found in the fourth spot in the second group on the toolbar.

10 Adjust the Color Correction node in the Inspector. Lower the Gain value to around .8, 
raise the Lift value to 0.03, and drop the saturation to around 0.80.

TIP A small gray dot appearing under any parameter slider indicates the 
default position of that parameter. Clicking the gray dot resets the slider to 
its default position. 
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Notice how the entire frame adjusts in brightness as the Lift is raised? This is because 
the Brightness/Contrast node affects everything inside the frame rather than just the 
portion of the frame that contains the poster. 

11 To limit the node adjustments to the poster frame, enable Pre-Divide/Post-Multiply in 
the Inspector.

Almost done! The last step is optional: replicating the dog-eared edge on the poster. 
This is another example of using two viewers at different stages of the node graph to 
assist with masking. As you can see, the dog ear is not visible with the corner 
positioner enabled. 

12 Send the Band node to viewer 1.

13 Send the MediaOut1 node to viewer 2.

14 Add a Polygon tool to the node graph below the Merge node. Do not patch the 
polygon yet.
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15 With the polygon selected, draw a mask around the dog-eared edge in the left viewer.

16 Connect the polygon output (gray square) to the Merge mask input (blue triangle).

As you can see, the exact opposite of the desired result is occurring. Only the dog ear 
is coming through and not the rest of the poster. 

17 In the Inspector, with the polygon selected, enable Invert.

It may seem confusing that a Merge node is being masked. By adding the polygon at 
the merge level, you are controlling how much of the foreground layer is placed on top 
of the background layer. And this foreground layer is getting distorted by the corner 
positioner. The Merge node is the last stop before these two images are combined. 
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Adding An Effect
You’ve built out the node graph and have cleaned up the posters! It’s easy to forget to 
review the results when working on a still frame for such a long time. Press the Spacebar to 
watch the shot now.

TIP You can click the speaker icon on the left side of the toolbar to mute the audio 
if you no longer want to hear it. 

The camera is on a tripod and, thankfully, the frame is entirely still. However, the shot is a 
little stationary. Fusion for Resolve contains an effective Camera Shake node that can add 
some subtle movement to this shot. 

1 Select the Merge node in the node graph. That way, any additional nodes will be 
placed after this point in the flow.

Rather than opening the Effects palette and navigating through the tools submenu, 
the Node Search tool is a fast way to find and add nodes.

2 Press Shift-Spacebar on the keyboard to open the node search.

3 Type camera in the search field

4 Select Camera Shake (third tool from the top). It gets added to the node graph.
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5 Press Play to view the camera shake.

These results are far too heavy-handed! Tone down the results by making the 
following adjustments:

6 In the Inspector, drop the Speed Scale down to 0.1 and review the results.

Much closer…but still too much movement.

7 Drop the value down again. In the Inspector, drop the Speed Scale down to 0.05

With the camera shake added, the composition is complete and ready to play back in the 
context of the edit.

Reviewing Work in the Edit
In traditional visual effects workflows, every individual edit is saved as its own project file 
for work to begin. To review the results of any single shot, compositions are rendered and 
manually imported into edit timelines for review. DaVinci Resolve does away with these 
intermediate steps. When working with Fusion inside of Resolve, the work is sent right back 
into the edit page!

1 To review the results of the Fusion composition in the context of an edit, press the Edit 
page button (Shift-4) and press play (Spacebar). 

The results of the first composite are immediately available for review. However, there 
are an additional three shots of the same interview that also require the poster work 
and camera shake.

2 Place the playhead over the top of the first shot in the timeline (the band interview) 
and enter the Fusion page.

3 Click and drag a selection around all the nodes in the composition, excluding the Band 
node and the MediaOut1 node.

4 Copy by selecting menu bar > Edit > Copy or press Ctrl-C (Windows) or 
Command-C (macOS). 

5 Step back into the edit page.

6 Move the playhead to the next interview clip and enter the Fusion page.
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7 Paste the nodes into the node graph by selecting menu bar > Edit > Paste or press 
Ctrl-V (Windows) or Command-V (macOS).

The nodes have been copied and pasted from the previous interview clip onto this 
one. However, the patching still runs directly from MediaIn1 to MediaOut1, and none 
of the creative work is inside the flow. 

8 Disconnect MediaOut1 by hovering the mouse around the connection line. When the 
connection line turns blue, click and drag the connector to break the connection.

9 Patch the MediaIn1 output (gray square) into the input of Blur1 (yellow triangle). 

10 Patch the output of CameraShake1 (gray square) into the input of MediaOut1 
(yellow triangle). 
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11 Move into the edit page and repeat the process for the third interview clip.

It’s possible to move between shots in the timeline without having to leave the 
Fusion page. 

12 Click the Clips panel in the upper left of the Fusion page.

13 Select the last interview clip (shot 18) from this panel to move directly to the fourth 
interview clip.

14 Paste the nodes from the clipboard and connect them to the flow.

15 Press the Spacebar to review the shot.

The guitar poster disappears in the middle of the shot. This is because this interview 
clip is longer than the previous clip where the work was initially created. The poster 
element is structured to run only the length of the shot when it was created. This is 
important to highlight, since assets can sometimes disappear when using templated 
content multiple times over. To change the length of an asset:

16 Open the Keyframes panel found in the upper right of the Fusion page.

17 Scroll down the panel until you find the guitar track.
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18 Trim the guitar asset longer by hovering your mouse to the right side of the time 
container and clicking and dragging to the right.

The Fusion page operates a little differently than the edit or color page and can be 
intimidating to newcomers. Don’t be discouraged! Start by mastering simple effects to 
become comfortable with the tools. The renderless workflow makes Fusion a compelling 
option for editors, motion designers, and effects artists alike. 
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Lesson Review 
1 On the Fusion page, how can you display the output of a node in viewer 1? 

2 When clicking a tool in the toolbar, where is the node added? 

3 What node would you use to blend two images? 

4 What is the yellow input on a Merge node? 

5 True or false? When on the Fusion page, you can disconnect the Media Out node 
because you have no use for it. 
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Answers 
1 On the Fusion page, to display the output of a node in viewer 1, select the node 

and press the 1 key. 

2 The new node is added directly after the selected node in the Node Editor. 

3 A Merge node is used to composite two images.

4 The yellow input on the Merge node is for the background input. 

5 False. The Media Out node is always the last node connected, and it renders the 
Node Editor results back to the edit page timeline.
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Delivery and Media 
Management

After completing a project, from 
editing and grading through to 
building motion graphics and 
mastering the audio, there are two 
final elements to consider: the delivery 
and the archive.

The delivery will allow you to render 
out your timeline, complete with 
grades, effects, and audio wrapped in 
a single file of your choosing. Archiving 
will allow you to save your media and 
projects so that opening an older 
project in the future will be easier and 
not take up too much drive space.
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Working in the Deliver Page
Everybody’s workflow is different, and the deliver page is designed to give you flexible 
options for creating output from low-resolution editing proxies to the highest-quality 
master files. You can batch-render multiple files to multiple resolutions, compression 
formats, and destinations, all from the same deliver page. With so many different options 
available, you might think it would be difficult to learn. But it isn’t. 

In this lesson, you’ll use the deliver page to create two separate outputs: one for web 
streaming and another custom output to create part of the timeline as a high-quality 
movie file. 

Rendering Out a Web 
Streaming File 
Almost every project ends up on a web-streaming service in some form, even if it’s just as 
promotional material. To output the most common file-based output formats, 
DaVinci Resolve includes easy setups and presets that automatically configure all the 
parameters for an output type that you select. 

1 Double-click the Wyoming Cattle Ranch project you were using to grade with earlier.

2 In the project, select the Secondaries Timeline.

The currently displayed timeline is the one that you will prepare for export on 
the deliver page. 
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3 At the bottom of the DaVinci Resolve window, click the Deliver button to open the 
deliver page. The deliver page is divided into five areas. 

Render Settings Output Viewer Render Queue

Thumbnail Preview Timeline Display

You’ll use the Render Settings for file-based output. When Render Settings are 
selected, as they are by default, you can choose a render preset to configure for 
your output. 

4 At the top of the Render Settings, click the Vimeo preset. 

When you choose one of the presets, DaVinci Resolve configures the Render Settings 
to output a file that conforms to the destination’s requirements. If you wanted to stop 
at this point and output the file, you could do so. The only parameter you would need 
to set would be the destination of the output file. 
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5 Just below the row of presets, enter the name of the file, Wyoming Cattle Ranch, and 
then click the Browse button and choose a location for the output file. Click the OK 
button on the dialog. 

Since you selected a preset, that is all you must do to output a file, but you also have 
a few options that you can apply to presets. 

6 Below the Browse button, set the Resolution to 1280 x 720 HD 720P since this is the 
resolution of the current timeline. 

Although you can customize the video compression and format parameters in the 
Video tab, when you choose one of the easy presets, many of the basic settings are 
optimized for you. 

When the Vimeo preset was selected, QuickTime H.264 was chosen as the format, and 
the AAC audio codec was chosen because those parameters are commonly used for 
web-streaming videos. 

The YouTube, Vimeo, and Twitter presets allow for automatic uploads to those sites by 
enabling the Upload checkbox. We’ll leave that unchecked for this exercise.
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TIP For the automatic upload to work, you must enter your YouTube, Vimeo, 
or Twitter account information in the DaVinci Resolve > Preferences window. 

7 At the bottom of the Render Settings panel, click the Add to Render Queue button. 

The job is added to the Render Queue on the right side of the window. 

The Render Queue acts as a temporary holding area for jobs that you want to output from 
DaVinci Resolve. You can add as many jobs to the Render Queue as you need to output. 
Although you could render this file immediately, let’s wait and prepare another job for 
the queue. 

Creating a Custom Preset 
In most circumstances, you will need to render out a high-quality file for client previews or 
final delivery. It is also useful to have since you can transcode the file later to another 
format or even upload this to a streaming platform and allow their systems do the 
transcoding for you.

You’ll render out a master file but also keep the setting that can be used later.

1 At the top of the Render Settings, click Custom. 

Clicking Custom makes all the options in the Render Settings available for selection 
and begins the process of creating a new preset. First, you can decide if you want 
every clip in the timeline to render out as its own individual file or as a single file. 

2 Click the File tab and name the file Wyoming Cattle Ranch HQ.
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3 Below the Location field, click the Single Clip button to output a single movie file. 

4 Click the Video tab, and under Format, choose QuickTime if it isn’t selected already.

QuickTime is widely used across many systems; think of it as a container that holds the 
video format of your rendered file.

5 Under Codec, click the menu and choose DNxHR.

6 Under Type, choose DNxHR 444 10bit.

7 Finally, set the resolution to 1280 x 720 HD 720p.

Before you add this file to the render queue, it might be a good idea to save these 
settings since you might use them again as your master file setting. Rather than 
having to generate this setting each time, you can save it for future use.
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8 Click the options menu in the top-right corner of the Render Settings window and 
choose Save As New Preset.

9 Save as HQ Render. You can now see the setting appear as an option in the Render 
Settings menu.

10 Now add the file to the render queue.

Rendering Out Individual Clips
Sequences do not have to be rendered out in their entirety. If you want to upload a section 
of a longer timeline, you can mark a section, either in the edit page or deliver page, to 
simply render out part of a timeline. Likewise, if you need to render out an individual clip 
for a VFX artist, you can simply choose this in the timeline.

Clip 02 in the timeline needs to be rendered out because a VFX artist is going to composite 
in some horses in the distance and more trees the foreground. VFX artists often need clips 
in a very specific format.

1 Click Custom Export.

2 In the Format menu, choose EXR.

3 Change the resolution to 1280 x 720 HD 720P.

4 Right-click over the clip 02 thumbnail in the timeline and choose Render This Clip.

You will now see an In and Out point marked over the clip.
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5 Click Add to Render Queue.

6 In the Render Queue window, click anywhere in the gray area to make sure none of the 
specific renders are selected (because having just one selected will render only that job).

7 Click Render All, and the three separate jobs will render in turn.

The deliver page has many more options for outputting various file formats and for 
supporting a variety of workflows, but you now understand the most commonly used 
workflows and how to set up your own custom presets.

Managing Media and Project Libraries
Unlike almost all other editing, audio mixing, or color grading software, DaVinci Resolve uses 
an industry-standard project library to store all your projects, bins, clips, and timelines—
basically, any item that is not an audio or video media file is kept in the project library. 
As a result, DaVinci Resolve works a little differently from other apps when you want to move 
projects from one system to another or create backups of your projects. It’s not any harder 
to do those things, and in some cases, it can be a lot easier. But it is different. 

You will now explore ways to back up and move project elements, projects, and media, 
as well as learn how to manage the DaVinci Resolve project library and introduce you to 
the Blackmagic Cloud. 
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Consolidating Media 
Before we explore project library management, let’s start with a topic that’s a bit more 
down to earth: media management. 

Almost every project will need some kind of media management. It might be just to copy 
media from one drive to another or to convert files from one format to another. The Media 
Manager performs these types of tasks in DaVinci Resolve. You can use it to copy, move, 
and even consolidate media. 

When your hard drive cannot accommodate a complete copy of the original media, 
consolidating can help remove media that is no longer needed in your project. Using the 
Media Management dialog, consolidating gives you the option to copy only those pieces of 
media that are actually in use. For long-form projects with lots of media, consolidating is a 
great way to free up disk space and make backing up a project a quicker task. 

1 With Wyoming Cattle Ranch still open from the previous lesson, click the Edit 
page button.

2 Choose File > Media Management. 
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TIP The Media Management dialog can only be opened when you are on the 
media, cut, or edit pages.

By default, the window will open with the Entire Project button selected. You can also 
see that the window is set to copy. With these settings, all the media within the project 
will be copied to a location of your choosing. The Copy function will create a duplicate 
set of media files in the destination location but leave the original files in place. This 
allows you to ensure that duplicates are copied safely and without errors before 
deleting the originals, if that is your goal.

TIP You can click the New Folder button to create a folder for the 
consolidated files that you create. If you don’t do so, you might end up with 
too many files on the top level of a hard drive with no way of knowing which 
files to keep and which to delete. 

For now, you don’t want to copy all the project media, but just the media you have 
used in the timeline you delivered earlier.

3 Click the Timelines area in the Media Management window, click the Secondaries 
Timeline, and the checkbox will become active.

The option to consolidate timeline media requires that you select one or more 
timelines to determine which files to keep. You have two choices for consolidating your 
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media: you can choose to copy the clips that you have used in the selected timelines in 
their entirety or to copy just the portions of those clips that you have used in the 
selected timelines (including handles).

Choose “Used media and trim keeping # frame handles.” 

Choosing this option will trim down the master clip files to only those clip portions 
used in the selected timeline(s). A field is available in which you can enter the number 
of frame handles you would like added to each side of a clip in case you will later need 
to trim or create transitions. 

TIP Compression formats that use interframe, temporal compression, such 
as H.264, can now be used with the “trim unused media” option in the Media 
Management dialog. 

4 Enter 24 as the number of frame handles to add. 

Because your project runs at 23.979 frames per second, entering this value this will 
enable a second of extra media on both ends of the clip for trimming and transitions. 

The Media Management window also gives you a helpful guide as to how big your 
original media files were and how big they will be after they are trimmed.

If you were finalizing these steps, you would now click Start to begin consolidating 
the media, but in this case do not do so. 

5 At the bottom of the Media Management dialog, click the Cancel button. 
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After you started the consolidation process, the files used in the timeline would be copied 
to the destination drive and then trimmed so that only the clip portions in use were saved 
to disk—along with a half-second handle on each side of a clip.

Copying Projects and Media 
to a New Hard Drive 
Although consolidating media can save you the most storage space, it addresses only 
the media. Your timelines, clips, and metadata are not included. The easiest way to copy, 
back up, or move a single project and all its content from one computer to another is to 
use DaVinci Resolve’s archive and restore features. Archiving a project collects all your 
files (even if they are on different drives) and places them in the destination folder of 
your choice, along with the project file. To archive a project, you must do so using the 
Project Manager window. 

NOTE The following exercises use a second hard drive for copying and 
transcoding media. If you do not have a second hard drive or do not want to take 
up valuable disk space by copying and/or moving the training media from this 
book, you can still read through the lesson to gain an understanding of 
the process. 

1 Open the Project Manager, right-click the Wyoming Cattle Ranch project thumbnail, 
and choose Export Project Archive. 
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2 In the Archive dialog, navigate to a drive where you want to save the project 
and click Save. 

All the media and the project file containing your bins and timelines are copied into a 
folder with the extension .dra. This folder contains everything you need to open your 
project on another computer. 

Be assured that the original media remain in their original locations, and that the two 
sets of media are completely identical. It’s up to you to decide whether you want to 
delete the original media from those original locations or leave them to work on later. 

When you copy the archived folder to another computer, you must restore it in 
DaVinci Resolve to begin working with it. 

NOTE Because you already have the project from the archive on your 
computer, the following steps are included for educational purposes and 
are not meant to be followed. 

3 To restore an archived project, you open the Project Manager. 

4 Then, you right-click anywhere in the Project Manager and choose Restore 
Project Archive. 

5 In the dialog, you navigate to the “.dra” folder of the archive you want to restore and 
click Open. 

The archived project opens in the Project Manager, and you can begin working on it. 

Exporting Timelines, Bins, 
and Projects
As explained earlier, DaVinci Resolve uses a project library to store your projects. The 
projects themselves can be exported as stand-alone files out of the project library and 
imported into different libraries. In doing this, none of the media will be included with the 
project; however, if you want to send the project to another user and they already have the 
media, they can simply import the project into their project library and relink the files.

1 In the Project Manager, right-click the Wyoming Cattle Ranch thumbnail and choose 
Export Project. 
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2 Save the project to a place of your choosing.

You may not want to export your entire project. If you are giving a project to, say, a VFX 
artist, they do not need multiple different timelines but rather just the one they need 
to work on. You can export a timeline rather than the entire project.

3 In the media pool, right-click the Secondaries Timeline and choose Timelines > Export 
> AAF / XML / EDL / DRT.

4 The Export Timeline window will appear with a menu at the bottom. By default, the 
DaVinci Resolve Timeline files (*.drt) will be selected.

5 Save the file, and a .drt file will be created.

A .drt file contains the timeline itself and only the clips used in that timeline. To clarify, 
there is no actual media in the folder—just the clip identifiers for DaVinci Resolve.

This timeline can now be imported into any other project, and the timeline and clips 
will appear in the media pool and then the media can be relinked.

TIP You can also export individual bins, which works in the same way as a 
timeline. Simply right-clicking over a bin and creating a .drb file will import bin 
contents into another project.
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Working with the DaVinci Resolve 
Project Library 
DaVinci Resolve keeps all your projects in its own container, called a project library. Unlike 
most applications you may be familiar with, your projects are not saved to a location of 
your choosing. They are all kept within the project library. And while that may suggest a 
process that’s more complicated than you may be accustomed to, it brings a lot of benefits. 
A project library adds a level of organization to your projects without you doing a thing. 
You don’t spend time keeping track of project bins because they already exist in the library. 

Also, because projects are kept in a project library, they can be stored on a server that can 
connect to multiple DaVinci Resolve workstations, providing the flexibility to access any 
project on any computer or for working collaboratively on any project. 

Creating and Switching 
Project Libraries 
When you first open DaVinci Resolve, it automatically creates a project library, so it is 
largely transparent to you that a library is in use. In macOS, the project library is stored 
in the Library folder, whereas in Windows, the project library is in the Program Data folder. 
Even though you know where the project library is stored, it is not recommended to 
rename or modify any of the folders or files in a library and certainly not to delete them!

In this exercise, you’ll learn the right way to switch between project libraries, create your 
own project library, and back up a project library without ever altering it at the operating 
system level. You’ll start by creating a new project library. 

1 In the upper-left corner of the Project Manager, click the Projects library button to 
open the list of available libraries.
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The project library sidebar displays a single Local library by default. It’s the current 
default project library that DaVinci Resolve created when you first started. 

You can either “Connect” to an existing project library that you have not previously 
connected to, or you can “Create” a new project library. Creating a new project library 
can be useful for organization; for instance, if you perform several jobs for one client, 
you might want to assign them their own project library and start a new one for another 
client. We’ll create a new project library as if we are starting a job with a new client.

2 At the bottom of the project library sidebar, click the Add Project Library button to 
create a new library. 

3 In the Name field, enter traininglibrary. 

4 Click the Browse button to open a file browser that allows you to choose the location 
of your project library.

5 Navigate to the Lesson 9 folder in the training materials. 

6 Select the folder called Training Project Library.

7 Click the Create button to load in the new project library.

The traininglibrary now appears in your list of project libraries. Clicking any of the 
project libraries listed will switch to that library. The newly added project library is 
already selected and ready for your new projects. 

TIP  Project libraries with fewer and smaller projects will save and operate faster 
than project libraries with a greater number of large projects. 
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Backing Up Project Libraries
Although it is more likely that you will back up a project by exporting it from the Project 
Manager as a DRP file, you can create a backup of a project library. The library does not 
include your media; however, creating a backup will save every project, bin, clip, and 
timeline in the project library. Conveniently, you can back up your project library within 
the project library sidebar. 

NOTE The following exercise uses a second hard drive or cloud-based storage to 
store your project library backup. If you do not have access to a second hard drive 
or cloud storage, you can still read through the exercise to gain an understanding 
of the process. 

1 In the list of project libraries, make sure the traininglibrary is selected.

2 Click the Details button to right of the project library name.

Generally, project libraries range in size from a couple of hundred megabytes to a 
couple of gigabytes, but unlike media, they can easily be saved to a cloud backup 
storage system or a small local hard drive. 

3 Click the Back Up button.
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4 Navigate to the hard drive or cloud-based storage where you want to back up your 
library and click Save. 

5 Once the save is completed, click the back arrow to go back to the Project Libraries list.

TIP If you are unsure of where your database is stored, you can go into the 
Details and choose the option Reveal in Finder to show you the folder the 
database is stored in.

6 Click close to close the Project Manager Window.

After saving a backup, a .resolve.diskdb file is created. This file contains your entire project 
library, which you can simply copy to another drive if, for instance, you purchase a new 
computer and want to move your existing projects to the new hard drive. On the 
new computer, you can click the Restore button in DaVinci Resolve to open and use the 
database. 

Project Libraries in 
Blackmagic Cloud
So far, we have looked at project libraries stored to your local system or backed up to an 
external hard drive. There is now an option to put your project libraries into a cloud 
environment by using Blackmagic Cloud. This means you can access your projects from 
any system simply by logging into your cloud account, which will then load any project 
libraries you have. You can work with your project in Blackmagic Cloud, and it is 
automatically saved there so you can easily switch between machines without worrying 
about whether you have the most up-to-date project with you.

NOTE Remember that your project contains no media, so you would need to have 
a copy of the media with you so the system you are working on can access the 
files locally.
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Using the project library this way will allow you to collaborate with multiple users, and you 
can all work on the same project at the same time—for example, you could be building a 
timeline while a colorist is grading the same sequence at the same time.

There is a small cost to having a project library based in the cloud because it must be 
hosted on a server. This can be canceled at any time. If you do cancel, you will not be 
locked out of your work. Projects can be copied from Blackmagic Cloud to a local project 
library. Also, if you are working collaboratively, you only need one person to host the 
library; other users can be invited in for free.

At this stage, you might not know if you need to work with a cloud project library, but you 
can sign up for a Blackmagic Cloud account for free, so another user could invite you to 
their project library.

NOTE It is not a problem at this stage if you do not want to sign up to a 
Blackmagic Cloud account. Read through the next few steps just as a reference, 
though, so if you decide later that you want an account, you’ll have an idea of 
what to do.

1 Go to the Blackmagic Design website: https://www.blackmagicdesign.com.

2 On the home page, click the cloud icon in the top-right corner of the screen.

3 This will launch your web browser and load the Blackmagic Cloud welcome screen.

https://www.blackmagicdesign.com
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4 Click the Sign Up! link below the Log In button.

5 Fill in your details and click Sign Up. From here, you will be logged into your Blackmagic 
Cloud account.

6 You will now see the welcome screen. You are now logged in to your cloud account.
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7 Go back into DaVinci Resolve and open the Project Manager. Click the Cloud button in 
the top-left corner of the window.

8 The cloud sign-in will appear. Use the details you have just used to create your cloud 
account to log DaVinci Resolve into your cloud account.

If you want to collaborate with someone who already has a project library set up, they 
can simply invite you into the library by using the email address you just provided. You 
can also start using your own project library.

9 Go back into your web browser. If you have closed the window, simply log back in to 
your cloud account.

10 Click the Project Server button, and the Project Server setup menu will appear. Choose 
the region that is closest to you.

11 Give your project library a name, which is the name that will show up in 
DaVinci Resolve.
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At this stage, you will be asked for payment details. For now, we will stop the process 
so that you don’t incur any costs. 

After the payment stage you would have a screen that showed the project library 
within the web browser, as shown below.

This project library would then also show up in the Cloud section of the 
Project Manager.

As you can see, although DaVinci Resolve uses project libraries to store all your 
projects in one place, there are many flexible options to save, share, and archive your 
work. Having projects in project libraries is a big advantage because it allows multiple-
user collaboration between editors, colorists, audio engineers, and VFX and motion 
graphic artists.
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Lesson Review 
1 How do you render a single clip from within a timeline? 

2 When choosing Vimeo, what encode setting is used by default for the audio? 

3 True or false? Choosing the Vimeo preset displays the most common options for 
creating a movie file for that online sharing site? 

4 Where would you save a customized preset for future use on the deliver page?

5 After adjusting the Render Settings, how do you instruct Resolve to output a 
movie file? 

6 True or false? The Media Manager manages clips, timelines, and bins. 

7 What is the main difference between exporting a project and a project archive? 

8 True or false? If you open a .drt file in a project, it will load in a timeline and all the clips 
associated with it.

9 How do you view the project libraries in the Project Manager? 

10 What’s the advantage of having a project library in Blackmagic Cloud? 
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Answers 
1 Right-click over the thumbnail and choose Render This Clip.

2 The audio file is encoded as AAC.

3 True. Presets provide the most common options. To view all the options available, 
click the Custom render setting. 

4 To save a custom preset on the deliver page, in the Render Settings Options menu (the 
three dots in the upper-right corner), choose Save as New Preset.

5 To output a movie file, click the Add to Render Queue button, and then in the Render 
Queue panel, click Start Render.

6 False. The Media Manager manages only media; it does not manage bins. 

7 A project will simply export a project file that contains no media. A project archive will 
export a folder and all media required, which will link to the project when opened.

8 True. A .drt file is a DaVinci Resolve timeline file, which will import a timeline into a 
project and all the clips needed for the timeline. It will not import actual media 
because, like a project file, it holds no actual media.

9 To view the project libraries connected to DaVinci Resolve, in the upper left of the 
Project Manager, click the Databases sidebar button. 

10 You can access the project library from any machine and work on the project, and it is 
auto saved to the cloud; you do not need to carry around or use multiple versions of 
the same project when using different machines.

Congratulations!
You have completed The Beginner’s Guide to DaVinci Resolve 18 and are ready to explore 
more editing, visual effects, color grading, and audio mixing functionality using the 
additional certified books in this series. Completing all the lessons in this book has 
prepared you to become a certified DaVinci Resolve user. You can take the online exam by 
following the link below to earn your certificate. 

We also invite you to become part of the DaVinci Resolve community by joining the web 
forum on the Blackmagic Design website. There, you can ask further questions about the 
creative aspects of editing, color correction, and audio mixing. 

We hope that you have you have found DaVinci Resolve 18’s professional nonlinear editing 
and world-class color correction tools to be intuitive to learn and a perfect fit to become 
the hub of your entire creative workflow.

Test your skills by taking the online assessment located on the Blackmagic Design 
DaVinci Resolve Training page—The Beginner’s Guide to DaVinci Resolve 18 Online Exam: 
www.blackmagicdesign.com/products/davinciresolve/training

http://www.blackmagicdesign.com/products/davinciresolve/training
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A
AAC audio codec, 380
Add Serial command, 203
Add Tracks dialog, 65
adjustments, making, 151–157, 201–206. 

See also subframe audio adjustments
ADR (automatic dialogue replacement), 298
ambience, 299
Anamorphism, adjusting, 115
animals and kids, 347
animation. See keyframing animation
archiving projects, 388
audio, muting, 370. See also sound
audio clips, zooming, 83
audio levels, changing, 45, 336
audio meters

Fairlight, 315
reading, 80

audio post-production, 296–297. See also 
mixing audio

Audio Scroller, 330
audio symbol, identifying, 26
audio tracks. See tracks
Auto Balance, 151
automatic adjustments, 151–157
automatic smart bins, 269–274. See also 

bins; smart bins

B
backing up project libraries, 393–394
backtimed edits, 75–77. See also edits
backups, creating, 284
bin list

displaying contents, 5
locating, 2

bins. See also automatic smart bins; 
smart bins

exporting, 389–390
keyboard shortcuts, 20
making, 265–266
opening, 266
using, 7–10

Blackmagic Cloud
features, xvi
project libraries, 394–398

Blackmagic Design Training and 
Certification Program, xiii

Blade Edit mode, 39
Blur icon, 361
blur radius, using with Qualifiers, 210
brightness values, 140, 151
Brightness/Contrast node, 367
B-Roll

finessing, 50–53
inserting, 31–36

Bypass button, 141, 148, 157, 241

C
camera audio, 317
certification program, xiii
Clear Color command, 232
Clip Attributes window, Fairlight, 317, 326
clip channels, setting, 313–321
Clip Color, Clear Color, 232
clip duration, changing, 48
clip metadata, viewing, 267–269
clip speed, changing, 98–101
clips. See also tracks; ungraded clips

adding from media pool, 365–369
adding keywords to, 270–272

Index
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adding to smart bins, 276
copying, 122
correcting, 131–132
displaying in timeline, 328
displaying on tracks, 318
filling timeline window, 24
importing on media page, 261–266
inserting into timeline, 36
normalizing, 81
playing, 22
removing and trimming, 37–40
removing from smart bins, 276
rendering out, 383–384
reviewing in edit page, 11–13
selecting, 82, 268
slipping and sliding, 53–57
snapping, 68
trimming in Fairlight, 322–324
zooming horizontally, 316

Clips button, 228
Clips filter, 229
cloud. See Blackmagic Cloud
Codec option, 382
color balance, working on, 179–180
color casts, neutralizing, 153
color channels, adjusting, 169–172
color correction. See also primary color 

corrections; secondary color 
adjustments

balancing scenes, 132
custom “looks,” 132–133
high-end work, 130
Hollywood tool, 133
introduction, 127–128
Lift, Gamma, and Gain, 144–105
quality control, 132
tone of visuals, 128–129

color grading, 130–133
color management, 164–169. See also 

YRGB Color Management
color page

applying Resolve FX in, 219–224

nodes, 158–159
Resolve FX, 219–224

Color Science dropdown menu, 166
Color Warper, making adjustments 

with, 201–206
colors, isolating with Qualifiers, 207
Command key. See keyboard shortcuts
compression formats, 387
Contrast parameter, 240
Contrast tool, 160
Control Panels group, 281
control points, using with curves, 

175–176, 182
Copy command, 116, 122, 331–332, 371
copying

grades, 230–232
media and projects, 388–389
projects and media, 388–389
timeline clips, 331

Corner Positioner node, 366–367
corrections, separating, 159–162. See also 

primary color corrections
cosmetic/performance fixes, 348
creative decisions, making, 251–253
Ctrl key. See keyboard shortcuts
curves. See also HSL curves; S-curve

activating, 180
in nodes, 177–183
primary color corrections, 173–177

Curves icon, 190
custom presets, 381–383. See also presets
custom smart bis, 274–277
Custom Zoom, 25
cutaways, adding, 46–49

D
databases, Reveal in Finder, 394
DaVinci Resolve

downloading, xiv
as Hollywood tool, 133

dBFS (decibels full scale), 80
deliver page, 378
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Denoise parameter, Qualifier controls, 211
Detail Zoom, 25, 39
dialogue

audio meter, 80
editing, 297–298
levels, 81–87

diegetic vs non-diegetic music, 299
Disk Search button, Relink Media, 7
documentary photography, 129
downloading

DaVinci Resolve, xiv
LUTs (Lookup Tables), 248

drag-and-drop editing, 68, 73
.drp extension, 4
duplicating timelines, 62–64
duration, highlighting, 71
dynamic range, adjusting, 300
Dynamic Zoom, 106–108. See also zooming

E
Edge Wipe, 110
edit page. See also media pool

adjusting pacing, 57
backtimed edits, 75–77
b-roll, 31–36, 50–53
button, 371
clip speed, 98–101
cutaways, 46–49
dialogue levels, 81–85
filters, 114–118
finishing mixes, 91–93
Fusion titles, 119–124
importing projects, 2–7
mixing sound effects, 144–105
mixing soundtracks, 79–80
music, 43–45
project setup, 62
real-time performance, 102
relinking media, 2–7
Render Cache, 102
Replace edit, 77–79
replacing shots, 94–98

reviewing clips, 11–13
shot framing, 103–108
shuffle insert edits, 49–50
slipping and sliding clips, 53–57
sound bites, 22–30
sound effects, 71–75
syncing sound to action, 77–79
timeline, 20–21
timeline clips, 37–40
timeline duplication, 62–64
transitions, 109–113
Trim Edit mode, 40–43
viewing options, 14–19
voiceover, 64–70

edit points
adding, 57–58
moving between, 33
trimming, 42

editing
drag-and-drop, 68, 73
music, 299
sound bites, 22–30
sound effects, 71–75, 298–299
VO (voiceover), 67–70

Editing group, User Preferences, 284
edits. See also backtimed edits

previewing results of, 78
reviewing work in, 371–374

effects. See also Fairlight FX; Fusion effects
adding, 370–371
masking, 360–365

Effects Library, opening, 89, 110
Enhance Viewer, 236, 238
EQ (equalization) controls, 301
exporting

bins, 389–390
grades, 239–243
items, 389–390
projects, 389–390
timelines, 389–390

Eyedropper tool, 153
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F
fade handles, 87–89
fades, adding in Fairlight, 323
Fairlight

adding fades in, 323
subframe audio adjustments, 324

Fairlight audio mixing, 308
clip channels, 313–321
interface, 308–312
mixing music, 336–342
project setup, 304–307
sound effects, 325–333
track formats, 313–321
trimming clips, 322–324

Fairlight FX, 334–336. See also effects
Fairlight page, 309–310
Feather box, 111
files, organizing, 264
filters

adding, 114–118
Clips, 229

F-keys, configuring, 30
folder structure, preserving, 264
folders, creating, 386
Foley sound, 299
frames, adding to clips, 42. See also 

shot framing
freeze frame, creating, 99
Full Extent Zoom, 25, 38
Fusion effects. See also effects

adding, 370–371
adding elements, 355–360
clips from media pool, 365–369
interface, 352–355
masking effects, 360–365
panning node graph flow, 354
renaming nodes, 355
reviewing work, 371–374
Text+ tool, 356

Fusion titles, adding, 119–124

G
Gain

color wheel, 157
primary corrector, 139, 144–150
master wheel, 157, 236
region, 152, 171

Gamma
color wheel, 152, 241
primary corrector, 139, 144–150
master wheel, 237

Gamut, 164
General Settings, 285
Grab Still command, 241. See also stills
grade management

creative decisions, 251–253
LUTs (Lookup Tables), 243–251
stills, 233–238
ungraded clips, 228–230

grades. See also ungraded clips
copying, 230–232
importing and exporting, 239–243
turning off, 241

H
H.264 codec, 209
hard sound effects, 299
HDR LUT category, 244–246
Highlight button, 191–192
Highlight Wand icon, 208
HSL curves, making secondary 

adjustments with, 197–201. See also 
curves; S-curve

hue information, Qualifiers, 212
Hue vs Lum curve, 199. See also 

luminance channel
Hue vs Sat curve, 198

I
images

correcting, 131–132
displaying, 172
viewing, 157, 176
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zooming out of, 193
importing

clips on media page, 261–266
grades, 239–243
projects, 2–7
timelines, 341

In points
removing, 76
setting, 28, 31, 35

Index button, 337
Input Color Space, 168
insert edits, shuffling, 49–50
Inspector

Fusion, 353
opening, 98
Transform controls, 103–106

Internet Accounts group, 282
I/O (Input/Output), 280

J
JKL keys, 27, 310
jogging and scrubbing, 27

K
key combinations, assigning, 291
Keyboard Customization window, 287–292
keyboard settings, configuring, 30
keyboard shortcuts. See also Shift buttons

Add Serial, 203
bins, 20, 265
Blade Edit mode, 39
clip duration, 48
Copy command, 116, 122, 331–332, 371
disabling nodes, 217, 219
edit page, 371
edit points, 57
Enhance Viewer, 236, 238
expanding track size, 83
exploring, 286–292
Fairlight page, 309
frames, 42
grades, 241

Highlight Wand, 208
inserting clips in timeline, 36
Mark Selection, 71
nodes, 162
onscreen overlays, 217
Out points, 29, 32, 35–36, 76
Overwrite Clip, 29, 70
Paste command, 116, 123, 331–332, 372
playback, 27
In points, 28, 31, 35, 76
previewing results of edits, 78
previewing transitions, 112
renaming nodes in Fusion, 355
Ripple Delete, 38, 40
searching, 290–292
selecting clips, 268
Selection mode, 40, 49
snapping, 41
timeline display, 311
timeline zoom, 25
transition duration, 113
Trim Edit mode, 54
viewing images, 157, 172, 176
zoom levels, 364
zooming out of images, 193

keyframes
adding, 338–340
adding to volume overlays, 85
using to refine levels, 321

Keyframes Editor, 143
keyframing animation, 109
keywords

adding to clips, 270–272
smart bins, 274

Keywords field, Metadata Editor, 269
kids and animals, 347

L
layouts, saving, 257
learning to see, 350
lesson files, copying, xiv–xv
levels, controlling, 336
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Lift
color wheel, 155
primary corrector, 139, 144–150
region, 170

Linked Selection button, 37
List View button, 16
Live Save, 283
Living in the Age of Airplanes, 2
Locate button, 6
locations, changing, 348
log clips, 164
log encoded source, 131
luminance channel, isolating, 178. See also 

Hue vs Lum curve
luminance information, Qualifiers, 212
LUTs (Lookup Tables)

applying, 244–246
downloading, 248
features, 243–244
loading, 246–249
renaming, 251
saving, 249–251

M
mapping presets, managing, 292
Mark Selection, 71
masking

areas with windows, 186–190
effects, 360–365

mastering and mixing, 301
matching shots using stills, 235–238
Matte Finesse tools, 210
media

consolidating, 385–388
copying to hard drive, 388–389
managing, 384
relinking, 2–7

media files, offline status, 5
Media Management dialog, 386–387
media page

importing clips on, 261–266
switching to, 262

media pool. See also edit page
bins and smart bins, 7–12
hiding, 79
locating, 2
viewing options, 14–19

Media Storage preference, 279
Merge node, 358–359, 369
metadata, customizing, 268–269. See also 

clip metadata
Metadata panel, 262
Metadata view, 19
meters, Fairlight interface, 308
mix, finishing, 91–93
mixer

Fairlight interface, 308
hiding, 310

Mixer button, 79
mixing

and mastering, 301
music, 336–342
sound effects, 86–91

mixing audio. See also audio post-
production; soundtracks

project setup, 304–307
motion graphics, 349
music

adding, 43–45
audio meter, 80
diegetic vs non-diegetic, 299
editing, 299
mixing, 336–342
stabs and stingers, 299

mute and solo controls, 81, 313, 370

N
narrative cinematography, 129
natural sound, 299
New Timeline Settings, 284. 

See also timelines
NLE (non-linear editing) systems, 287
node adjustments, limiting, 368
nodes. See also outside nodes; Serial node
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disabling, 217, 219
labeling, 163–164
renaming in Fusion, 355
sending to viewers, 357
separating corrections, 159–162
turning off, 162
understanding, 158–159
using curves in, 177–183

Normalize Audio Levels, 82, 320–321
normalizing clips, 81

O
Offset, primary corrector, 139
onscreen overlays, 217, 219. See also 

Overlay button
Option key. See keyboard shortcuts
Out points

removing, 76
setting, 29, 32, 35–36

outside nodes, reversing selections with, 
191–192. See also nodes

Overlay button, 189. See also 
onscreen overlays

Overwrite Clip button, 29, 70

P
pacing, adjusting, 57–58
pan controls, 301
Parade scope, 141–143, 146, 180
parameter position, 367
Paste command, 116, 123, 332, 372
performance/cosmetic fixes, 348
picture sync and sound, verifying, 329–333
Place on Top edit, 45
playback, controlling, 27
playback direction, controlling, 310
playhead, moving, 22, 24
playing clips, 22
Plugins, applying, 117
Polygon node, 362–363, 368
Position X and Y controls, changing, 105

post-production. See audio 
post-production

Power Windows menu, 196. 
See also windows

preferences
resetting and saving, 286
types of, 279
window, 278–285

presets. See also custom presets
commands, 292
customizing, 257, 381–383

previews and viewers, 148
primary color corrections. See also color 

correction; corrections; secondary 
color adjustments

automatic adjustments, 151–157
color page, 136–138
curves, 173–183
Lift, Gamma, and Gain, 144
nodes, 158–164
separating corrections, 169–162
video scopes, 141–143

primary corrector, 139–141
production dialogue editing, 297–298
Project Archive folder, 136
Project Backups option, 284
project libraries, 256

backing up, 393–394
in Blackmagic Cloud, 394–398
creating and switching, 391–392
managing, 384
working with, 391

Project Manager, opening, 3, 256
project preferences, 278–286
project settings, 256–261
projects

archiving, 388
copying to hard drive, 388–389
exporting, 389–390
importing, 2–7
organizing, 277
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Q
Qualifiers

Color Warper, 202–203
combining with power windows, 213–216
selecting areas with, 206–212

QuickTime H.264, 380

R
RCM (Resolve color management), 131, 164
real-time performance, Render Cache, 102
REC.709 Gamma 2.4 setting, 168
rectangle, aligning, 188
Relink Media window, 5, 306
Render Cache, real-time performance, 102
Render Queue, adding jobs to, 381
Render Settings, Vimeo preset, 379
rendering out

clips, 383–384
web streaming file, 378–381

Replace edit, 77–79
replacing shots, 94–98
Reset UI Layout, 4, 137
resolutions and frame rates, 260
Resolve FX, applying in color 

page, 219–224
Retime Process, changing, 101
Reverb plug-in, Fairlight FX, 334–336
reviewing work in edits, 371–374
RGB tooltip, 155
RGB values, converting, 249
Ripple Delete, 38, 40

S
saturation information, Qualifiers, 212
Saturation parameter, 241
saving

layouts, 257
LUTs (Lookup Tables), 249–251
preferences, 286
project settings, 261

scrollers, using for positioning, 330–333
scrubbing and jogging, 27

S-curve, creating, 179. See also curves; 
HSL curves

secondary color adjustments. See also 
color correction; primary color 
corrections

adjusting lighting, 192–196
Color Warper, 201–206
HSL curves, 197–201
masking with windows, 186–190
Qualifiers and Power Windows, 213–216
reversing selections, 191–192
selecting areas with Qualifier, 206–213
tracker, 216–219

selecting
areas with Qualifier, 206–212
clips, 82, 268

Selection mode, 40, 49
selections, reversing with nodes, 191–192
Serial node, adding, 236. See also nodes
set extensions, 349
Shift buttons, 289. See also 

keyboard shortcuts
shot framing, changing, 103–108. 

See also frames
shots

matching using stills, 235–238
replacing, 94–98

sky 
adjustment, 203–205
replacement, 347–348

slider, resetting, 367
slipping and sliding clips, 53–57
smart bins. See also automatic smart 

bins; bins
adding clips to, 276
automatic, 269–274
custom, 274–277
removing clips from, 276
rules for, 277
using, 7–10

snapping, enabling, 41, 68
softness, adding to vignette, 222
solo and mute controls, 313
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Solo button, 81
Sort menu, 15
sound, syncing to action, 77–79. 

See also audio
sound and picture sync, verifying, 329–333
sound design, 298–299
sound effects

adding and aligning, 325–333
audio meter, 80
categories, 300
editing, 71–75, 298–299
mixing, 86–91

soundtracks. See also mixing audio
defined, 296
spotting, 297

source viewer, 2, 14
Speed Change settings, 260
speed controls, revealing, 99
Split Clip, Fairlight, 321
Split Screen button, 252
spotting session, 297
sRGB color space, 169
stabs and stingers, 299
stills. See also Grab Still command

applying, 233–235
using across projects, 242–243

storage. See Media Storage preference
streaming file, rendering out, 378–381
subframes, nudging, 331
sweetening tracks, 300–301
system 

preferences, 279
requirements, xiv

T
Terwilliger, Brian J., 2
thumbnail view, 18–19
timeline clips. See clips
timeline viewer, 2
timeline zoom, controlling, 25
timelines. See also New Timeline Settings

building in edit page, 20–21

duplicating, 62–64
exporting, 389–390
Fairlight interface, 308
highlighting durations, 71
importing, 341
locating, 2
organizing, 64
resizing, 311
zooming, 55

title templates, live previewing, 119
tonal adjustments, 177–178
tonal values and tonal range, 140, 151
toolbar

Fusion, 353
locating, 2

track adjustment, verifying, 87
Track Display Options, Fairlight, 312
track formats, setting, 313–321
track heights, resizing, 85, 315, 340
track size, expanding, 83
tracker, using, 216–219
tracks. See also clips

adding, 64–65
displaying, 337
enhancing and sweetening, 300–301
repositioning in timeline, 327

Transform controls, Inspector, 103–106
transitions

adding, 91, 109–113
previewing, 112

transport controls, Fairlight interface, 308
Trim Edit mode, 40–43, 54
“trim unused media” option, 387
trimming

clips in Fairlight, 322–324
edit points, 42
limitations, 57
timeline clips, 37–40

Twitter preset, 380–381
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U
UI layout, resetting, 137
UI Settings, 282
ungraded clips, identifying, 228–230. 

See also clips; grades
User preferences, 279, 282

V
Vertical Wipe button, viewers, 237–238
VFX artists, 383
video preview, Fairlight interface, 308
video scopes, 141–143
viewers

expanding, 236
Fusion, 353
and previews, 148
Vertical Wipe button, 237–238
zooming into, 156, 188

viewing options, 14–19
Vignette effect, adding to node, 221
Vimeo preset, Render Settings, 379
visual effects compositing

adding elements, 346–347
animals and kids, 347
changing locations, 348
introduction, 346
learning to see, 350
motion graphics, 349
performance/cosmetic fixes, 348
set extensions, 349
sky replacement, 347–348
wire removal, 348

VO (voiceover), editing, 67–70
volume 

adjustments, 80
controls, 300

volume overlays, adding keyframes to, 85

W
web streaming file, rendering out, 378–381
White Balance tool, 153–154
windows. See also Power Windows menu

combining with Qualifiers, 213–216
using to mask areas, 186–190

Wipe transitions, 110
wire removal, 348

Y
YouTube preset, 380–381
YRGB Color Management, 261. See also 

color management

Z
zoom, reducing, 50
zoom levels, resetting, 364
zooming. See also Dynamic Zoom

audio clips, 83
clips horizontally, 316
out of images, 193
timeline, 55
into viewer, 156, 188
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Legendary Color Correction

Fairlight Audio Editing and Mixing

Professional Editing Tools

 DaVinci
 Resolve 18

Node-Based VFX with Fusion

The Beginner’s Guide To DaVinci Resolve 18 is a step by step training 
guide for both new and existing users. Using a project based 
approach, you will discover how to edit a sophisticated trailer for 
a documentary feature, grade your film using DaVinci Resolve’s 
legendary color correction tools, enhance your soundtracks with the 
Fairlight page and build custom visual effects using the Fusion page. 
Download the free version of DaVinci Resolve 18 and start creating 
your own Hollywood caliber film and video projects today!

What You’ll Learn
• How to edit your own projects using the industry standard editing tools

• Edit using functions such as overwrite, insert, replace, place on top 
and append at end

• Trimming clips in the timeline using context sensitive functions for 
ripple, roll, slip and slide

• Normalize audio levels and add and mix sound effects and music

• Perform primary corrections using the color page’s wheels and curves

• Learn to read video scopes to adjust contrast, color balance and 
saturation for the perfect grade

• Create secondary corrections using custom curves, the 3D qualifier 
and the color warper

• How to add PowerWindows™, track objects and add ResolveFX

• How to match shots, create looks, copy and manage complex grades

• Enhance your audio editing and mixing using the Fairlight page

• How to deliver projects to a variety of formats including those for 
popular social media sites

• Tips and tricks throughout the book that will transform how you work!

Who This Book is For
This book is designed for both beginners and professionals. Beginners 
will find clear and concise lessons to get you up and running quickly. If 
you’re a professional switching from another system, you’ll find lessons 
that cover everything from basic editing and trimming to working with 
audio, adding text, effects and more. You’ll also find dozens of pro tips 
and tricks that will help you make the switch to DaVinci Resolve!

 The Beginner’s Guide to
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